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1. 7u— )37y a VRE

Ta—rN ATy a VOREF, TA B ADENIEFRR L SES KOETDY FA T v M T34 ZAZEE LET,
SES ® A == —/3—/, [Tools] -> [Options] #27 V v 27 L%,

ro‘] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User na... - O X

Database View Folders Keys Qser Help Secure

Add Refresh Del Generate Key File Install Filter Help
[General]
Cptions d
& General
Gener. wihen maving uzer or device to a different falder, also move all related users, devices and keys
[ ]'when moving user ta recycle bin, remove user key fils from all devices
m [1Delete drive infarmation when computer is delsted fram the Fecycle Bin
Server's RSA (] Hide Machinelrfo fles after extraction
keys [1Rename old key duting extraction from machine info file
[1Enable "Crypto-eraze device" remote command
@ [ Automatically update device's profile settings when profiles are modified
Authentication Show top 1500 records in table views

Questions [ the length can be from 8 to 32 bytes; Longer values

=
=

Pazsword recavery length |10 =

T | are more secure |

=

=

=

=

.‘? J Command Expiry |30

Delete commands from histary (10

day(s]

Key file options day(z] after expiration date
& |Jze SDConnex to communicate with SecureDoc client machines
N
=
. [ &llows duplicate User Mames - Duplicated user names will not be automatically resolved
er
|Jzerz may alzo login using Sak, UzerlD@domain. com [UPM], UserlDigtdomain, DamaintUzerlD,
o Domain/JzerlD formats
=]
=l Allow |dP Software Token
Licenses [ Use token protection as default protection type
m Default taken type for new users | ikey 2032 w
Device Password rules
Authentication
Certs

[] Dizable AD folders structure Browse for rook folder

[ Do not impart groups Fep Uzage I:l Configure Key Uzage

Cancel
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0 When moving user or device to a | 2=V —F = 1ET A 2ZBO 7 4 VA BT 5 L, BET53_To

different folder, also move all
related users, devices, and keys

e FAL A BLORLEELET,

When moving user to recycle bin,
remove user key file from all
devices

a—H—% [Recycle Bin] (ZZ44) I[ZBEIT 5 & X, XTDOT A
ANG =P —DXF—7 7 A L EHIEEL 7,

Delete drive information when
computer is deleted from the

avEa—4H [Recycle Bin] (Z#45) MOHIBRSNIZEZIIRT AT
THHEHIBR L E7,

Recycle Bin
O Hide Machine info files after Machinelnfo 7 7 A JViZiX, 72 94TV FT AL AL a—VF— 2T 51F
extraction WhEENLTOET,

SDConnex LBERHTICAH T TA L TA A b= LIzHE, TOT N
A A% SES TEELT A720IZIL SES 22 Y — VD IEAA D
[Machinelnfo Files] TA VAR — h 320 ERH Y £,

SES DB IZB &R BEATZ L, SESEHa L Y —MIINLDOT7 7 ANV ER
RLEWE T DI, ZoF T varaEt iz LET,
BEIIFEALEEA,

DI S L ENTZ 2 DO BH DT A ARTFA A —ILEh, A A B
—NVEFITLIEFICED I TA TV TR ANED Xy b T — 7 JGEN
TN &N D R IR A VRS S 7 OIfE R L E T,

Machinelnfo File 7 7 A /LTI, T35 AITEINTEID M T HN-88E
FNET, ZOF T arEFACT L E SES Tl WEEO A A ZE T
L. D7 F7AT Y "TNA ZADREEALDOT-DITH LDEZ Ak LET,

SES /5 U E— h =< KT Crypto Erase #Ef7 &bk HIc L%,
Crypto Erase |Z7 /XA A L#ZHIBRT DT, H5bT25 2 &13TX
T T HFIIE SN0 L RIS Y 9,

Crypto Erase %5 L7127 94 T hT XA AX, 7—bn 4 7n
7T ABIELSEELARS 2D £7,

RO BRIER S HIT, T 7 4V PR EIE Tl EL T,

BEfro7a 7 7 A NVEER LI, ZEAIO7 07 7 A VREH ST
DT NAANHENTERE L2717 7 A /L% SDConnex #% M THUE L
Hd [/\ij—()

ZOF T a rOERICE, TOEETOILENRDD £T,

SES = V— LT, Fid XXXX La— K ({T) & RLET,
TR T 2D, SES a2 Y — L DERA 2B D Tlogs] THRS
NHI7 T,

7 7 4 v hEIX 1500 T,

DR T — RENCFIHT AT vy L V&LV AR AT, LA
RAEORE#ZEELET,

EWZE, ZeMixmE 908, BT LRMEMEZmEICLET,

F 7V MREMIT T10] THY, BF =2V T 40 EERAMEDNT U 2N
nTns ERashEd,

I TAT ok TR A~Da~ K (Crypto-Erase =~ > K& HRL) %
TR ELET, MEL-HEEZRBTDLLE. a~r FOFL)
RN gINEd, T 740 M 130) HTY,

[0 Rename old key during
extraction from machine info file

(0 Enable “Crypto-erase device”
remote command

0 Automatically update device’ s
profile settings when profile are
modified

Show top XXXX records in table
views

Password recovery length XX
(the length can be 8 to 32 bytes;
longer values are more secure)

Command Expire XX Day(s)

£ Crypto-Erase =~ > FOAZWRIEL 10,000) HIZHRESILE
9, SES & # L Crypto-Erase =t~ ROARMIRAZHTE TE 7
Wzh, N o loGh, X BT ORERS Y £77,
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Delete commands from history XX
day(s) after expiration date

G

AEBIBRD XX ARICIBREND 2~ REHIRLET,

D IAT  RNTNAANDA~v Yy REWIET D ETORFHIMEZETE L E
ER

I TRIE LI HEUNIZT AL AR — A= LR LRWES, 728 %
. 20T ADT e Ty ANEEHTLHIE—F arbr— ax
¥ RIFHIRTIAICR Y £

[0 Use SDConnex to communication
with SeueDoc client machines

SeueDoc 7 74 7 v T34 A%, SDConnex Zf#H L Cifg LE9,

[0 Allow duplicate User Names -
Duplicated user names will not
be automatically resolved

HE2—Y A &I LET,

[0 Users may also login using SAM,
User ID@domain.com(UPN),
UserID@domain,
Domain¥UserID, Dmian/UserID
formats

2 —H—i%, SAM. User ID@domain.com(UPN)7z &
KT F—<y NTRZA LT 5L b AHETT,

O Allow IdP Software Token

=PI IdP Y 7 b =T b= U ERFEHTEET, A==
> 9.0SR3 Ti%. SES & MagicEndpoint IdP 2 ## L C, =—H%—nD Y
TNy =T =2 2% SES T4 N—RI{RFLET,

[0 Use token protection as default
protection type

TIAT LV NTNNAATh—rv7arysyarasr 74V sTHEAT D
%{‘HC?": 4 LET

Default token type for new users

SES TIERT 2% —7 7 A WM T 2T 74V b D =2 v 2 T 5k
RLET,

<Password rules>

NAT— RKL— L aFELET,
[SecureDoc Enterprise Server version 9.x 7 A v 7 A A h—/L 4
AR #IZZHRLTZE 0,

0 Disable AD folders structure

Active Directory /»5H A »iR— kL2 T _RCO2—Y—L F)L—T0N[FE L
TANAFIIREIND LI LET,
Active Directory @ 7 4 )V A& AR L 8 A,

0 Do not import group

Active Directory 7\ — 7% A R —h LEHEA,

Key Usage

Active Directory 7> HAFHEZ A R — T D ERICE BT SO
% GEEORM) Z@IRCTEES, TXTOXA TOREHEL A AR —
h¥5i2ix. digitalSignature 5 7 4L MiE (0) DEFITLE T,
FREDMEHEO L Z A VR — FT 5121, tOEZBRLES, &2
IX. UserSMIMECertificate @& FfOREEDHZ A AR — M LET,
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[Server’s RSA keys]

TV ARSI TWDEIE, SES 7 —# X—ZXDERTIAER S b DT,

HW—0fEAEMER S, 7277 477 GEAEL LTRESNTWET, FEALEDOHE, SES A VA h—/LT &
S TERENTZHETHH T, MED CA OERINEAELER T2 L8R H 256, <Import> 227U v 7 L
TA v A— h%. <Set Active> #7 U w7 LC, ZNEAMILET,

Options
f{# server's Roh keys

Forthe secure communication with SecureDoc clients, Enterprise Server needs RSA key pair. rou

have to load FKCS#1Z file. containing server's key pair into the database. in order SES to be ahle to
control client machines remaotely.

(

Server's RSA keys Description Devic.. Status

Import
SES Certificate 8/25/2022 15:25:31 2 Active

Generate

Authentication -
questions SetActive

XJ Delete

Key file options

Export
2
Other Certificate info:
g = Serial Number:
= 7DB0ZCFY
Licenses lssuEE
EE Ch=SecureDoc Enterprise Serser
i Subject:
Device Ch=SecureDoc Enterprise Server
Authentication -
T Walidity:

From Aug 25 06:25:37 2022 GMT
To Aug 25 06:25:31 2032 GMT

[Authentication questions]

AR EE 1 DRI 21 S8 A
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[Key file options]

MERRFRER &, ZZTRELIENENRA VA ML —va Uy —UHERIFFICT 7 40 FRRIE & L Tt A ENE T,

Options .

Key file options

%

General These options are related to the operations on the "Devices" tab: adding user ta the dewvice, Key File creation,

et

.l

. [“]¥hen Key File is created for the device, automatically send itto device
Server's RSA keys . ) ) ) -
[+] Autarmatically update Key File on device when userdevice/group keys are modified
@ Automatically generate Key File when user is added to dewvice

Enable password propagation

Authentication

[ JAkways include a personal key in Key Files

&

Key file options Default user privileges will be used as default package settings, and for creation of new users through SES

consale or during import fram AD.

Privileges: (@ User Rights (O Admin Rights
Other [ Modify Password [IModity Profile [Jcormvert Removable Media
t":J [IModify key [ select Profile [ Corvert Hard Disk
) - [CJExpor and View Key [Jcorfig SFE [ Disk Integrity Check
Licenses [J¥iew Transaction Log [JCreate Emergency Disk
EE DEchude from DAC (password sync should be enahled)
Device
Authentication
Certs
R B i
O When Key File is created for the TNA ZRIEFR =T 7 ANVPMER SIS & ZhE BHEIIZT A A
device, automatically send it to ICEELET,
device
O Automatically update Key File on A—P— /TR AT N—=T DX —=NEFSNIZGE, T35 A LD
device when user/device/group F—T AN EHBMIZEGLET,
keys are modified
O Automatically generated Key File A=Y= TN, ZBIMLTZEE, F—7 7 A L Z BEVTIERR L E
when user is added to device 7
O Enable password propagation NAT— ROGIREFIZ L ET,
B DT A ZNZE L= = DB I N TV DA, 22— =33
AT — R&EZEH LIZEE, SDConnex Z 4 L T F /34 AITZEH L
JoNAT— K&k £,
RPN SN TV BT 31 A SDConnex &iffE L
TWARWEE (BIRAASTWRNWE) | 20T A A 3HL
WA — FFREZZ TRV O T, EREAZRDOT Y 7 —
NRGECIIAEEF O/ RAY — R AR RLECT, OS LEhik,
SDConnex &Ll 5 & A SN2/ A T — RIGH &5 1B
0. WIEIDOFBFERF HITHT L S BRE ST/ AT — R LEET
A=
O Always include a personal key in =T AN, BT R=YF X —F AND LI LET,
Key Files
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Privileges:
© User Rights 774/ hREX, T4 Modify Password] OA T,
MERR—B27 6 MERRMERRZ 5 TE 7,
© Admin Rights FrxvrT5HE, RTOHERNMIGSNET,
O Modify Password a—P—ix, NRATU—RKELEHTEET,
O Modify Profile —YP—L, T T ANEERTEET,
[0 Convert Removable Media Z—P—L, U L—NRTNRAT 4 T ERELTEET,
O Modify Key a—F—E, EEERAER, BB, B0 R— R TEET,
O Select Profile =YL, Te T A NEEINTEET,
O Convert Hard Disk =Y =L, T4 AT OB/ ERLER IR ET,
0 Export and View Key a—P—i%, BEERETEET, RExE T AN EBTT AR

—hrToZ e HEMDOF—T 7 ANV AR—F LY TEE
R

O Config SFE a—HF—ix, 7 T4 7 MUIT, SecureDoc 7 7 A VI AL & EFE
THZENTEET,
O Disk integrity Check T A AT DREWT = v 7 DRI LEERETH, 2—F—13E¥ %k

TCEET, TXARAZREL, T4 A7 OESEDTZDITH LWE
S FAERL L ET,

View Transaction Log

2—W—i%, Audit Log #RoZ LN TEET,

(I

Create Emergency Disk

=P —F, TV =T AT EERTE LT,

Exclude from DAC (password sync

should be enabled)

DAC ZMEzhiz LE9, (CHEFITERLETA)

AV ARL—2 a3 Ny —DT a7 7 A IVOREIZT, T A ARY
T7r7vAar hr— (DAC) NAEIEESIL, B AT 4 7~

OB DRHIR ST DIEGEE, IMEAT 4 T~DT 72 AMTAT,

TAAT T a7 LThH, INTAT 4 T 7 &g — 2 OBENPT
ZFEH A,

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

[Other]
Options X
) Other
General [ ] Disable Password Recovery featurs

[]User/Date info from token certificates will appear in dislogs/lists to aid identification

[ 5kip check of Key Usage atibute in imported certificates

Server's RSA [ Automatically flush the Recycle Bin on exit
keys

Alert spstem

@ Warning if devices do not communicate for D riri[z).
Authentication :
questions Error if devices do not communicate for D mir(s].

) [] Show alert notice in console after lagin
) I
'lg‘kJ Debug Logs

Key wlons [JEnable Log to Windows Event Log
: []Enable Log ta file an disk WSESLogFile bt

Azure AD TenantlD - required for AAD uzers pazsword change support

Azure AD ApplD - required for Azure authentications

Licenses | |
Authentication Saurce
Device [ &uthenticate 40 users against &zure AD - ApplD required
Authentication [] Authenticate users against Okta Universal Directary
Certs

Authenticate 40 uzers against AD

If multiple options enabled, the ones on top take precedence.

Canicel

(0 Disable Password Recovery feature FUNCTDHE, TRTOZ—WF—D/RRAT — REENEZNZ D F
T FERZR BRI IENRY | AN LN TS 2S00,

(0 User/Date info from token certificates | b—7 ViEHEO 22—V —/HHERNF A T 7/ U A MNIFERS
will appear in dialogs/lists to aid . RANHEREEGIZLET,
identification

[J Skip check of Key Usage attribute in FEEN L —Y— La— RO—f L LTA AR — bbb L, SES

imported certificates IXZOFEERR S LICER SN0 E ) DEMER L, T ) TRV
BIEHLEEA, FEEZEHTLICIE, ZoF T v arrzty
WLET
O Automatically flush the Recycle Bin on | SES =V — /L D# THEZ [Recycle Bin] OWNELZ HEICHIKR L £
exit 7
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Alert System

g&ll

By

Warning if devices do not communicate
for X min(s).

TV RARA v MF 34 28 SDConnex & DfE N7 WiE4 . SES
BB LT D OIS RIREN D D & R SN AR (4) &R
ELET,

O OZoFTvarid, ATM AR ETHEDN DT NA A& ME L T
E

Error if devices do not communicate for
X min(s)

TNA AR X EIEE LeWEaiE, =7 —& LET,

0 Show alert notice in console after
login

BHEEN SES avy—nice s AT hE Ry T T o7 Ay
=V kBT T (EELLIEZT—) BERINET,

Debug Logs

[0 Enable Log to Windows Event Log

SES Audit Log LI4bc, Windows A X hu 7z 7 24 F LE

R

(] Enable Log to file on disk

SES Audit Log DISMZ, fRE LI=HATIc m 7 2 k(F L £,

Authentication Source

[0 Authenticate AD users against Azure
AD - AppID requied

Azure AD 1Zxf L Ca2—Y—%3EiET2I121F,. ZOF=v IRy
A AN LET,

[0 Atuthenticate users against Okta
Universal Directory

Okta Universal Directory (2%} L C—H—%F8ET 521X, 2D
Frxv IRy AEF A LET,

[0 Authenticate AD users against AD
If multiple options enabled, the ones
on top take precedence

CDOF IRy T AL AT DHE, 22—V —% (@EITL T
I A?) Active Directory (Zxf L CERREL £,

B DT = 7Ry 7 AERIRN UGS, 22— —FErEhTn5
EFCZhneDT 4 L7 B Y —ERCx L THRIES N ET,

[Licenses]

[SecureDoc Enterprise Server version 9.2 7 4 v 7 A VA F—/LH A K| ZTBRITIZE N,

HNTGA B AEEBLZ T, 7547 734 22 SecureDoc A v A h— LT 52 LIXTTXERA,

[Device Authentication certs]

802.1X ZMEMT 5%y b U — I BET, 70— VLG ES—ROF A ARAE BB T DA, Z OSSR
I L CRERI T2 A o — b BE R B ) T,
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Options

o

General

=

Server's RSA keys

®

Authentication
questions

e

Key file options

g &
m 1]
&

&

Liceps

Device
Authentication
Certs

Device Authentication Certs

SecureDoc Enterprise Server can (optionally) secure 802.1%-protected MNetwork communications
using a PKCS#12 Certificate. To make availahle such Certificates for use in

Device Profile settings, import one or maore PKCS#12 files containing cerificates for 602.1X usage. vou
may also delete expired certificates using this panel

Certificate Name #Profil..  Expiry Import

Delete

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

2. SecureDoc Enterprise for Windows 7’u 7 7 1 )L

O XA r® [Profiles] 74 a2 Z&RL, <Add> 27V v 7350, AXADOLETHEZ Yy 7L, avTFA b
A==a—n5 [Add profile] 27V v 7 L9,

ﬁ:‘] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - O X

Database View Folders Keys User Tools Help

Secure
@ x & & @ z
Refresh Del Generate Key File Install F

: SIchI Y v
= |, Folders A Users M Devices | §f' Keys

ﬁ Groups ‘ ., Fa J
SES Administrators Mum|  UsserID Domain UPN

email Descr
5‘.' wmj.local
il All Folders
g Purged Devices

g Exempted Devices E/\o/r V2

.‘-‘o Recycle Bin
>
',,-U Installation packages
-y Machinelnfo files

- Logs

©@ [Please select the profile type] 7 1 > RUBRERREINETOT, [© Endpoint] OFNF T A=a2—LY

[SecureDoc Enterprise for Windows] ZER L, <OK> #7 VU v 7 LET,

Please select the profile type X

(@) Endpoint (@) () cloudvm

ISecureDoc Enterprise for Windows VI

@ [Profile name] #ic7'm 7 7 A V4%, LU T [Comments] #llizz A A AT LET,

SecureDoc profile

x]

Profile name [7 74 L F 707 7 1L |

Comments |#AEITF /(4 2]

Type |SecureDoc Enterprise for Windows

Profie data
General options Boot text and color Boot configuration
Port Control Disk access control
Edit manually Save

Cancel

@ fHxDOFBENTET LD, kkiz<Save> 27V v 7 L THRIEFELET,
SES L7 e 7 v A WDMERR S Z & &R LT,
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ro] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name:

SESDB, User name: SESAdmin — O X
Database View Folders Keys User TJools Help 0 SecureDOC
— _ Enterprise Serve
" + x ar i -d ?
Add Refresh Del Generate Key File Install Filter Help
= | Folders
SES Administrators
-~ wmjlocal
== j|f All Folders

g Purged Devices
g Exempted Devices
‘-3: Recycle Bin

@] Profiles

= k.tj Installation packages
/_Df Machinelnfo files
[EXS Logs

Record(s) visible: 1, available: 1. Total user(s): 10. Total computer(s): 0. Total key(s): 4.

X BHoOTaTrANVEERTAIEE, (EREOT 0 7 s ANV ERET D Z & CHBEIERTEET,

Ve DT u 7 v A NEHEZ ) v 7 LT, arTF A MA=a2—)5 [Copy Profile] 34T L 7,
[Profile name] 2 LW a7y A VA& AL, LEREAZREL TRIFL T EEW,
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2.1.General options
[General]

Wbz 2RO RMBOT 4 ATIRERE, T30 ZAIBOBE R HT T,

SecureDoc options >
— General
w Custom eror message:
General

[ Device will nat reboot after boot logon has been installed
.Ji:! Uzerz of MO Packages will be automatically lngaad-in to the boat Key File
- Automnatically continue interrupted encryption

Communication . ) . N
Synchranize Secureloc pazsword with “Windows password [bi-directional)

i& [JUsers can Encrypt Files using "Windows Explarer contest menu
. [JUsers can create SellEstractor archives wzing Windows Explorer context menu
BitLocker
Management [ 5ecue \Wipe parmits users to 'Wipe a file the following number of times: 0

[ Pratect device against repeated failled-password attack at 05 logon.
a

Credential Murnber of Key Files in SecureDoc space: 40 =
Provider I:

r%-' Client Uzer Interface Language: System ~

SecureDoc Encryption

Password
Manager ] Only encrypt Fiemovable Media (FM0) - Mo hard disks will be encrppted
= () Encrypt all disks [ Encrypt partition anly Refresh / Reset
TErn B (®) Encrypt boot disk only 1z hardware encryption if available
() Encrypt boot disk and all fixed disks [J1f BlackSID enabled force software enciyption
I
SecureDoc File Initial convergion will encrypt: Evwery sector v | LMo recoven [faster)
Encryption Exclude partitions from encryption: |
@

Advanced

Options

Hardware ﬂ

Cancel

Custom error message: SecureDoc TEMHENTWNWAT 74NV hOZT =R b=V 5k NAL <
ARXTEET,
) ~VTF A7 (NERER 1234) £ TBBWADELZEN,

[0 Device will not reboot after boot SecureDoc D7 — b w7 A A A M=% OS OFEEIZ I Z bk
logon has been installed WEOIZLET,

[0 Users of RMO Package will be U A—RTNRATF 4 THEOLEH AT 5 RMO /Sy r— 0o — —
automatically logged-in to the boot | (X, 7— ¥ —7 7 A MICHBINIZ2 A LET, B 5{LORET,
Key Files [Only encrypt Removable Media (RME)] Z&ER L7-HEIC, 7V 7

— MBREZ LB L LRV ETT,
[Boot Configuration] & C. [Force permanent Auto-Boot] #~
Ta NN o TOWDRENRH Y £,
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OO0 Automatically continue interrupted
encryption

G

il & DB TS L T SN2 BE T,
ESr

Feba HEIICHER S

[0 Synchronize SecureDoc password
with Windows password (bi-
directional)

FrvZEANDE, 22— —D Windows /X2 U — K3, SecureDoc
DF—T 7 A WA T— R EHEMIZFEH SvET, Windows /X2 T —
ROZEH 3 H#hIC SecureDoc (2 & 41, SecureDoc /XA T — KD
22 ¢ Windows (2 S v EJ,

T la=r IV EEATREER. Ty 7 EANDILERDH D
F9, Ty Z B ANTWRWGEE, Ny 7 —UERIFIZT 77— FRER
S, TuTZ s A NVEERTLHEIESNET,

[0 Users can Encrypt File using
Windows Explorer context menu

a—H—i%, Windows =7 A7 0 —5—Da T F AN A=a—%ff
HALTCT7 7 A Vv a b T&E 9,

[0 Users can create SelfExtractor
archives using Windows Explorer
context menu

2—W—i%, Windows =7 A7 0 —7—DarTF A~ A=a—%#
FALT BORT —hA TEETE £,

[0 Secure Wipe permits users to Wipe
a file the following number of
times:

IOFTvarvEERTLE, /AT a—T—DHF I Vv arT XA
MA ==zt 7 varpnBnEin, AchHsd Faey 7 ) 2 NTHRES
NEBEETT A AL 7 7 ANV E EEX L THETEET,

[0 Protect device against repeated
failed-password attack Windows
logon

BEFIL, NAT— FORITEEN T/ ENAEEE I DICERTHI L
NTEET,

Windows & 7' g L TR L7 mEAs, & 2 TRRE L7z Inl4kic iz
ToHE, FERIL, 7V 7 — FERE (F721% BitLocker U 7/3U) (281
Bz2¥ET,

Number of Key File in SecureDoc
space:

BikT DX —T 7 A NVORKEERE LE T, HEHE: 40
BEHT AL 16~200 ORI THEE AN LET,

Client User Interface Language:

SecureDoc 2—HW—A L X —T7 = — AT HEBA BN L ET,

[System] (X, Windows OS |ZF%/E AL TN A Sl B &
SecureDoc DEFEZHE L ET, FxfaET H L&, 0S LI1FRe <,
SecureDoc DEFENEHE SNET,

SecureDoc Encryption

[0 Only encrypt Removable Media
(RME) - No hard disks will be
encrypted

UL—=NNTNAT 4 T DI ERFALT DHEAITRINL £77,
HDD <° SSD ®»u—h VT 4 A7 Zh55{b LEH A,

O

Encryption all disks

BCDT 4 AV T b LET,

O Encryption boot disk only

T T4 A7 OREFALLES .,  (WIRE)

O Encryption boot disk and all fixed
disks

T—= T4 AT LEET 4 A7 &TEREE L LET,

[0 Encryption partition only

NR=TFT 4 arOhrzhis{b LET,

[0 Use hardware encryption if
available

A A ML= g7t APZ, TCG Opal K74 7 ZRa LI-BE,
V7 N =TI E BB SLITR 27T, Opal €E—RK&7 277 4 71Z
L, 7V 77— "R 0 7T LA A =L LET,
Fxv 7 EIF L, TCGOpal KT 7 ThHhoThY 7 k¥ =T THERL
LET,

¥ FHEINC UEFI/BIOS C©, HDD /X2 U — R L < X Block SID OF%iE
L TENTLIEE N,
TCG Opal "= R T =7 OHAET, f VA M—=NLETH, v v T
T BLEETT,
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[0 If BlockSID enabled force
software encryption

G

UEFI ®F% & T BlockSID AN/ > TWAE, Y7 b =7 TS
L %9, UEFI @R E T BlockSID # RN TX R\ TF 31 Z AT D%
ETY,

Initial conversion will encrypt:

Every sector :
BTCOEI Z—%EF b LET, BT 4 AZICEHBERT —Z DMRAFES
NTCVWEEEETZ0AT v a v ERIRLET,

Data only(faster) :
A A NV, EREEROAEZE S LET, TO%, T—4NE
TAEND &, OB X ZAWTHE S ET, Kbt a—4
—NEMT A2 EEHY EEA, (WIHIERE)

OB —MEA LTS, BEERT—INBHDHT /3 ADEE,
IOFTvaiFEREINET A,

[J No recovery (faster)

Wb, B—OREAIMATY AN F =2 A El LIE S L £
N, ZOF T a rEERT D L) WY T =X AR TR B{b A 5
TLEY, FIATOR Gz RET SERLWERICRILLET,

E O OBCa—V—MEALTWD, HERT DD DT A ADLA
COFTva RIS EY A, BIRLEZGA, BELRETT 5
FC, B a—F28K L. OSOU Y v T URBRZY S 720
oz Ean,

Exclude partitions from encryption

[Encryption partition only] ZER L7-H&12, BA{ba MnE s L
NW=T g var&EELET, AT 4=V RIZF =T 43 DFN
NEANNLET,
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[Communication]

SDConnex & O{E IZBEHE T 5 EEFTCTT,

SecureDoc options

x
) Communication
ﬁ Communication Settings
General |Jze SDConnex to communicate with SecureDoc client machines

TLS encryption

ﬁ Server List 192168 2 27 Add Dizable TLS w
- "—J’ Port number: | 7300 Prozy Settings Walidate server certificate
Communication - - P
[] Communicate with randam SDConnes server within priotity group Werity host name in certificate
y Communicate with server every  |B0 = minute(s)
BitLocker
Management If o communication with server far more than
@‘ 0 = day(z] - disable users' access to computer
. 0 = comm. eycles - move device to Exempted Dievices folder to prevent PBConnex authentication
Credential
Provider PBConnes
% [] Enable machine to communicate with SDConnes at preboat
Device will locally cache PEConnes autoboot key file for: |0 = das)
Password [] Use Static IP Configuration from Client at preboat
Manager

M agicE ndpoint Enterprize
@3‘ [ MagicE ndpaint can assist/strengthen Authentication

Walidate 1dP certificate
Media Encryption IdP List:

Yerify host name in certificate

T} M agicE ndpoint Credential Key will not be backed up to SES and cannot be shared to other devices
h b |
SecureDoc File Silently perform FacelD Authentication for kagicE ndpoint Clients whenever possible
Encryption zers will be automatically logged in to MagicEndpoint using Securelloc Credentials
i Do not show notification when logging into a website/services
;
l o
Advanced -
Options

Hardware ﬂ

Cancel

Communication Settings

[0 Use SDConnex to communicate 74T v hTFoA AL, SDConnex & DG E2 B 2RV ET,

with SecureDoc client machines BRI ZRBEE N 220 R Y . Z O EIFERR L2 T EE W,

Server List SDConnex A v A h—ENTeth— =D IP 7 KL A %7213 FQDN 4

Z AN L%9, SDCoonex i, fixK 16 Ai%E T £,

JIA4 T v ME, T ZTHRESNT- SDConnex EEABZARVWE T,

#i%57> SDConnex MNi%iE XN TV 554, Bt SDConnex MDA
(Priority) ##ECT&Ed, 7747 hE, Priorityl ® SDConnex

LT E o 1284 . Priority2 @ SDConnex & O#fgi 2 £,
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o B
SDConnex Address List pad
Enter SDConnex Server Address(es) in any of [Pv4, IPvE or DNS-Name formats
MNOTE: The list can contain maximum 16 addresses
[ | [ Aw
Custom pon number (if not defaul): l:l
Server Addresses Custom Port Priority Remowve
192.168.1.10 1
Set Default
Mowe Up
Move Do
OK
Cancel

Port number

7747 k) SDConnex LT HEOFR— MESERELET,
HEMIEX 17100 T,

Proxy Settings

IIAT IR T e ——%#kHm LT SDConnex L i#EET H%LA
WCRELET,

Proxy Settings x

DEC()nnect to SDConnex via proxy server

Use Internet Properties

Manually configure proxy settings

Cancel

[0 Communicate with random
SDConnex Server within priority
group

#i%o> SDConnex T Priority ®f%E4 11ZL., ZOF T a VEHNC
THE, T4 7 MME Priority ®F%EN 2 ¢ SDConnex ~D 7 7 & A
Z A BN, Priority O E2 1 @ SDConnex ~F 2 LT 7 & %

kB FET,

Communicate with server every X
minute(s)

7747 ME, OS E#hE (U— v ABiGEF) (2 SDConnex & DEHID
BEEZRAET, TO®HIL, 2 THEEINZFKE T SDConnex & dif

FaiArEd, BEMIT 160) T,

TLS encryption

- Disable TLS
- Force use of TLS 1,3
- Force use of HTTPS

HTTPS H AW ik TLS #fHT 2854,
[J Validate server certificate
(1 Verify host name in certificate

W b A A — R 2R L £ 9,
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N

If no communication with server for more than

X day(s) - disable user’ s access to FRELIZHEWNIZZ 747> 78 SDConnex &a@fs L~ =84, H

computer B2 TO2—Y—DF—T7 7 () (FEHEX—T7 7 AL ERL) &0
v 7 EFET, vy ZHERICIET ¥ LU PRV AR AR R E T,

X comm cycles - move device to SDConnex #fiHl L CTF NA A&7 U7 —hFry hT—ZFFEL T D

Exempted Devices folder to prevent I TAT Y NTNA AT, BEYA 7 VTHRE S LZE4, SDConnex

PBConnex authentication LIEE Lo 23, 73 A% [Exempted Devices] 7 #+ /L& 1ZF
et

SOF T arORML, ERET AN, A A — N T — b EFFALRNS
N—TWZBETLHZ LIk, MAOFRFEtOxT Y KA 2 h T34 A
(IOT 734 A, HENRT LW/ BEIRGEHE., 427 7314 2%) ©
X2 UT 4 &b d 52 & T9, SDConnex LilfE TERWEE, 7
INAANKEZZ T TNDD, ERIEERICS D STV D ATREERH Y
F9 GEBEWFT) ., [Exempted Devices] 7 # WV AZ ICBEH &= T
INA AN A =R T = b =T 7 A LR EESIN72W=, A— T — |

EEITENEEA,

PBConnex

[0 Enable machine to communicate 7V T7—hrxy hU—27GE (PBConnex) A LET,
with SDConnex at preboot

[J Enable will locally cache TV T — bRy NT—VERECA— T — N —E X EF AT A4
PBConnex autoboot key file for X | Auic B4 — 7' — FAF—7 7 A I — S—MITHEER S, 7
day(s) FAT VY MNEFy NI —7 ECEREFHT A ETHEIR 7 A VA AlHE

ELTWET, BEERSNLIA— T —  NF—T 7 AT SA4T
MIIIRESNEREA,

ZOF T aE, Y= "—lOAR AT 2 BROZHIZ, 7747
VMIF—=T AN EF Yy 2 SH BE, =T 7 AV EER LN
ol LEd, v v S A%EHELET,

[0 Use Static IP Configuration from TV T — bRy NU—VERGETHEE IPARATE AL 2ICLET,
Client at preboot TV T— b3y hU—IRRRETCHEAT S IP 7 R 2O EL, Windows

DIPT RLVAREEZSLET, Windows @ IP 7 KL A& EM DHCP
IIAT N E, TV T — b Ry NU—UREEEB IR )T —n s
Fr v T MEDHCP 7 747 FE LTEIELET,

COF T a rEANCTSHE . Windows DR EA DHCP Tld7s < [H7E
IP 2 LTV 5354, Windows TRESHTWAREEIP 7 KL 2%
VT — b3y NI REEECHETHIPT RLAICRELE T,

MagicEndpoint Enterprise

[J MagicEndpoint can MagicEndpoint # SecueDoc & il LIEM T 256, F=v 7 2 AfLE
assist/strengthen authentication R
1dP Lis MagicEndpoint Identity Provider Z{Ef9 544, URL (5K A R4R

—h&Z) EANLET,

MagicEndpoint aredential Key is synchronized with SES and SES can share it to user’s other devices

(MagicEndpoint FBFFFE#HF—1L SES Iy 7 T v 7 ENT, oF 4 2 LILFTE 8 A, )
MagicEndpoint aredential Key will not be badked up to SES and cannot be shared to other devices

(MagicEndpoint FEFENH S —IL SES E IS, SES 1IEnza2—H—DfhoT M A LfFTcExET, )

Users will be prompted to perform FaceID-based authentication
(22— —%, FacelD _—ADGEZ £ 715 L HickwonEd, )
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Silently perform FacelD authnetication for MagicEndpoint Clients whenever possible
(F[REZ2FR Y . MagicEndpoint 7 7 1 7> k@ FacelD ik £IfTLE 7, )

Users will be authentically logged in to MagicEndpoint using SecueDoc Credentials

(SecureDoc FFLEM & M SN TWAEATYH, —HP—|2% I MagicEndpoint ~»nu 7 A &R 5N ET, )
Users will always be prompted to log in to MagicEndpoint,even where sysnc'ed with SD Credentials

(77 7V FERGE)

(—¥—% SecueDoc IElEH# %M H L C MagicEndpoint [ZE8FEIC 2 71 > L £,

Do not show notification when logging in to a website/services
(V=7 ¥ A MY —bRZ0 T A T HEEITBHNERRLETA, )
Show notification when logging into a website/services

(V=T A NI —ERZu T A 5L SITBMERRTLET, )

[0 Validate IdP certificate IdP GEEAZRGEEL £9,
O Verify host name in certificate AERTEDO R A N R LET,

Automatically log out MagicEndpoint key after N minutes (Note: 0 ,means never)
N 43#12 MagicEndpoint ¥—Z#H#fIcn 77 7 h LEJ,

FEO0 Fu s T R LANWI EEERLET,
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[BitLocker Management]

BitLocker EH I MBI EHEH T,

SecureDoc options X
. BitLocker Management
General BitLocker Encryption: Do not use BitLocker encryption ~
# BitLocker Authentication and Access Monitaring

Communication

Authentication method | TEk only (auto-boof)

Additionally. allow independent USE Startup Key

BitLocker
Management

Allow Password as a fallback if no compatible TP available

BitLocker Conwersion Options

BitLocker Cipher Type: AES-CBC 256-hit

Credential Provider
Enforce cipher configured in profile during installation if BitlLocker already active

@P Enforce Drive Encryption Type: Full Encryption Used Space Only
Media Encryption Drives Tao Encrypt: 03 Dirive Onby 05 and Data drives
B Drives To Be Excluded:
1

SecureDoc File Advanced Opfions

Encryption Install SecureDoc encryption on devices that do not support BitLocker
‘ Use hardware encryption if available.
Ny=
Advanced Options BitLocker Tamper Protection
Frevent unmanaged decryption
Ii

Freventwolume protection suspension

Trusted Devices
Disable BitLocker management application (manage-bde.exe)

BitLocker Encryption - Do not use BitLocker encryption
BitLocker #fi [ L £t A,

- Enable Microsoft BitLocker Pre-boot

BitLocker #4077 — NERFEAEAH L £97,

[Authentication method] » 7V X =2 —C, BitLocker ™R

RESEZEIR L £,

Enable SecureDoc Pre-boot for BitLocker (#£3%)

SecureDoc D7’ U 7 — FERET 0 7T LA EEH L ET,

SecureDoc 7'V 7 — FRRREIZ L - T, MV IR T — RL— )L TOIE

HAev 7t a 4y (SSO) | =—P—m vy 7R, Tyl v&
L AR AEOW R CE £,

F2, VT — xRy hU—7FFELRIHARETY,

BitLocker Authentication and Access Monitoring

0 Synchronize BitLocker BitLocker PIN//X2 U — K% SecureDoc 7 /31 ZigH 12 —HF —D /3
PIN/Password with SecureDoc ATU—REFRMILET,
device owner user’ s password
Authentication method BitLocker fE#D 7Y 7' — FREREARIR L7354, RAE k23R L £
7
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+ TPM only (auto-boot)

- TPM+PIN

- TPM+USB Startup Key

+ TPM+PIN+USB Startup Key
(incompatible with BitLocker password sync)
BitLocker /XA U — R & HHNENRH O £H A,

- USB Startup Key only

- Password (no TPM)

[0 additionally, allow independent
USB Startup Key

SHIT, ML/ USB AX— T v 7 F—%FF LET,

O Allow Password as a failback if no
compatible TPM available

HENEDH D TPM B0 G NAY— RafFrl LET,

BitLocker Conversion Options

BitLocker Cipher Type:

Wb 7 =) XL ZE R L E T,
+ AES-CBC 128-bit
+ AES-CBC 256-bit
+ XTS-AES 128-bit
+ XTS-AES 256-bit

[ Enable cipher configured in profile
during installation if BitLocker
already active

BEIC BitLocker BNENCRESNTWAHE., AV A =L ficrm >
7 AL THER SN BT LT Y X A2/ L ET,

Enforce Drive Encryption Type:

ks BRI 0 BRSO B ST 2058 L9,
BEICT 4 A7 BICEE T — 2030 55414, [Full Encryption] 341 L
e I

Drives To Encrypt:

OS DAL AL—=NENTZRTATDIH, HHWIZNLUND FT AT
W5t d D DnEEIRL 7,

Drives To Be Excluded:

Wbz LI R T4 T4 2 AT LET,

Advanced Options

[0 Install SecureDoc encryption on
devices that do not support
BitLocker

BitLocker ¥R — Kk L72aWT A ZAD A, SecureDoc 2 L% Y7 b
VTR b ERB RN ET,

[0 Use hardware encryption if
available.

N= R =T LRSI K747 (TCG Opal 72 &) &ML=
4. BitLocker OB EALT AT ZAAICEL DY T N =T TOREALIZE

SN

ZRbT. N U =T LN Lol SR FIH L ET,

BitLocker Tamper Protection

[0 Prevent unmanaged decryption

Z—F—|2 & % BitLocker DY AEEEIL L ET,

[ Prevent volume protection
suspension

TN, ADRY 22— 5 L~UL T BitLocker % A FEEEHA,

[ Disable BitLocker management
application (manage-bde.exe)

o —H#—|%, manage-bde.exe FEITA[HE7 1 7 7 L (BitLocker % &%)
I L7 EE L2V T& % Microsoft v —/u) ZiHATER< 20 £9,
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[Credential Provider]

Windows ¥ > A ZBET A% E T, Windows #Z#od Credential Provider (7 LT vy v Nf Z—) i
SecureDoc Credential Provider [IZE® L ¥, v > 74 A 42 (SSO)IZFKEZEE T 5I121E SecureDoc Credential

Provider BN I4ETY,

SecureDoc options x

o

General

Credential Provider

Define whether credentials entered at Boot Logon automate user's logon into Windows

[ &wtomatically lag in to Windows with Credentials entered at Boat Lagon

.Jl:’ﬂ Ilzerz can zingle sign-on with Smart Card or Token
'—J’ Automatic login to Windows will ime out after |3

-

Communication Configure ‘Windows Credential Provider a3 last logged on uzer's provider

S g
r& Defing how SecureDoc credentials are used to authenticate at Windows Logon

L [JUse SecureDoc credentials to log inta YWindows
BitLocker

Only ugers having SecureDoc Credentialz may log in at Windows Logon
Management b g i =

Switch to native Windows logon in home netwark, [SES server iz reachable)
@ Additional options for token-bazed Authentication

Lock computer when token is removed

Credential

Provider Two-Factor Authentication
[]Enfarce Two-Factor Authentication for windows Logan

% [] Erforce Twa-Factar Authentication for Remate Desktop devices

e Remaote Desktop

Manager
[ &dd SecureDoc Login enhancement to Remate Deskiop Client

—] [] Only users having SecureDoc Credentials may log in at Remate Desktop Client

. . Authenticate to Femote Deskiop using M agicE ndpoint - requires no uzer action
Media Encryption

@

SecureDoc File
Encryption

[ Permit Remote Deskiop connections with SecureDoc authentication only

@
Advanced
Options

Hardware ﬂ

Cancel

Define whether credentials entered at Boot Logon automate user’ s logon into Windows

O Automatically log in to Windows with 77— FERAE T OB R A LT Windows 12 HBIRIZ YA

Credentials entered at Boot Logon AU LET,
0 Users can single sign-on Smart Card A~v— M —RFRERIFT =07 VEFEHT L LT, T8 A 04
or Token VEFIATEET,

O Automatic login to Windows will time | Windows ~® HE) VA > 1 id X HHBICZA L7 7 B LET,
out after X minutes

O Configure Windows Credential KB A v A v Lina——% 7 LT ooy 7 as o X —OmAk
Provider as last logged on user’ s IR LET,
provider

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

H H o B

Define how SecureDoc credentials are used to authenticate ad Windows Logon

[0 Use SecureDoc Credentials to log into SecureDoc Credential Provider #fiH L T Windows (21 > o

Windows Y LET, Windows ¥4 A ~DE X )T 1 &iffb LET,

[J Only uses having SecureDoc SecureDoc Credential Provider T® 7, Windows (2% A 1 >
Credentials may log in Windows TEET,
Logon

[0 Switch to native Windows logon in SDConnex &i@fE r[HEZ2 % v b U — 7 BEIClE, Windows #E#ED
home network (SES Server is JUT TR NT RN XY ET,
reachalble)

Additional options for token-based Authentication

[J Lock computer when token is USB h—7 v Z#k< &, Windows 1 v 27 L7,
removed

Two-factor authentication

[0 Enforce Two-factor Authentication for Windows ¥ >+ N HEEEGEA A L E T,
Windows logon (SecureDoc Credential provider)

[0 Enforce Two-factor Authentication for VE—FTF27 by FFNA 222 BERBIF AN LET,
Remote Desktop devices

Remote Desktop

[0 Add SecureDoc Login emhancement VEe—hK TAZ b7V 747 I SecureDoc v 7' A > DLk
Remote Desktop Client HERE A B L £ 7,
[J Only users having SecureDoc SecureDoc &EiklEHAFi>o2—Y—DHNVE—h TAZ by
Credental may log in at Remote J7IAT v Ma A4 o TEET,
Desktop Client
[0 Authenticate to Remote Desktop MagicEndpoint Z{H L7V E— K T A7 kv S ~DOGE,
using MagicEndpoint-requires no user | = —V—O#E/EIRETT,
action
O Permit Remote Desktop connections SecureDoc BIEDHTY T— T A7 by 7THgRE T LET,

with SecureDoc authentication only
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[Password Manager]

D= =L L RRAT — REffiolo LT —T 7V r—a v ~ORGEE TR — M LET,

SecureDoc options >
} Password Manager
# (] Enable Password Manager
General Enable Pazzward Matnager for non-managed Apps a3 well
¢ Managed Apps
ﬁ-ﬂ Add
Communication -
Edit
& Femove
BitLocker
Management
@' Pasgword miles for the App
Credential App URL of executable path/name Help
Provider
% Fermit the uze of YWindows uzer name/pazsword for login
Auto-generated password restrictions
Password - -
Manager Pazsword length from 12 2 to (20 - | symbals
Dizallowed syrbols;
@? Murmbers Lowercase Latin letters
e e Special symbalz of & Latin alphabet Uppercase Latin letters
"W arn uzer upon login bo changedrandomize initial passwiord
(i
1 Apply Cancel
SecureDoc File
Encryption _
. Fazzword record sharing between Apps Fazzword Change URLs
‘; Windows Pagzzword Fotation/R andomization
Advanced |D0 not randomize ‘Windows user passwords w
Options Automatically robate Windows passwords every | 30 2| days
i Exclude the following 'Windows accounts]: Helo
Hardware ﬂ

0 Enable Password Manager NRAT—= R A=V ¥ —aHILET,

0 Enable Password Manager for non- BHEXIGHNT 7Y THRRAY — R 32—y —&EHhC LET,
managed Apps as well

Password rules for the App <Add>AR% %7V vy LT, 77UOURL £72ITFET7 7 A VD

App URL or executable path/name INA AR AT LET,

O Permit the use of Windows user 1 7' A N2 Windows — % —4, /X AT — RO Z7F ] LE 9,
name/password for login

Auto-generated password restrictions BB RS A T — RO

Password length from XX to YY symbols NRAT—ROESII XX 226 YY XFIZLET,

Disallowed symbols: EHCERWiEE
[0 Numbers e
0 Lowercase Latin letters INSCTFED T T T
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[0 Special symbols of a Latin alphabet
[J Uppercase Latin letters

[J Warm user upon login to
change/randomize initial password

o B

TTUTINT 7y ORI
RIXFOZT 2 LT

BT A R NRA T — R BT T oM D KD ==l
RLET,

Password record sharing between Apps

T TYBTONRAT — Ritgka A LET,

Password Change URLs

NAYU— RZEHE URL 2B L £,

Windows Password Rotation/Randomization

Do not randomize Windows user
passwords

Enable password randomization for users
protected by Phone[Bluetooth and
Network]

Enable password randomization for all
users protected by SecureDoc

Windows &.—H#F—D /XA T — R&F v 2 AMELEH A,

A~— k7% [Bluetooth L % v N —Z | CR#ESN TN D 2—H
—DNAT—RET7 X AMELET,

SecureDoc THR#EIN TNDE TR TOL—PF—D/AT — K& T
ZrE L ET,

[0 Automatically rotate Windows
password every XX days

Windows /RA U — F4& XX HZEICHBIHICET LEJ,

Exclude the following Windows account(s):

s o7 00 FERELET,
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[Media Encryption]

UL—=NTNATF 4 T &5 d 28 E

SecureDoc options *

R Media Encryption
& Removable Media Encryption [RME] Settings

. ! Automatic or Manual Encryption
BitLocker

Management [ Automatically encrypt remavable media when it is connected

[ &llow marual removable media encryption [from context menu)

@ Encryption Method

Credential Full media Container-based [RMCE)
Provider
Free zpace to uze 100
% Encrypt entire zpace and mowve files into container
Password Securely format removable drive [recommendad only when sensitive data exists)
Manager

/ > Cuztorn Prompt

Media Encryption

Preferred Key for Media Encryption

@ | Remaowve Browse

S Do Fil ) ) )
eg::;p:;:onl & [] &llows user to change the default media encryption settings

[] Encrypted media can be accessed with a password
oy

~; [ Prevent using the device key for media encryption
3=
[JLog RME actions/changes to RME audit log

iz Obfuzcate file names in logs

Options

; [[]Enable Container CO/DWD encryption

[ TR T

Automatic od Manual Encryption

O Automatically removable media when it | U A— T AF 0 7R SN D & HEIRICK 5L 2 BRG L E1,
is connected

O Allow manual removable media AVTRARAZa—EHHLCAT 4 T2 LET,
encryption (from context menu)

Encryption Method

O Full media YA LAULVTAT 4 T RS LET,
oV —lTAT 4 TEIIETIHE, ROFHERH T,

s AF 4 TIFEERTHE S AL SN TWS, HDHWNIE AT — R TR
FEINTNDH L,

T34 A 21X SecureDoc 31 VA h— L ENTNDH I &
O Container-based (RMCE) AT FR=ADRE R LEB IV ET,

F A=Y —HTAT 4 72T OHE. ROZERHY £,

AF 4 TIFARETHE S ESNTWD, HDHVIESA T — R TR
EINTnbH L,
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O Free space to use

o B

22 7 ORI E E L E T

O Encrypt entire space and move files
into container

BEE 2T FOHEkE LTS L ET,
W bR 7T — 2 ik L, B bk, 7 — X 2l b Snic AT«
TICRLET,

[0 Securely format removable drive

g T I B LA BET AR AT 4 7 290 L EJ,

Custom Prompt

FEb BT OIS, Ay —VEFIRTEET,

Preferred Key for Media Encryption

AT A TR D8 iEE L E T,

[0 Allow use to change the default media
encryption settings

AT 4 TG DORENEDER 2T LET,

[0 Encrypted media can be accessed with
a password

WS b AT 4 TR AT— R TCT 7B ATE5 91 LET,

¥ Full media TR SAL LT AT 4 TICT 78 ATEBERMEE LT,
SecureDoCc A v A F— L ENTWALENRDH Y F7°,

[ Prevent using the device key for media

A—P—RRAT 4 TRESIEN T 28 %, T4 27 ORF BRI L

encryption TSNS E T,
[J Log RME actions/change to RME AT 4T O EELET,
auditlog

[J Obfuscate file names in logs

T JNOT 7 A NG EHESE L E T,

[J Enable Container CD/DVD encryption

a7 5T, CD/DVD #if 5k T b LI LET,
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[SecureDoc File Encryption]

SecureDoc options *

%\ H secureDoc File Encryplion

BitLocker [J Users may encrypt specific Files and Folders

Management Activate "persiztent encyption'
Once enciepted, filezfolders will remain encrypted even on other destinations or media
@. |Jzers may manage list of Applications that access encrypted files

Credential

Provider Allow uzers to decrpt and enciypt files uzsing the ‘Windows context menu

Password

Manager
]

Media Encryption

=
1

SecureDoc File

Encryption

H B ‘ 7 B
O Users may encrypt specific Files and BEDT 7 ANE T3 VT et TEET
Folders
O Active “persistent encryption” Persistent encryption Ck#ny7alsis{b) #HMLE7,
[0 Uses may manage list of Applications Persistent encryption T S 7=k 5L 7 7 A iz, =—1
that at access encrypted files —%. VAL RIZEBLARE T S r—a DY R N B
HTEET,
O Allow users to decrypt and encrypt files Windows 27 Ak A=a—%fiHL T 7 AV EEFLEB X
using Windows contest menu PEE{b s HiIcLET,
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[Advanced Options]

SecureDoc options >

tdvanced Options

] Boot Keyp Files Optiots:
Media Encryption
/s

[

SecureDoc File

Authentication

S

Trusted Devices

_% =
¥ Enable zending of uzer's passward and Self-Help password recovery answers to SES
BitLocker [] User/D ate info from token certificates will appear in dialogs/lists to aid identification
L S [ 5ecurebios icon will not appear in the system tray and natifications will be suppressed
@ [ 5uppress SecureDoc natification messages
- [ Show users' authentication answers text in SES Consale. as aid to Administrator
Credelntial [1Unlock Self-Enciypting Drives [e.q.0PAL, TCG Enterprize) when system resumes from Sleep mode
Provider Unlack Self-Encivpting Drives when system resumes from Hybrid Sleep
r%_' Devices may Sleep when Intel ® Enterprize Digital Fence iz enabled
Permit Windows administrators ta directly modify Secureloc configuration files on client devices
Password
Manager Windows Accounts

MNew uzers will be protected with random pazsward

[] Create Boot Key Files for local users detected on device
[] Create Boot Key Filss for AD uzers detected on device
[] Create Personal Key Files for ‘wWindows users detected on device

Login Perzonal Key Files automatically
Login ko Perzanal Key Files with SecureDoc password

Encryption
== [ Create accounts for A0 users only

‘l [ Display Boat and Personal Kew File pop-up messages

Advanced Exclude the following account(z):
Options,
SecureDoc Boot Logon Auto-Adapt

i Installer will auto-adapt to device specific/technologies

Hardware

Successtul compatibility test will proceed to installation and encryption e
[] Allow a lessfeatured boot-loader [PEUA4) to be used if PEL{U) is not compatible
It & device iz determined to be incompatible, SecursDoc will

Mark the device az incompatible and uninztall ~

(0 Enable sending of user’ s password
and Self-Help password recovery
answers to SES

2P —DNRNAT — N LT~ T OEE%E SDConnex #41 L T
SES DB 21D £,
BT AT Y BRY X HARREERE CIX TRV T £ A,

0 User/Date info from token certificates
will appear in dialog/lists to aid
identification

b—2 VEEHEDO =P —/ AHERB A T ) A MIRRE
. AANHEREZRSIZLET,

[0 SecureDoc icon will not appear in the
system tray and notifications will be
suppressed

VAT AL AIZ SecureDoc DT A 2 B FRIEET A,
WAL LFE RS EEEA,

[0 Suppress SecureDoc notification
messages

WHA vy =2 LERIEEREA,

0 Show user’ s authentication answers
text in SES Console, as aid to
Administrator

EEE OMBI L LT, SES a v Y —la—F =D T~LTD
A A RRSEET,
A AR CIE SR 721 £ 4 A,
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OO Unlock Self-Encrypting
Drives(e.g.OPAL, TCG Enterprise) when
system resumes from Sleep mode

o B

Holsk 74~ (TCG Opal) T, AV —7E—FzflfiT&5
Lol LEd,

E O ORAU—TEB— FOMHITHER S L EE A,

0 Unlock Self-Encrypting Drives when
system resumes from Hybrid Sleep

Hem 5k K747 (TCGOpal) T, "A 7V vy FRAY—=7E—F
RATEL LI LETS,

[0 Devices may Sleep when Intel
Enterprise Digital Fence is enabled

Intel Enterprise Digital Fence # A~ — kL,
Intel Enterprise Digital Fence TiZ, 7 /34 ABFHE T % LAN
TU=A T v 7 THE, AV—7REMRENET, LirL, RER

MOHENLEEETE S LAN 2B720Ea . IRIRIRREA TEH] S 41 E
o

[0 Permit Windows administrators to
directly modify SecureDoc configuration
files on client devices

Windows EELEN T 74 7> T34 A D SecureDoc i% €7 7
ANEEBELEFESTDLZ AT LET,

Windows Accounts

Boot Key Files Options

[0 Create Boot Key Files for local users
detected on device

FNRA A ETHhEnNTEe— N a—F—fFic, T— ¥ —T 7 A
AR LET,

[0 Create Boot Key Files for AD users
detected on device

T A TR S AD 22—V —[fiflc, 77— h¥F—T7 7 A L%
ERL L £

[0 Create Personal Key Files for Windows
users detected on device

FRA A ETHH &N Windows o—H —[ific, S—Y % —

77 ANVEERLET,

F OV T MRREARAT S —F—TIIEH L EE A
+12 TOnly encrypt Removable Media (RME) | [fi} T3,

O Login Personal Key Files
automatically

BAF—7 7 A NMZABI TR A > LET,

F OV T MRREA R T S —F—TIIEAH L EE A
+1Z TOnly encrypt Removable Media (RME) | [} CT9,

O Login to Personal Key Files with
SecureDoc password

SecureDoc D/XA T — R CAHF—7 7 A 1iZu 74 LET,

F OV MRAERAT = —TCIIEA L E A,
T2 TOnly encrypt Removable Media (RME) | [f]1F T,

[0 Create accounts for AD users only

SecueDoc 7 v > MERE AD = —V —IZ[RE L £,

[0 Display Boot and Personal Key File pop-
up messages

HEIBLOSR—=YF A =T 7 A VDR T v T A y— TR
éﬁiﬁ—o

F OV 7= FRAERAT 2 2 —F—TIIEA L EE A,
T2 TOnly encrypt Removable Media (RME) | a1l C9,

Excludes the following account(s):

CITHRELET AU MIER L EHA,

SecueDoc Boot Logon Auto-Adapt

[ Install will auto-adapt to device
specific/technologies

Successful compatibility test will
proceed to installation and encryption

T ZZEE OREPLELR LS, BB TENZEIL L T X b

—/LLET,
HHPET A NIRRT 2 &0 A A b= LI bictEAE
7,
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Stop after Pre-Boot compatibility test | « 7V 7' — KN E#apET 2 FMRIZA > A b— L& EIE L, fERO&
and report results only ELAR—HFLET,

[J Allow a less-featured boot- UEFI 734 RA|IJO 7 — ba 47 a7 7 A0 PBLU) & AHA
loader(PBU/V4) to be used if PBL(U) WA, BT —btu A7 m s APBUVA ZEHATESL LD
is not compatible IZLET,

If a device is determined to in compatible, SecureDoc will:

Switch to SecuerDoc BitLocler - T—hurtr a5 50 PBLWU) & EENRRNIES,
Management (SDBM) BitLocker Management 28]V Bz £,

FHIIZ, BitLocker Management MR ENME T,
Mark the device as incompatible - HEEEOBENT NS R E LTCREL, TUA AR LE
and uninstall D
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[Hardware Authentication]

WNAT = RUSADFET, F—T 7 ANV RETORETT,

SecureDoc options

o

General

i)

Communication

BitLocker
Management

2 |

Credential
Provider

=

Password
Manager

Media Encryption

@

SecureDoc File
Encryption

&
Advanced
Options

Hardware

Hardware Authentication

TPM Protection for Key Files [for devices with TPM available]
Do ok wse TP -

[ &llows Mabile Device-based Authentication using Metwark,
Enable Manager-approved Recaven Login
[] &llows Mohile Device-based Authentication using Phone Token [Bluetaoth)
Enable Push Hotifications for Bluetooth Phone Tokens.
[ &5k users to enroll D TP pratection on their phones
Requires enabling MagicEndpaint in Cammunication options
[] Default to use "Key File on Token" at boat logon
] K.ev File supparts both Passwaord and Token-based protection/authentication
Once token iz used to authenticate, Key File no longer zupports Pazsword authentication

[CT1F "Key File is on the Token'", remember Key File to be used next ime

[ &gk wzer to switch from pazsword to token protection

Pazsword based Key File will be created in remote installation. When uzer logz in first time,
he/she will be azked to ingert token and change protection method of the Key File,
Tokentype | ActivCard ActivClisnt Y5

Fratection method | Jce (oken RS54 keys

Catcel

TPM Protection for Key Files (for devices with TPM available)

- Do not use TPM

- Automatically TPM-protect Password-
protected Key Files

- Create Key files protected by TPM and .
PIN instead of a password

TPM ZfEH L £ A

ZET,

ZAER L £,

PIN complexity rules:
[J Allow alpha characters in PIN
Minimum PIN length: X

PIN (23 &7Fr LE T,
PIN o & g/

[J Allow Mobile Devices-based
Authentication using Network

R

NAY— R CHR#ESNIZF—7 7 A /v Z HE)T TPM {RFE(28) D 4%

INRAT— ROz TPM & PIN THR#EINTZF— 77141

K U= i LTS VTS, AR— ZADFRAR ] L
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[ Allow Mobile Device-based
Authentication using Phone Token
(Bluetooth)

o B

A~v— k7 H kB b—2 > (Bluetooth) Z B L= A L
F AL A= ADRFEE AT S

[0 Ask users to enroll OTP protection on
their phone Requires enabling ....

22— — (PR D OTP fRill 2 00k 5 £ 0 (KT 5 a4~
= > C MagicEndpoint Z N 2 LR H Y 7,

[1 Default to use “Key File on Token-
based protect/authentication

T AN BTE, b= R_R=2ORHE[FEFET [F— T 7 A1) %
ERLET,

[0 Key File supports both Password and
token-based protection/authentication

F—7 7 A E,
PR—hrLFET,

INAT—RE h—2 v R— 2D /RO 5 %

[J Once token is used to authenticate,
Key File no longer supports Password

F—T 7 ANVORGEC b= VEEAT AL E L, NAT—RNIZX
HGEE i LE T, Fov B AND E, TV T — NIRRT
4 AT TR, b= EMBLET,

0 If “Key file is on the Token” ,
remember key file to be used next time

7Y T — FBRE T — Y= FRAEE WA AT H & T T — NRRGE
T T NIX =T ANEY—FT LET, =T 7 AINNRT 4 AT
NTIERL b—2 b rGA,. ThemEstEd,

[J Ask user to switch from password to
token protection

Token type
Protection method

INAT— RS NTZxF—T7 7 A V& b=V CR#ETLHXF—T 7
ANMCEBT D2 LN TEET,

ZOF T a CEENT DGAE, @ h—27 XA TR T
BIYERHY £,

[Token type] Tix, ZNAX U A=a—nbHHTDL h—7 &k
WRLET,
[Protection method] I& b —7 Y MIDOREIZHDOEET,
- Use token RSA Keys
- Token contains PIN
- Use Certificate on token - F—7 G ZE
- Use Certificate from windows store
- Windows A k7 55 OFEI
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[Trusted Device]

IHV # - K5 B{LikRefT USB A U 72 Y%, SecureDoc @ [Media Encryption| THi B b Sz /314 R LRERIC, 1B
BEINTT ANARE LT LOIHRELET,

SecureDoc options *

Trusted Devices

. Wendor Name Vendor ID Product Mame Product ID  HWE Type

BitLocker
Management

2 |

Credential
Provider

=

Password
Manager

Media Encryption Add Remove Clear Import Load Defautt List
)}
{
SecureDoc File
Encryption

&
Advanced
Options

Hardware
Authentication

1
Trusted Devices

Cancel

<Add> A%~ <Add> #27 Vv 7T 25L&, BEJELZBRTEET,

Add trusted device wizard X

Select to authorize an inserted device, or manually enter the details:
(O Authorize a distinct device (e.g. Kingston DataTraveler 2.0 with serial number 1234)

(O Authorize a device by entering PID and VID manually
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O Authorize a distinct
device (e.g.Kingston
Data Traveler 2.0
with serial number
1234)

TNA A% SES AL Y —VITHEi L, KR SNTZT S AD HIOT A R 2455k L E
RS

Add trusted device wizard X
Select a Device to Authorize
Vendor Name Vendor ID  Product Name Product ID
[[] Show previously connected devices Hardware Encryption: Private ~
<E36) Syt

O Authorize a device
by entering PID and
VID manually

FEHATI T, T3 A=BEHKLET,

Add trusted device wizard X

Please enter the Vendor Name, ID, Product Name and ID:

Vendor ID: |:|
Product ID: |:|

HWE Type: Private ~

< E3(B) Fovtll

<Load Default List>

—ICEFICTE 5 SED @ U X N &FIHT 5121%, <Load Default List> #27 VU v 27 L
i—a—o

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
Secure

2.2.Boot Test and Color

7Y 7 — R E CRRT HDEHA AN AS A ATEET,

Boot Text and Color X

Preview

o ot 2 e 3 4 s e e T

Header

Key File Frompt

Fassword Prompt

Lock Promat

Challenge/Response
Frompt

Edit Boot Messages

FesetBoot Messages

Background Theme:
Update boot-screen background image when updating Boot-Logaon WModern

Impaort Customized Text Color w | Customized hackgrounds and text colors only apply to
Background —— computers that support high-resolution at boot time

o

H B ‘ i B
Header WWIERE SecureDoc Boot LogOn
Key File Prompt 2—H—ID Z AT HHBEICERT HXFERELET,
wHEEE  User ID (Enter for default--) :
X ZEA] 2 —H—ID
Password Prompt NAT — Ra ANTHHAICERRT O LFEARELET

WAl  Password :
e INAT— R
Lock Prompt FTTID £/3 AT = ROBANN G S T2 HAICERTHXTERELET,

MR E

You have incorrectly logged into the computer. If you know your

User ID and password, please press Ctrl+Alt+Del and try again.

If you don't know your User ID or Password, please contact your Help Desk
for assistance.

S E

Mi&-7-ID b LI AT— RBAHESNE LT,

Ctrl + Alt + Del ##ffL T, MEBL, AJJLELTIZE,

HL, NRAT—=REENTLE A, RO~V T T 271G LTE S0,

e, BUSEICR b EZRESND L O RIEFROFLHITHAR L A, 244 %

Challenge/Response FX LUV VAR AR RS E DL LFERETEET,
Prompt

SecureDoc Enterprise Server Version 9.2 V 77 LV A~ =a7 )L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

® H

S
N

Edit Boot Message T— A=V A RETEET,

FER 72 B AN EVER Y | GBI L EE A

[0 Update boor-screen T= a7 F U OTHIFC, EREBRETER L ET,
background image
when updating Boot-

Logon
Background Theme: Classic :IHZ A 7O 7Y 77— s iRiEMi
Modern : @i RIS L7285 LW Y 77— SRR A
Import Customized WO A2 LT CTEET,
Background 7rANMEXIE, 24y O bmp 74—~ v b
Text Color LFOEERETEET,
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2.3.Boot configuration

[General]

T—hustrrass AOBRERLE

Boot configuration settings

General
[ tdask keyfile input (=]
[] Force user ta input User 1D at logon
[ Pass user credentials ta pour integrated sign-on DLL
[[] Change PCMCIA 140 address if zero
[15manCard + password authentication; User D is derived from Smart Card used in ‘Windows

Keyboard layout Enable SUISAM (] Enable SLISAM for LEFI
et ] &llowss User to Crypto-erase device at Pre-Boot using keystioke sequence Key Sequence Settings
rﬂ% [ Protect Auto-Bioot with TPM if TPM suitableavailable
e [] Disable Auto-Boot, preventing bypass of Pre-Boot Authentication
Options Enable silent Auto-Boot [bypass Boot Logon authentication]
[ Force permanent Auto-Boot [never display boat logon]
‘:-'."E!E | Browse
Network Access Allow uger to login to SecureDoc Control Center without a password
Control Autornatically reboot machine after remote command activates forced permanent Auto-Boat

[

Unattended devices left at Pre-boot will auto power-down after [max B0 minutes) 0=

b amimurn number of permitted failed loging at Boot Logon

-

Enable touch support

Smartcard reader type At ~
temary mapping base
MBR access mode 0 v
Wirtual MBR Yes ~
Special BIOS mode Mo e

Special v Mode [Hex)

Legacy Boot Loader

() Use V5 BootLoader only

(® Default to V5 Bootloader, with option to use Y4
(T Use 4 BootLoader only

() Default to 4 Bootloader, with option to use Y5

JEF! Boot Loader
() PEU: Mative UEFI pre-boat environment
(®) PELL: Linux pre-boot for UEF] devices

t awimum number of failed PELL <

boat attempts permitted before
Pre-Boot switches to PBL

Cancel

[0 Mask keyfile input (¥*****)

=P —D AN LIELFENT ZAZ Y AT ICEEHRL SNET,

(AT —RET 74V FTHIZZOFETUEIET, )
T—tra S F I ——ID O AL TLE LTS,
BRLCWARWES, 7740V bOa2—F—IDII AT EMELE LE
A,

HaEYA A DLLICERZ LTy vz LET,

SecureDoC B D/NT A —H — R TH X HICRE S L7 DLL 28
HY, ZTODLLEFEH LT — a4 ANz 2—H%—4
ENRAT— RERBTALAIC, 20X avicFavrZEANE
T, EBEILFEALEEA,

[0 Force user to input UserID at login

[0 Pass use credential to your integrated
sign-on DLL
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[0 Change PCMCIA I/0 address if zero

o B

T—hruZF N —k PCOPCMCIA U —X#—%2fHT&EARWiE
G T RUAIREICHEND 2 AREERH Y 9, £z, HEICL-
TlI%, SecureDoc T7 RLAZEL{MHTEAL LI, /—Fh
PC®» PCMCIAI/O T KL A%ZTFT 74/ 7T KL AD

D0O000000 | IZAEHTHMENH Y £,

SmartCard+psssword authentication;
Use ID is derived from Smart Card
used in Windows

SmartCard+pssword 8iEDHE, = —H#—ID £ Windows Tff ]
EhTuwb Smart Card 2> HG L £,

Enable SUSAM

N= R =T NN T = FREICY R — F SN TWD2E 5 A B2
LAl T =y 7 B ANVET,

Enable SUSAM for UEFI

UEFI 534 AT, N— R =7 RS 7 — "NBEICHR— FENT
WAENE I MDA AT =y 7 B ANET,

Allow Use to Crypto-erase device at
Pre-Boot using Keystroke sequence

7' 7 — FERFEW ¢, Crypto-erase ZF{TCE5 LKL E7,
Crypto-erase #E1T9 5 &, 7 /34 AN EALF —23HIBR S 4,
TR ARBEIZRY £T,

Protect Auto-Boot with TPM if TPM
suitable/available

TPM 2NE TN ATRE 72556, TPM THA— F 7 — &R L £

Disable AutoBoot preventing bypass
of Pre-Boot Authentication

F— 7 — MERZEDNIL T, 77— FRRAEDONAA N AZHEE
X

[J Enable silent Auto-Boot (bypass
BootLogon authentication)

A— b7 — MEREZ AL LT,
FryliENNDE, 2=V —=RELT—brrF &@LU CGHEIES
NTVWRWEATH, A= b7 — b E2ETTEL LRV 7,

[J Force permanent Auto-Boot (never
display boot logon)

Wb EN=7 747 bOa—P—|Zx L TCT Y 7 — FifiE & #or
SHFEHA, 22—Vl EBY OJET Windows 1281 A
l/ij_o

Select Auto-Boot account

F— "7 =TT LTI FataELET,

[J Allow user to login SecureDoc
Control Center without password

WAE/Z2 L CSecure Doc 2 hr— b X —lZu /A T&bH L
INCLET, WA — N7 — "B HR T A ACH#EA L ET,
A= 7= MDA, 2=V —DFXF—T 7 A NV EFEHETIZTETIN
5z, —H—|% SecureDoc = hu—Lkv X —|lZua s A T
X770 ET,

[J Automatically reboot machine after
remote command activates forced
permanent Auto-Boot

SES 72b U E— ha~y FTK@NARA— M7 — MEREZ AT L
T, v HEICTER L 7,

Maximum number of permitted logins at
Boot Logon

FY T — FRIETHASND 1 7 A RO A EE R ETE £
+, BECRESNEERICET S L. ¥—T 7 A UTHBIICE v
7 SnET.
HIME T15)

TNA ADT v 7 BRERT 2121, BHES—T7 7 A VERIZRY
— RUDNYRYMETT, JIOF—T 7 A0 Tal A RNk L5
BTH, vy INEXF—7 7 A NVITMREBRENET AL

Unatiended devices left at Pre-boot will
auto power-down after (max60 minutes)

SecureDoc 7 74 7 v FOERE A AT L T b —ERRINIZ 22—
P—RBIBT DN TS E, T/AL 2k vy vy MUV LET,
ZOMRER T DB, FERE (9) ZANLET,

[J Enable touch support

TN T — NRGET, A AT Y —rF—R— RE2HEHILET,

Smart reader type

T T — NRGERE, b= U EEERCE WA, T~ et
07T AN =7 )= —RBETERNZ ERFRO 1 >E LT
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g&ll

By

BEioNET, 2L RGE, V—¥—0% 17 (USB, PCMIA,
Seria) ZffET 5 Z & CRIEZ R TEX 25680560 £7,
(7 /v Mt Auto)

Memory mapping base

7T — NRGERE, 7 — bu A PCMCIA V — X — % i C&
RONGE, TAAADRAEY =y B ZICREN S 5 TN H Y
To ZOXIRGE, T AEDETAEY vy BT DT R
AaBHELET,

WinMagic 7 7 = L% R — MIFHR L7z ETRIA L T E &,

MBR access mode

Master Boot Record ~® 7 7 & A9 A HIE A Al 62 CT9,
BIOS i OIRE T, UEFI 731 AT OEEETIEH D £H A,

[77®2E—F 0]

o7 e 7T AIMBR 2R S0 E ) ITRAEL £,

[7 72— K 1]

MBR OZE R Z#FFrl L E T,

[77®2E— k2]

MBR ~DOZEH#EZ L L 5 & LTWAH T u /T A& #HIEL T, MBR
MEBIIEHE I N TN DIZ, BHEEINTND LM ST ET,
(IFEAEHERINEREA)

[77®2E— K 3]

NR—=T 4 arT—TNVOEREZHFINLET,

Virtual MBR

JEIRT — b L a— RORET, WICHHREM Yes)] OFEFIZLT
BEET

Special BIOS mode

N= R =T Oy ha—7—=3F R AOEENCEEE 52T\ D
el LET,
WinMagic 7 7 = 1 V¥R — MIHH# L7z ETRIH L T2 &0,

Special Y Mode (Hex)

MBR OEJENEN 2 8 2 BN 6 DA EA L £,
WinMagic 7 7 = 1 V¥R — M L7z ETRIH L T2 &0,

Legacy Boot Loader

BIOS /31 A} 7 —hturA4r7u s AOER

© Use V5 BootLoader only

V57— st 7ra s a0 ELET,

© Default to V5 Bootloader, with option
to user V4

V5 7—btuertrrar I AL, 2N E<EETE 20
LXICHVEA T =l At oral I rE T 3—NNy 7 LR
THEDICHELET, (T74/V MEE)

© Use V4 BootLoader only

HV4 7 —burdr7nr 7 hO0hiEE LET,

© Default to V4 Bootloader, with option
to user V5

HV4 7 —turtrrarInafffiL, £nn) E<EFCER
WEe XIS T — bl gt a5 hE 7 F— o3y 7 LTl
TLHEOITRELET,

UEFI Boot Loader

UEFI /31 R[a)l) 7 — a4 7 a s T hAOiER

© PBU: Native UEFI pre-boot
environment

FAT 4T TV T = OT—bturstrrarss s

© PBLU: Linux pre-boot for UEFI devices

Linux 7V 7 — D7 — bt o7 s o A

PBLU T, Linux X—2DH%— K X—5 48T (75 1)V — L%
AT HEEZM A T, A~— K74+ 2OV R — MIARFAKT
T,

T A= 7 EMHT %A, PBLU 28R L T 7230y,
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Maximum number of failed PBLU boot PBLU DR E TRENZ KT 556, PBU ~HEIICEI D B2 52 &
attempts permitted before Pre-Boot MAHECY, PBU ~Y) 0 #x 571D PBLU TORATEH A #E L £
switch to PBU 7

[Keyboard layout]

F—AR—FLA7 7 MNIETLIRE

Boot configuration settings >
) kevboard layout
w IF wour keyboard lapout differs from the English (US] GWERTY layout for entering Latin characters, it is
Geneml possible to get boot logon ta remap your keys. Thiz option exists primarily for some Western European
N keyboards and Diworak keyboards that change the location of Latin characters. Most intermational

keyboards keep the BWERTY layout in addition to the layout for their ovn language, go thiz option may
not be required.

Keyboard layout

Default Feyboard Layout: | Japanese e

[ Automatically detect keyboard layout when installing Boot Logon
[Mote: Securelioc will only detect kepboard lapouts included in the above selection.]

Advanced Support Foreign keyboards
Options
[Jwhere an On-Screen Kepboard applies. it will begin minimized at Pre-Boat

i

H H ’ B

Default Keyboard Layout: TNEG A ma—F8 0, TS RACEDEESHEOF—HA— LA
T REEIRLET,

E O OHARGEX—A— RFTiL, [lJapanese) Z#EIRL T XN,

0 Automatically detect keyboard layout SecureDoc DA A b —/VIFIZ HBIZF—R— R A T U K&
when installing Boot Logon HLFET, BARES—F—F, USHF—R—F7RdL, Bidrd—©FR—

RLAT T bOT AL APFIET HEEICEDTT,

ELWE—R— R A7 7 FERETERVEGEAIE,

[Default Keyboard Layout:]

T, WURF—AR— R A7 U FEFRL T ZI0,

[J Support Foreign keyboards English (United States) LSt OAMEREX—AR— R&EAT 58

G, Ty rEANET,

O Where an On-Screen Keyboard applies, | A A7 V—r % —R— RB#EH I 56, 7V 7 — FSGEHE G
it will begin minimized at Pre-Boot T, wMELET

[Advanced options]

WE, RETOILEIHY T, RELEETLIHEIE. 727 =WV PR— MUHRLIELETRE IR T EEW,
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Boot configuration settings X
. Advanced Options
H Advanced Boot Settings
General
WARNING! Please consultWinhMagic Technical Support before changing any Advanced
=z ] Boot Settings!

Keyboard layout ® Start: X After:
. » Size: rrhdode:

Advanced Option: 04D mode: u

- Boot Parameters: |
=

Metwork Access
Control Fre-Boot Features

[JAdvanced ATR Mode (not recommended for most cards)
Device will attempt to contact PEConnex Servers for a maximurn of seconds
EFI

[“]Use UEFI BootOrder

[“]Use UEFI driver hook

Force Direct Boot to Windows

|Transfer Keyta 05 in BAM w

[Jweh Browser Default URL:

Foot CA Certificate (cer only): Browse

Intermediate CA Cerlificate (.cer only): Browse
PEConnex

[JHide the User and Passward entry fields during autoboot
[] Device will not respond to netwark pings until Windows has started

Advanced Boot Settings

X Start: 77 /v MRGE 5 040

X After: 77 4V MEE 5 0000

X Size: T 7 4V RERGE ; 7¢40

X-Mode: T 74 NERE ; 45

DVD mode: 0

Boot Parameters: T—hturFrra s AR, I THRELEARTA—F—FEZTLE
7

Pre-Boot Features

O Advanced ATR Mode (not A~— h#H— KT, Advanced ATR (Answer-To-Reset) J&M:&2 AT 55
recommended for most cards) | & (F&AEDH— RITIFHERESILETA)

Device will attempt to contact PBConnex #—t A~ ks D 8z sk i LE 7,
PBConnex Service for a
maximum of X seconds
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UEFI

0 Use UEFI BootOrder

[J Use UEFI Drover hook

[J Force Direct Boot to Windows

UEFI 7 — hA—X—%fH L, IE&E 1 o EE L ET,

1. SecueDoc Boot Logon

2. Windows Boot Loader

UEFL O R T A N—=3A U7 4 7 NFEEEZ TN D UEFL 734 AT O E
T9, UEFL RTAN—= A T 4 TN 7 havThh, RTA 38—
EEREBIMEILTH720OKEEL | FFED RTA RN—BREDa L hua—F
— B TEX DN EINERET DIZOOENRH D T,

SED ##{7 N1 2 ¢, 7V 7 — MR IZ Windows ZEEh T X 7oV 4.
Windows ~D | # A L7 F 7 — s A RAHET,

Transfer Key to OS in RAM

Transfer Key to OS using
Persistent Storage

F 7 F I FRE
7Y 7 — FERRECREREIZ SN L7tk E 5 IC B el E A € U & - THiik
L OS #if#) L £,
T— A —F =N ELLENET LT 34 ZADEA,
1. SecueDoc Boot Logon, T,
PRREICHENT B &, #EAE Y RElce— Rah,
2. Windows Boot Loader] % #&Hd 2Rl
FEflio> T B b SNz T « A7 ZEZLLET,

k7o 2. Windows Boot Loader| ZiiE#)§2Fic, A€V kice— KL%
A7 VT LCLE I TANA ADEE, OS BEIHICK S{b3ni=T + A7 %1
FbTET, OSZEEHT A ENTEERA,

ZDOX DN — AT, BOWEICT 4 A7 AERALET,
SR 5 &, EIZHEEITT 4 A7 M BEIBRE R E T,

0 Web Browser

7Y 7 — FEERERE, T UV ERIATE S LI LET,

Default URL: F7 4N kD URLZFELET,

Root CA Certificate URL ®7 7 & AlZ B L— b CAGEEZRE L £,
(.cer only):

Intermediate CA Certificate (.cer | URL ®7 7 & A C /3 h i) CAGEHEAZRE L £,
only):

PBConnex

0 Hide the User and Password
entry fields during autoboot

TV T —h Xy M=V DA — 7 — b E2RIHT DT 34 AT, —
PN STID LA T— D7 4 — L RITM LD TF EEASIT5 L,
A — 7 —bh &R EHA,

AN ZE DI, ID &R T — ROADEFTZEERICTHZENTEE
7,

[0 Device will not respond to
network pings until Windows
has started

Windows 23 E 45 £ T, T34 AL Ping I Lsnk Sl LE T,
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[Network Access Control]

TV 7=y MU= RBREERIAT 2 mE0R v U — 7 REETT

Boot configuration settings

&

General

Network Access Control

Connection Settings
(@ Connectto SDConnex over wWi-Fi

] OConnectto SDConnex averwired link

Wireless Settings

[ IHide wireless canfiguration at pre-boot

Do not reveal passwords at pre-boot

Keyboard layout

Access point

Ky

Advaneed-Qptions Security Pratocal | Open

Encryption protocal |None

MNetwork Access

Control Credentials

Account name

Fassphrase

802.1x Authentication

EAP method

Transport Layer Security (EAP-TLS)

Show text

Authentication type  [Davice ceriicate

Device Name format

802.1x Cert

Trusted Root CA <naone>

RADIUS server

H H

Connection Settings

The ONES name of the local computer

Use fixed account

Add "host™ to name

e

sh&

|

O Connect to SDConnex over Wi-Fi

T MU —ZFEFEC, Wi-Fi#Eki a2 EH L £,

[0 Hide wireless configuration at pre-boot

7Y 7 — FERREEE T, Wi-Fi REEZ R T LEE A,

O Connect to SDConnex over wired link

Fv MU= RRAEC, ARMER AN L ET,

[0 Do not reveal password at pre-boot

7V 7 — FREREEE T, NAV— FEFRLERA,

Wireless Settings

Access point

FIAN DT IV EARA LV NEBELET,
=W —i%, 7V T — NRGEEE T, BOT I ARA L B EAF Y
UTCEET,

Security Protocol

T RARA  MIEHET DI BB R I A Y L AEFanT 07
= N g - /NI D=

Open

Shared

WPA-Personal

WPA-Enterprise

WPA2-Personal

WPA2-Enterprise

Wired 802.1x
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H B

Encryption protocol

o B

FitCERLztx 2T 4 70 barn <, Bk a han
NEREINET,
DX T a s EZT I ATEEEA,

Credentials

User name (Account name)

EAP method MR T, KA Lb Y £4,

802.1x Authentication T, PEAP Z[&EET7 v F TRET L
Bl

Passphrase

WPA-Personal . WPA2-Personal 77 A0 ua 7 A L /SAT— R
FFI AT L= AT LET,

[J Show text

A LIZRAT — RaFoR LET,

802.1 x Authentication

[J EAP method

EAP FBFEHFEZ IR L £ 77,
- Protected EAP (PEAP)
- Transport Layer Security (EAP-TLS)

[Authentication Typel4 7' v a X HBEIMICER S E T,

0 Use fixed account

PEAP T, EET IV FERETEET,

O Device name format

EAP-TLS C. 4B L SNDF A 247 +—~< > b (DNS 4.
NetBIOS 4. FQDN) OWF170%84R L £

The DNS name of the local computer
The NetBIOS name of the local computer

The fully qualified DNS name of the local computer

0 Add “host/” to name

Frv IR I A% ) w7358 TN ALOFNT Thost /] %
GHDHLENTEET,

Trusted Root CA

ZOMREEFE T 254, FRilciEtHEE A AR — N LET, Frvy
TR YA NEEHA LT, SESITA v AR— hERTZAEHED FH
O EHMOFEFEZ BRI L £7,

SESz YV —)l A=o—/—

D [Tools] -> [Options] -> [Server’ s RSA keys]

@ <Import> #27 Vw7 L, GiEELA R — M LET,
[Options]V « > RUNRERENETOT, FEIZ
% % <Password rules>R& %27 ) w7 LET,

RADIUS server

RADIUS #r— =& A LE T,
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2.4.Port Control

Port Control DFREAZ T2 & FFED USB 731 ADH A ATREICT 2 Z LR TE £,

@ [Install port control] &. [Block unauthorized USB devices] (25 = v 7 % AXl., <Authorized Devices> 7~
iUy LET,

Port Control X
Install/Uninstall Port Control
stall port control
Port Control Policy
Elock unauthorized USB devices

(@ Manually configure authorized devices
I Authorized Devices I
Ohutomatically build the Authorized Devices list on the
client, authorizing currently inserted devices
Close
H B ‘ i B

Install/Uninstall Port Control

© Install port control l Port Control # 1 > R— kL E7,

Port Control Policy

O Manually configure authorized <Authorized Devices>Hh# > %27 U w7 L, HHAREE T 57 /31 A
devices IR L ET,

O Automatically build the AT NCHGBEBERT NA AV A N BEIICER L, BIFERAS
Authorized Devices list on the NTNLT A AEEKRLET, ZOREEZAIMTDHE, 74T~
client, authorizing currently- T AL ZFBIEFFA SN TWD T NA AXA T A% ¥ LTHEN
inserted devices Security W2 TARTA RY AR IZHEL, TOT A AZFERIICZ T AIUATHE
Protocol RTNARELUTHAZFAITEET, ZOBIEBMOFMIEX, A—k

ay hr— L EICESICL T, 1A (w7 A, F—FR—FK,

WYy —n) HAR—U U THIHTEL LI 22T, 1 K#H

B, T RATEEOT A Ay ROHOYR— T 25 X9ICRED

‘ij_‘o

E ORI, T ATM X 4 A7 T, 2 o 10T 57
NAAZEFIZHR—NTHEMTEMSNE Lz, b ORI
efor S AL D OB AT, B RIS ICHIBR S AVE TS R LA
SNTRIT, EBLE XM O DIC~ T A /F—R— K27
A RGP T DMEN O L H5ERNH D £77,

@ WOBEEMNRFERINDOT, <Add> 27V v7 LET,
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Authorized Devices X
Description Vendor 1D Product ID Serial Mumber Add
Keyboard
Mice Remove

Human interface devices

@ HEOT S AT T ABATERT 5841, [Authorize a device class] 7 V4R # o,
FEEDET VD USB 7 /31 AN THART 5354 1X. [Authorize a device model] 7 VAR ¥ >,
BrE D USB 731 AD A% AT 584 1%, [Authorize a distinct device] 7 V4R % %
BIL, THIZHD <k~>%227 Vv 7 LET,

Add authorized device wizard *

Select whether to authorize a device class, device model or distinct device:
@ Authorize a device class (e.g. Printers, storage ...)
(O Authorize a device model (e.g. Kingston DataTraveler 2.0)

(O Authorize a distinct device (e.g. Kingston DataTraveler 2.0 with serial number 1234)

[Authorize a device class] 7 VAR KX &7 U v 7 Lichf, IROBERNBERINET,

Add authorized device wizard X

Select Device Class To Authorize

Human interface devices

Bluetooth devices

Display and image devices (Digital cameras, scanners ..)
Modems

Network devices

Disk storage devices

Floppy drives

USB hubs

Windows portable devices
Specialized Windows portable devices
USB printers

Mice

Keyboard

NOTE: A single device may expose more than one device interface class. All device interface
classes for a given device must be authorized or the device will remain blocked.

<E3(6) *rvtlh

TNART G RAEBRL T, <FET> 27V v 7 LET,

[Authorize a device model] 7V ARZ %7 1V v 7 Lizia, IROBEINERINET,
(RIVTZNWT A, 22 L, SESICRHBIEET, T ARTHIND L —HICRRSNETOT, AKBSE
WT NS ZREBRIRLET, MBI L2 EDOH DT A 2% 55615,
] Show previously-connect devices| OF = v 7Ry 7 A%+ A2 LET,
%2, <5ET> 227V vy 7 LET,
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Add authorized device wizard X

Select one or more device models to authorize

Description Vendor ID Product ID
Buffalo Usb Flash Disk USB Device 0411 023A

[] Show previously-connected devices

i

< FE3(B) =T Froeil

[Authorize a distinct device] 7 VAR %27V v 7 LichE, ROBEHPRRINET,
I EIWT NS R&R L, SESICHRBISEET, 71 AREBIND & —HICRTRSINETOT, AFIEk
WT N ZAZEBRLET, MEICERLEZLEOH DT 1 24BN 28561%.
[0 Show previously-connect devices| OF =y 7Ry 7 REF NI LET,
B, <5ET> RAFUEIY v LET,

Add authorized device wizard X

Select one or more distinct devices to authorize

Description Vendor ID Product ID Serial Number
Buffalo Usb Flash Disk USB Device 0411 023A 07001C7D88A0SED2
< >

[] show previously-connected devices

< =3(B) =T el
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2.5.Disk Access Control

Disk Access Control OfREZ T2 &, USB 20D HiE TR SND T /3 AZHOWTHIET 2 2 &N TE ET,

Disk Access Control X
Disk Access Profiles
Add
Delete
< >
Temporary Profile Scheduling
Use temporary profile: Feset
Prafile will be enakled for 0 minutes starting fram 10/16/2022 02:23:07 F1& = Start now
Disk Access Contral Profile Details
Frofile Name: Default
Femovahle Media: Mo Restrictions ~
CD/OYD: Mo Restrictions w
Windows Portable Devices: Mo Restrictions ~
H H ‘ B

Disk Access Control

<Add> K% T4 AT 7Ry ba—)VHIZT 7 4 NUSMNEEO T e T 7 A VB
ETHZENTEET,

<Add>RZ T, —~H7n 7 7 A VEERTE £,

—F7' a7 7 A VITEE LI oG8 727 a7 7 4 )L TT,
ZNLSIT 7 H v T T 7w A VORENEH S ET,

Temporary Profile Schedule

Use Temporary Profile TR T s ANERETDHAIX, IAF T A =2 — L0 <Add>HHF %
7y LCBIMLIEY a7 7 A NVAERINLET,

Profile will be enabled for X W7 7y A NVOAENRERE] (43) BEO, WOoNLAMITH0EHRE L E

minutes from Xx/xx/xx kR

Disk Access Control Profile Details

Profile Name: WEEHETDHT a7 7 A NVANRERINET,
Removable Media UL—INTIRAT 4 T ~OHIE T EZ RN L £ 9,

- No Restrictions  (FlfR72 L)
- Read Only, unless Encrypted
(AL SN T WA THE A 000 )
- No access, unless Encrypted
(s TWARWNE T 7 & ART)
- Read Only access (iAW #H7 7 & X)
- No access (77 & AAKH)
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m

CD/DVD

G

CD/DVD O Hilffl )5k %8R L E 9,
- No Restrictions (fill[R7: L)
- Read Only access (FiAHuv BH7T 7 &)

Windows Portable Devices

Windows 7R— % 7I)LF 3 A ZA~OHIE 71528 L £ 7,
- No Restrictions (f[R72 L)

- Read Only access (G B 7 7 & A)

- No access (77 &EAART])
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3. SecureDoc Enterprise for Windows Xy 7r—3

[SecureDoc Enterprise for Windows] 7 At AZMEMTHA A b b—a Ny —UOFREHEBIZOWTHE
MLET,

TuebVa=m b= E il A VA N L— g Xy =V OIERTIEIZ DWW TIX,  [SecureDoc Enterprise Server
Version 9.2 7 A v 7 A VA M=V HA R] ZIBHITZE,

O® f~A @ [Installation packages] 74 2> Z&IN L, <Add> R¥ %7 Vv 73D, AL DLTHZY
v L, ary7TFARA=a2—25 [Add package] #27 VU v 27 LET,

[3] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SOLEXPRESS, Database name: SESDB, User name: SESAdmin Od 4
Database View Folders Keys User Tools Help

Secure
b X & B @ =T 2
Refresh Del Generate Key File

Install Filter Help
= |, Folders A Users M Devices “{( Feys ‘ lf_?" Groups ‘
: SES Administrators | [Num|_UserID
w wmjlocal
-y All Folders
g Purged Devices
g Exempted Devices
'\‘; Recycle Bin
AJ Profiles
-1 Installation packages
g{ Machinelnfo Tiles
53] Logs

.. Folder Encryption Policies | g Drives

/| First name | Last name

Dormain UPM

e mail Descr

© [Please select the profile type] U 1> RUNKRRINET DT, [Endpoint] DT NF T A=a—L Y

[SecureDoc Enterprise for Windows] Z#iE{R L, <OK> A& %7 Vv 7 LET,

Please select the package type X
(@) Endpoint (@) () cloudvm
ISecureDoc Enterprise for Windows VI

Cancel

X HBEOA AR L—va RNy b —VURERT %A, EREOA AN —va Ry r—URRET DI L
TRBLICIERRCTE 7,

ERFDOA A ML —va vy r—T% 427 ) » 27 LT, [Copy Package] #5EfTL %9,
[Package name] IZH LWy r—TU4 5 AL, LEREHEZREL TRFEL T Z S0,
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[General]

70T 7 A VORRERCH SR ORER ENFENET,

Installation package settings »
4 General
General Fackage name || |

q?‘*jl Comments | |

Create new users in this folder during the remate installation

Key file
a == ot zelacted = | Browsze
% Apply thiz SecureDoc profile during the remote ingtallation
Uszers -
Device Profile | Profile-01 | Edit Browse
AY. [ Aisk user to verify data before starting encryption
Provisioning Farce uzer to complete all data fields
Rul . .
Hies Drefault device (D iz emply
Default uzer 1D iz emphy
Key name farmat
(®) Device nams Add random characters to key name to make it unigue

(JGUID

- -

[ communication fails, retry every 5 = minutelsl upto 5 tirne(z] [0 = infinite]
[JIn case of communication eror, continue installation offfine

[]¥#ait for the file distribution software ta rebaot the system

Hide encryption progress from ueer

Restart device when encryption is completed [ for hardware encroption will power off ]
[ Allow SecureD os installations b run silently when deploved using file distribution software

[]Suppress message after initial installation

[ Disable installation-time debug log

Package name BT DA v A ML —va v o r—I4 5 A LET,
Comments VIS LT, aAy MEANLET,

Create new users in this folder during the remote installation

*** Not selected *** <Browse> #7 U w7 L, 4 VA=A T v AR/ERT D 2—
P— DRI 7 A N A HIEELET,
ADSync ZfEH L CTWA A, ZOREITLEH D A,

Apply this SecureDoc profile during the remote installation

Device profile <Browse> %7 U v 7 L, 7L RZEHT 5707 7 AV EFEE
LET,
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H B o B
[0 Ask user to verify before staring AL & BA T D Ei.  [SecureDoc Ok~ +—Lb| =T A7 K
encryption v INIER L, =P =L —F—IDALREDOHRELEAHEL L
7

[SecureDoc DBk 7 4+ — A1)

& SecureDocDEFI1—1 X
SecureDoc’
by WinMagic
1-Y-13E
a-1-1D: User-001
&t
¥
L+
EF4-0
IVE1-9158
JIVE2-7ID: LAPTOP-FUGIIO7A|
IUTNES: PF1XGSQC
RET: LENOVO
B 20NBCTOTWW
BT
J0K71 59:
*-T71{ %R
*-1D: LAPTOP-FUGIIO7A key _2878368870e0b470_
=7
[J Force user to computer all data fields [SecureDoc DRk~ +— L) DETOT 4 —/L FEZEAIZLE
KD
[J Default device ID is empty SecureDoc DXk ~7 A — L) O [arta—2fFH] (CHT57
4=V FEZEAIZLET,
O Default use ID is empty [SecureDoc DXEE 7 +— L] O [o—HF—IEH | (2T 57 1 —

NV REZEHIZLET,

Key name format

© Device name TSN A4 LR O8E AR L ET,

[0 Add random characters to key name to | #4127 v X LR XFHEML, 2=—27 b DL LET,
make it unique

© GUID GUID &[R4 o#EE AR L 7,

O If communication fails, retry every X BRI L6, XAOZ EIERXEIY NT A4 LES
minute(s), up to X times(s)

O In case of communication error, WEXZT—DEAE., 774 T VA M=V EHITLET,
continue installation offline %1z, SDConnex LBEZRBI/MHI &, 7 I7A4 T bT/3A ATH

% S AL7-4t% SES DB ICfRfE SN E T,

[0 Wait for the file distribution software to | 7 7 A VY 7 BT AT LA HEBTHO2/HHLET,
reboot the system

O Hide encryption progress from user OSSR ET A7 by 7 EICERLER A,

0 Restart device when encryption is WEbse TH, T/ AZFEiE LE4,

completed (for hardware encryption will =R =TI KT A T E2HBHE L TOhDT A 2ADEEIE, vy
power off) v T LET EBEAT)
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O Allow SecureDoc installations to run T ANMEAY 7 b =T LRI 2%G, SecureDoc @
silently when deployed using file AVAN—NEFA LY N = RTIETTEDHLIICLET,
distribution software
O Suppress message after initial A A N —=ARIT, BT bR TET LIERRZR RS ND A v —Y
installation M SALDOT ) ZIERTRICLET,
[Key file]
HEFR D% E &
Installaticn package settings *
. key file
General Password rules

Mote: These privileges are only applied for new ugers created during a remote ingtallation,

Privileges: (®) User Rights (O &drin Rights
Modify Pazsword [] Modify Profile [ Corwvert Removable Media
[] Modify Key [ 5elect Profile [] Corwert Hard Disk
[C] Export and Wiew Key [] Config SFE [] Disk Integrity Check
[]%iew Transaction Log [] Create Emergency Disk
] [] Exelude from DAC [password syhc should be enabled)
P4
Provisioning [] Use hardware token b protect Key Fils
Rules Thiz iz only applicable if on-ine communication with a server iz uzed during remote ingtallation,
Iger muzt exizt in the database and user's certificate must be loaded into the user's recard.
H B ‘ oW
<Password rules>7h % > Ta—N"NVA T a V TERESNTWDT 74/ EO/RAY — R)L— LR FoR &
ET,
[Tools] -> [Options] -> [General]
<Password rules>
T THIROREAZ AR TEET,
Privileges:
© User Rights I a—rVE T g U TRIE STV AR 5 EvET,
[Tools] -> [Options] -> [Key file options]
T 7 /v hRETIE, [Modify Password] OA 5 S CTnET,
HEMR—HE b, MEERMHER 2T 5 TE 7,
© Admin Rights Ty TDHE, RCOERPTEINET,
O Modify Password Z—H—F, NAT—RELEFTEET,
[0 Modify Profile A—P—F, TeTrANEEETEET,
[J Convert Removable Media TP, VA= NRNTNRAT 4 TR TEET,
O Modify Key =W, BEAM HIBR, BLOAS VAR — R TEET,
[] Select Profile =P IF—E A HIBR, BLOAS VAR — R TEET,
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® H

[J Convert Hard Disk

G

Z—F—F, T AT ORI/ E LB IR ET,

[ Export and View Key

=L, WEEMECEET, HEE T A NVEZ I AR—THD
Lo, RO —T7 s AN AR—FLTZY TEET,

[0 Config SFE

a—H—L, 7 T4 7 MIT, SecureDoc 7 7 A MG b &2 EFRT H Z &N
TEET,

[ Disk integrity Check

TAATDEEMNT = v 7 BRIRLIZGETYH, 22—V —IMEREHITTE X
o TAAREREL, T4 A7 OBEEEOT-DITH LWEA ZFER L ET,

[J View Transaction Log

2—H%— %, Audit Log # D Z &N TEET,

[0 Create Emergency Disk

=Pt TV VT 4 AT EERTEET,

[0 Exclude from DAC (password
sync should be enabled)

DAC ##5hic LEd, CGAFITIRIRLEEA)

AVARL—=2a Ry =070 7 7 AIVOREICT, TAAIT 7 A2
> hr—L (DAC) BHEMIEE S, IMNBAT 4 7 ~OEHNHIRE N TS
B, INTAT AT ~OT VR APMTAT, T4 A7 %7y 7 LThH, 4MB
AT 4 T IR ENT =X OBEMTZEHE A,

[0 Use hardware token to
protect Key File

DAV AN—NR =V FTTDHITAT 2 T AL ADZ—H =03 B
FALEINI=T ANA AZEFIZa 7 A T HITIE =T VDSV ETHDH 2 EERE
THEAICA AT LET,

h—27 i, 22— —ZBEMT SN TR ERE EN TV ALERH Y F
T, ZOF T arEHERT AT, B — Y —FEHEE#R A Active
Directory 7% SES |24 VAR— T HXENH Y 7,
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[Users]

EREHROID 227 747 2 T AL A ZARO2—F—L LTRERT DRE

Installation package settings x>
" LJsers
General
Atthis point user or administrative accounts may be added to the installation package.

a7
'lg‘*J Administrative accounts must satisfy the following requirements:

Key file -they must have admin rights;
@ - they must have cerificates loaded into the database, if token based

4 User or administrative accounts can be either password ortoken based.
Authentication
questions

Users Bo.. UserlD Privileg... Protecti.. Add
' Delete

Provisioning Rules

<Add>HR %> AV A M= T ARic, BEEHEROID # - ANBUKEOZ—F—2 LTI IFA4 T N7
INA ANBERTEET, YO ID 2R LET,
<Delete>R % —EnG, EHEMIRO ID ZHIRE L £9,
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[Provisioning Rules]

FA—7F—ID ER Tk DR ER &

Installation package settings

o

Provisioning Rules

General [ Do not create and send down deploying user Key File
da)
Key file Device Prowvisioning Rules
@ Enable a provisioning state 5o as to allow access to device until its owner has been identified

(@ Device(s) will auto-boot ta Windows logon

Authentication . .
(O Users can access device(s) at Pre-Boot using this Temporary user account

guestions
Q% = Mot selectad == Browse
.
Users Crwener Identification Rules

(@) Automatically identify owner without having ta prampt user

[ Allow offline identification

() Users will be prompted to confirm device ownership: Firsttn confirm will be device owner

Device location

(@ Owmerfolder
() Registration folder
() Specified folder = Nat selected Birowse

Iowe device to a folder on SecureDoc upgrade

Deployving user
(@ Use Last Logged On User
() Use Specific User Browse

O Do not create and send 2P —DF—T 7 A NVEERET, 774 T FT A RTF—T 7 A NV E B
down deploying user Key LEH A,
File COBREDOHHNL, TV T — bRy NI =V BAEEGHTHT A AT, Fy MY

— VN LTEBREE A E L, T3 A Za—H—ID ZXEk L7\ 2 L T,

ey

Device Provisioning rules

O Enable a provisioning state | 7 rb v a = 7 REZHZHIZL T, THEEPFESNLETT A A~DT 7 &
so as to allow access to A& LT ORFETHALET,
device until its owner has
been identified
O Device(s) will auto-boot A—h7—=hMZLoT, 7V 7 — MBREIE/XA Z4, Windows # B Tx £9°,
to Windows logon
O User can access device(s) | A—F—2fEE+T25F T, U7 — FFIETIE, SES =2V —/Ld[Users]# 7T
at Pre-Boot using this FHIZ/ER L7z Temporary # A 7O =2—H—ID #fi-Tr /A > T& £,
Temporary user account
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F—F—EET D & TR L7z Temporary # A 7O ——ID (X, 7
TAT Y NT A ANGEETHIBREIVET,

<Browse>7R % >

Temporary % A 7O =2—%—ID #fEEL £,

Owner Identification Rules

O Automatically identify
owner without having to
prompt user

TAZ Ry b FRoAET, AETA—F—ID ZER L E T,
Zhuc k., A LU R A VA B L ARETT,
A —JF—ID DER T iEIEL. Rt Deploying user] O EICHEVET,

O Allow offline
identification

A7 T4 REET, A—TF—ID OEREFFRILET,
[Deploying user] O E T, [Use Last Logged On User] #R L T 72 &
AN

O Users will be prompt to
confirm device ownership;
First confirm will be device
owner

FAY b7z [SecureDoc 7 A~ VT AUV NORE] XA 7 ulEFoR
L. TAAFABETHDH Z LIZOWTHERZ RO E T,

<OK>%7 Vv r95&, ZZICEREINTWS Windows —H—473, 4 —F
—ID & LTHRERENET, HRENTWVWD Windows —H—4 1%, ZDIHF,
Windows (ZH 1 >4 L T\W5 ID T,

A —F—ID BHEET H L., T A AELEEO T Y T — [NEFEEFHTE S &
720 FET,

Iz

?

SecureDoc T 54 VT HI Y FDERE

SecureDoc

by WinMagic

800 T M ADELFEETHEEAN. [OKNETyILTF
' HIVFERTELET.

Windows1——& :

User-001

SEE : SecureDocD—ERMIEEE (JSAFYMRERY) 3. T3MNUTHYY
MR EINSETHIATEE A,

oK

TN AFIEHE TRWGA, Bl ITHYESCS v T 0 U I7EEE2 B> T
L¥EENA LA NN EBI > TEBY, 2—%—0 Windows ID THA > A
LTWRWEAIE, <tk T>%27 U v 27 LET,

<OK> #27 Vv 7 +5FT (A—F—IDMWEETTHET) . OS EdHhi%,
[SecureDoc I A~ YT H TV VORE| NERSINET,

Wiz

Device location

O Owner folder

FRA 2%, A—F—ID LRU 7+ FIT8EK L ET,

O Registration folder

[General] -> [Create new users in this folder during the remote
installation] C. fEE L= 7 4V FIZT A A %86k L £,

O Specified folder

<Browse> R T, TAA ADKEERELET,

[0 Move device to a folder
on SecureDoc upgrade

SecureDoc DT v 77 L— Rl TNA AEIEE L7 4+ /VZBICBEILET,

Deploying user

O Use Last Logged On User

A A M=V FETIFIZ, Windows ~H 1 A LTS ID VW ET,

O Use Specific User

ZCZTHRELEID ZMivEd,
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4.1. 2 —F— BT IEIEA =2 —

[Users] #7C, 2—# =&, avTFA M =a— (FVADEZ Y v/ A=a—) TRRINLHMEIT, FiLo

F=TNEZRLTIESN,

ﬁ’] SecureDoc Enterprise Server SOL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - O X

Database View Folders Keys User Tools Help

o b X & H & T 2

Add Refresh Del Generate Key File Install Filter Help
= | Folders A8 e 4 Devices |g¢ Keps | o Groups | || Folder Encryptian Policies | A Drives
: SES Administra | Mum_ | User ID [ Dormain Mame | UPN /| First name I Last name email Descrigtion
é L local Q i wrnj kaida@wmloca jE tBE ki j aida@winmagic
wmj.local winj ktanaka@wmilo #25] B4 ke njl.kanaka@winm
- Domain Ca Wi sho b T 3 AddU e
p= E ser nsel
N =z A
- &HTER & Modify User Enter
W s 4“_—1‘7 D) S & Delete User Del

{11 All Folders
Q Purged Devices

Move to Folder...

View Audit Lot
Q Exempted Devices - 2
-~ &, Recycle Bin View RME Log
LLgJ Profiles Set Filter
. }:L.‘] Installation packagt Num | Device /4 lanufacture Serial Modified Refresh e ploved State

’_ﬂ Machinelnfo files

= |, Logs

L0 Audit Loa v Assign keys to users
>

¥ Generate new keys for the users

Member of groups

Add new user
Create Key File =]

Challenge response F4
Remote installation
Save to file

Check PBConnex Access

)
5

.

Add User T AN — =2 FHHER LT,
Modify User BRL TV D2 —F—DFREmEL T,
¥ O TRELTREFELTH, T BB ST, TS RCBESNT
WhHa—H—DF—7 7 AT EEXLEEA,
Delete User IR L CW DS a——% 7 3 LA BHIBR L £,
o —H—%, Recycle bin [Z%# L £
Move to Folder:- BIRL TN 2—F—%RDO7 + VX ITBELET,
View Audit Log 2 —F—DORGEICET 5 e 2 [Audit Log) ZHECTE £,
View RME Log 2—H—D RME |24 5 1r 7 [RME Log) ZMECTE £,
Set Filter T4 H—EE T, —EALERAMETE ET,
Refresh —EFREY 7Ly a LET,
Generate new keys for the =P —DHITHTICHE AR LE T, FIIE. AT 4 THE O,
users
Assign keys to users SES bt 2 —Y—DF—7 7 A JLIBINTE £7°,
Bl ZIE, 22—V —DBICHEER L, 2—V—ICEIET D Z & AHE
Member of groups T N—T ~DBMNEFRETEET,
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=P —DF =T 7 A VEERTE ET,

dbk 7 7 A VOB TR SN LD T, 7Y 7 —|
L7zdbk 77 A L Zflio T A 3252 ENARETT,

Create Key File
FEREEE T, USB A E U IT{RfF

X TR ACHEIE SNT, TS ACEREN T S 2 —F—F =7 7 (Vi

FEXLEEA,
Fx LV L ARS ARE, 22— —D R T — REIICHHE L E T,

Challenge response

Remote installation FTIGA A VAN L= g RNy —VEER X F9,

Save to files a—P—DFERETF A MR TESHEET,

Check PBConnex Access

PBConnex ORI FIHE/ 2T /A A MR TE £7,
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4.2. 5134 AT ABIEA =2 —

[Devices] # 7T, TA A&RY, AV TFA A= 2 —TRREINDLEREIZ., TiROT—T7LE2SRL TSN,

m SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - O

Database View Folders Keys User Tools Help

x

Del

. +y

Add Refresh

Generate

A ¥ ?

Install Filter Help

Key File

=~ |, Folders

| Folder Encyption Folicies | A Diives

SES Administr
-~ wmj.local
il All Folders
Q Purged Devices
Q Exempted Device:
5_: Recycle Bin
12J Profiles
';J Installation packa
,:-g Machinelnfo files

Logs
{0 I YT

< >

v

Modify device info

Modify device info

Delete device
Move to Folder...
View Audit Log
View SFE Log
View RME Log
Set Filter

Refresh

Add keys to device

Add users to device

Assign device profile to devices

Assign folder encryption policy to device
Member of groups

Create emergency disk

Mark as parent device
Activate auto-boot
Reboot device

Lock device

Setup Port Control

Prevent Login to Device(s)
Show commands

Cancel all active commands
Save to file

Check PBConnex Access

TN ADEHRE HETE £,

Delete device

FR L TWDBT A, A&7 4V FIHHIBEL £,
T34 A%, [Recycle bin] 1ZB# L £,

Move to Folder:--

BIR L CNWDT A ZAZENO 7 3 VX IZEE L ET,

View Audit Log

TR AT A/ TAudit Log) ZRETE £1,

View SFE Log SFE 2B+ %1~ TRME Log) #METx£4,
View RME Log RNE (2R84 %=~ TRME Log) Z[ECTx £,
Set Filter T VH—RET, B LIEREMETE £,
Refresh —ERREV T Ly a2 LET,

Add Keys to device

B —F—HALTIER TS RCEETE £,

Add users to device

DB I TAT Y FTFAL REITE £,

Assign device profile to
devices

SES ET. WELLBFOT 0T 7 A Va7 A ZZHERAT 2560, o7 o
TFANMIERTHIEBNTEET,
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H H B

Assign folder encryption T ANV AREOR) =2 LET,

policy to device B, 74U ARKETT,

Member of groups TN—T~DENEFETEET,

Create emergency disk VIAT T AL ADT Y T — FERET 0 7T STEE BRREA LTS A O xRS
VEprxw—T =T 4 A7 EERTE ET,

Export escrowed key TR E—F—DTT AKR— |,
EEFIFFATE EE A,

Mark as parent device WEITHEHLEEA,
parent & child device DRz Ff>7 /31 AD4 parent device & LT~ —7
LET,

Active auto-boot WELTe—EWHM - B oA, A= T — AN TEET,

Reboot device IIAT Y NTNA AR LET,

Lock device I TAT > N T 3 ZAD Windows OS A7 U —>r v 7 LET,

Crypto-erase device(s) T4 A7 DI A e A ) T— M THIBRL £
FITENDHA I TV, 7747 k2 SDConnex & {7 Lana 252 1 it - 72 5%
T, #HEHBRINDZ LT, 2=V F—FIEE IO LFRETT,
ZDavwy REZITWMS=T 3 A%, 7V 77— EIE7T 0 7T AL EFICEELZR
<Te v EF,

Setup Port Control A—har br—LOFER) - BhEFRETEET,

Prevent Login to Device(s) TNAA~DO T A I LET,
BT D7 DIIETF ¥ L P L AR RIS L D U DN BRSLETT,

Show commands SES D DEELIZ=a~ > ROIREE MR TE £,

Cancel all active commands | 7277 4 V/ea~r &2 Tx vy BV LET,

Save to files TNA ZADWERET ¥ A MR TEESHEET,

Check PBConnex Access PBConnex OFIf A[fg727 /" A A& i TX £9,
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4.3. 7N A RAZBEFEIN TV B —F—~DEEA =2 —

[Devices] # 7T, TA AEZBLEE, TONRFIUIET AL ABREEEN TN D2 —PF—ID NFERENFET,
ZFOa—Y—=IDEEZ Vv 7 LTERENDIALTHFA M A= 2 —0BREIX., FTROT—7LE2ZHLTLIEE N,

F:] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin

Database View Folders Keys User Tools Help

- s x &

Add Refresh Del Generate

= Al L ?

Key File Install Filter Help

|, Folders

| | Folder Encryption Policies |g Drives

SES Administrators |
=8 L wmj.local
.h, Domain Contrc
-l mem
- BT
L) mEE
il All Folders

- Q Purged Devices ETE

- Q Exempted Devices - 5|
&, Recycle Bin )

-y | Profiles
i« Installation packages
,j Machinelnfo files
Logs

< >

Remove the users from devices

H H

Remove user from device

LIsers Nay]

User 1D / | First name | lastrame ___email ______KeyFie

Generating

Remove user from device
Access rights

Set Filter

Refresh

Modify User

Create Key File

Challenge response

Remove key file from device

FileVault

TN b a—HF— 2R L ET,

Access rights

T RAMEET LET,

Set Filter T 4 VE—RERET, —EDIERA N TE £,
Refresh —EFRREY 7Ly a2 LET,
Modify User =P fFEETEET,

Create Key File

FEMREFLCHDOBIMNRE, 2—P—DF—7 7 A VEFERTE T,
7547 M SDConnex FRHEIT, LWk —T7 7 A LEZIT]RY . wElOF Y 7
— FRRRERF I LW —T 7 A v Tl A 5 2 LR £,

Challenge Response

=P —DRAT — FENRIC, 16 O L) T, —ER /A &2 L
F9, =—%—1I, Windows ¥ 1 %2, BHICLD2H LVWIRATU— REREL
ROBNET,

Remove key from device

TNA ANLEEHIBRLET,

Set Device Owner

TIAAA =T =2 EEST 56, U0 —V—2@RUTETLET,

File Vault

mac 7 /31 AT D A =2 —"T7,
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5, 2—%—7aRXF 4 DHFASITDONT

a—W =77 121, [Typel ORENRHY £7,
ADSync % fif » T —¥%—% Active Directory 7»& A >R — 9544, [Regular] BEESINTWET,
FHTO2—PF—ERRFFHZIE, BICHDOE TRELET,

Add User
LJser properties
. Type |Regular v
User properties
a UserlD Auto Boat Password
% UPN name |Temporary
Member of DAY D User must change password at next logon
groups BemmEin First name
Email Last hame
Description Fhaone
Create series of “ | useraccounts
Regular : BHEEBVEAT 272002 —H—ID

Auto Boot : U 7— MRAEME T, WA LELET, B (A—FT =) &FHa—%—ID TT,
ZO2—F—=ID %7 FA4T v MT AL RZBMNT S &, i Regular # o 7O — W —ID M &g I T
WTHA—h 7= L2250 T, TESBLETT,

Temporary : YuovbEYa=vZL—nL [REx—2C) . [RX&x—2 D) THALET,

F—F—0HEET S L. Temporary O—HF—ID 1374 2 LBIBRENET,
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6. 7V 77— "Ry NU—ZFEE (PBConnex)

SecureDoc 7 7 A 7 > ME, A#k LAN & 2T LAN % ffi 572 % » b U — 27 3GEOHERE (PBConnex) ##2fft L %
T VT = FREOBFECE N T, B—=U TN ATRER SN TNDa—F—ID 245 D TiZA <, SES MIcHiksn
TnWba—HF—ID 2o Tr s A U A4HMATT, =—F—NANLLID BE—H LT NA AMFELRWEE, 7
—hrrFr7u 7 A%, SDConnex Z#&M LT SES IZHEHKIN TV D ID ~ORFEE AL E T,

PBConneX # i3 57DIZid, v 7 7 A NVOREEKEDT NA AL a—F—2BETLLENDHY 7,

KBE1 : &% PC TOax—¥F—FHEOAHER

FUT—Fxy NT—ZEEEOBRERfF S L. SecurDoc D=y RRA v N —HF—FHEEDOT NA AT V7 EATX S
L5120 4, 64 PC 4 EEBO 2 —F—RFT 57 A ZCBT 52— —EFRO AR T 5 - LA TE £
ﬁ—o

RR2  2TOREFERE T —INT A RTHE LRV & bR
TV T = bRy MU= REREERIRT 5T A ADGEE, v — A VICTEREE & Rk L 72V SecueDoc 7 T A T

FDA A B =B ARET,
TreYa = I — L DOFRE T,

A4 Do not create end send down deploying user Key File]
DF =y IRy I AEF NI LTeA VA M= a N\ =V %o T, 747 MZ SecureDoc 7 547 b %
AVAR=NATDHE a—HNT AL ALF =T 7 A VEBEESNET A, F—T 7 AARBESNL TV RN, HE
b+ 2D —T 7 A NVEFITT 272D ID/PW 2MFIEL £ A

Installation package settings s
. Provisioning Rules
General DDU not create and send down deploying user Key File
= N
Key file Device Provisioning Rules
@ Enable a provisioning state so a3 to allow access to device until its owner has been identified

o (@ Davice(s) will auto-hoot to Windows logon
Authentication . i
(O Users can access device(s) at Pre-Boot using this Temporary user account

questions
ﬁﬂ = Mot selected = Browse
Users Owner Identification Rules

(@ Automatically identify owner without having to prompt user

[ Jdlow ofline icentification

Provisioning Rules

R34 — M7 — MR

PBConnex i%, 4 — b7 — M#rEH YA — ~ LET, SecureDoc 7 71 7 b7 SDConnex & #ifid 5 &, SES TF
— 7= MIEBRINET A ZZIT ) 7 — P CORGELZLE LTS, BEa A &85 LRWRETT,
SDConnex 23 &R {& S 7z LAN LISMET A ARSI EanBE, A— 77— b &3 T | BiENLEL R 7,
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6.1.70 7 7 A IVDOFKE

PBConnex #4574 A TIE, 707 7 A /VICLA FOREDMLETT,

- [ OEnable machine to communicate with SDConnex at preboot | %ZHZhz L E7,
A EfE AT : <General options> -> [Communication] -> [PBConnex]
[JEnable machine to communicate with SDConnex at preboot

B> TCommunication %] & 2SR 72 &V,

SecureDoc options *

Communication

w Communication Settings

Usze SDCannex bo communicate with SecureDoc client machines .
General & TLS encryption

g Server List | 192.168.2.26 Add Dizable TLS ~

3}*31 Part rumber: | 7300 Proxy Settings Walidate server cerificate

Communication

2

¢ Communicate with server everp  |B0 = minutefs)

[ Communizate with randam S0 Conmes server within priority group Werify host name in certficate

BitLocker
Management If o communication with server for maore than
@ 0 = day(z] - dizable users' access to computer
- 1] = comm. cycles - move device to Exempted Devices folder to prevent PEConnex authentication
Credential
Provider FBConhex
] Enable maching to communicate with 50 Connes at preboot
EXE] Device will locally cache PEConnes autoboat key file for, |0 = day(s)
Password [ Use Static IP Configuration from Client at preboot
Manager

< RS DUVDITERR LAN OF%E
A ==ivin

A ER T © <Boot configuration > -> [Network Access Control]

B> TNetwork Access Conteol i%iE] Z &ML IZE W,

Boot configuration settings X
" Network Access Control
Connection Seftings
General (@ Connactto SOCoRnex over Wi-Fi [ Hide wireless configuration at pre-hoot
> (O Connectto SDConnex over wirsd link Do not reveal passwords at pre-boot

Keyboard layout Wireless Settings

(AL Access point

Security Protacal  |[Open v

Encryption protocol |Nune

Control Credentials

Account name

FPassphrase Show text

802 1x Authentication

EAP method | Transport Lever Security (EAP-TLS)

Authentication type |Devme cerificate Use fixed account

Device Name format | The DS name of the local computer Add "host" to name

B02.1x Cert

Trusted RootCA - <none> Wiew

RADIUS server
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6.2. 7 V—FDVERR

All Folders 12i%, BEfF< TAll Device Group) & TAll User Group] ZNRESNTWET, ZNHDTNV—T7 %9

HE, BTCOTNA AL ETO2—H—|Z PBConnex DRHZRETHZ EMT

TET,

Z 2T, PBConnex ZfIfT 52— — LTS ZAZEHS B0 7 N—TEFHITHER L, HRETHT A 2L

—Y—a T D HEERH LET,

[8] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin — (] X
Database View Folders Keys User Tools Help Secure
4 = P = - 5
o +y < o ik s | " ?
Add Refresh Del Generate Key File Install Filter Help
| Folders A USEIS| M Devices |'\'4‘ Keys | ¥ Gioups | Folder Enciyption Policies ‘ M Dives
SES Administrators Num Group Mame 7 Description
Il wmjlocal Lo Al Device Group s belong to roup
m| 1 All User Group All users belong to this group
_rg Purged Devices
@ Exempted Devices
i Recycle Bin
‘,,1 Profiles A Users M Devices | %, Groups
il Installation packages Mum| User 1D Domain UPH % | First name | Last name email Descr
@’ Machinelnfo files
Logs
< >
Record(s) visible: 2, available: 2. Total user(s): 10. Total computer(s): 0. Total key(s): 4.

SES OfiA L0 TNA—THRERT D% (Z+VF) BBRIRLET,
7Uw 7L, <Add> RZ V%227V v 7 LET,

Wz, BHA 2H D [Groups] ¥ 7 &

WO T,

fO] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - O X
Database View Folders Keys User Tools Help Secure
- = P = -

A X & B A ?

Add Refresh Del Generate Key File nstall Filter Help
|, Folders - Llsers| & Devices ‘L@‘ Keys *»?}i Groups ) Folder Enciyption Policies | A Drives

SES Administrators Num Group Mame 7 Description

L wmijlocal . o belong to this zroup
i Al Folders 1 All User Group All users belong to this group
IS purged Devices

[Group name] #liC 7 Vv—7 4%, SB(Z) U T [Description] #liZ#HBHAZ AN LET,

Group Properties

General

General
n Group name I

&
Privileges
|
AutoBoot
&
PBConnex Access
Policies

%,

Member of
groups

Description

Group's keys

Key Narme On-Derna.

Al
Femove

Edit

=
i
Ju.] D Users from this group (and sub-groups) will not perform secure moment during provisioning
Folder Encryption

Policies
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@ A—br7 - ERETIHEET
feA 30, [AutoBoot] 71 =%~ Y > 27 L, [AutoBoot via PBConnex] @ [Allow] IZF = v 7 & AL,
W TECHD <OK> RE %227 Y v 7 LET,

Group Properties X

General

AutoBoot

By checking this option, devices inthis group will pass by SecureDoc boot logaon and

& . directly to Windows boot logon

Ny-

. AutoBoot £
Privileges puagnﬁ:e:'ﬁ Eow

PBConnex Access
Policies

SES 28R ENTWD ID 23y bV —VEIETHAT LHAEIT
fE~4 > 29, [PBConnex Access Policies] 71/ 2> %7 U v 7 L, [Get Key File via PBConnex] #®»
[Allow] F = v 7Ry 7 RZF =y 7 & A, B FEBIZHD <OK> RE %227V v 7 LET,

Group Properties X
" PBConnex Access Policies
General
By checking this option, userwho belongs to this group has access to all devices in this
group and its subgroups and device which belongs to this group allows all users in this
group to access
Privileges Get Key File via ]\B{,}E
Q IFECmiE [save Key File to dient machine

Coeny

I-

PBConne)c Access
Policies

)
5

\

Get Key File via PBConnex

O Allow FFaT 5,

O Save Key File to client machine | 7'V 7 — x> b U =27 BEEICEE LItk EHL7ZID (F—7
TAN) BT TAT VN TNA AT L ET,
I|J Z“/ FDU— 7uqu%‘f'ﬁi):H‘j_51/2él\ 1%, Frv7 Li@/\/o

X kWl FUID #ffioTr A a2ilhdet, F—7 741
TIAT BTN ANTHEREN TN D, Ty MU — 7385
&fcib‘j— H— j]/l/uou‘.E&faLV)i‘j—

O Dey E{EREDI )
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6.3. NV —TF ~Da—P—ZeFk

Xy P = RBIETHERT 22— —2 /= ITBEMLET,
¥ A—F7—FERATLIHE. ZOREFIAETT,

O BIETERLEZZNV—FZEIRL, 20 TF A b A==2—»5 [Add Users to the Group] #7 YV v 27 L%,

ﬁ!‘] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - | >
Database View Folders Keys User Tools Help Secure
a ¢ X & W= d@ ' ?
Add Refresh Del Generate Key File Install Filter Help
. Folders A Users | M Devices |55 Keys | ™, Groups |, Folder Encryption Policies | B Diives
SES Administrators Num Group Mame ¢ Descrigtion
L, wmjlocal 0 All Device Group All devices belong ta this group
1 All User Group All users belong to this group
|1l All Folders B = E
g Purged Devices M Add Group Insert
g Exempted Devices Set Filter
g Recycle Bin
)
:'] Profiles A Users M Devices | ¥ Groups ‘ Refresh I
1-':.1. Installation packages Mum | User ID Domain UPM 5| First name| 2 Group properties BsCr
/_Df Machinelnfo files % Delete Group Del
Logs I Add Users to the Group I
< Add Devices to the Group >

@ IOLIBEEPRTINET, EA L0 TA—TITBMLIcnwa—F—=0FHET 57+ VX 2 ERLET,
EFRA R a—PF—ZBRL, THICHD <OK> RF a2 ) v 7 LET,

B | Select users *

= Folders
SES Administrators ktanaka

T F
S| loc 1]
- wmj ktanaka@wm] local 3l E
-0 wmjlacal 8] kaida wmj kaida@wmilocal prgl kil

-y Domain Controllers
N =
L s

-0 wE

[ Display itemns from all folders
Records visible: 3, availabla: 3
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6.4. I NV—TF~DFINA ZABEF

*‘7 ~ Uhyu:u\uE’T‘é% b%ﬂ:‘”ﬁﬁjﬂé?/\/]’zé?ﬁﬂ/‘—

NRARIT IR ATED L2720 £,

@

TR L ET, R NV—T IR T 22— =R —THNDT

VER L= N —T 28R L, 2 FF% X h A==2—5 [Add Users to the Group] #2V v 7 L¥7,

ﬁ:] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - O pad
Database View Folders Keys User Tools Help Secure
< = P = W =
" + x an o cdl ?
Add Refresh Del Generate Key File Install Filter Help
| Folders A Use|s| M Devices |‘ﬁ Keys | ﬂ Groups |, Falder Encryption Policies | A Diives
SES Administrators Hum Group Mame  / Desorigtion
L, wmjlocal 0 All Device Group All devices belong ta this group
1 All Usar G All users helong to this group
il Al Folders ) =
g Purged Devices @ Add Group Insert
g Exempted Devices Set Filter
5, Recycle Bin
:‘;’] Profiles A Users @ Devices | B Groups Refresh I
LI:J Installation packages Mum| UserID Domain PN % | First name g Group properties BsCr
,]]f Machinelnfo files & Delete Group Del
Logs Add Users to the Group
< I Add Devices to the Group I >

WD LD pWmENFRINET, EXA K0, FT—7

BMLEWT AL ZRFIELTWD 7 3 VX 28R L E

T, ALV TR RERIRL, THICHD <OK> R¥ %27V v 7 LET,

01 Select devices

= Folders
. SES Administratars
E| .w wmj\ncﬁ\
Daormain Contrallers
i
ﬁfﬂﬁ%ﬁ
M REE

H

[ Display terns fram all folders

Num _Device Name anufacture Senal

x

Modified

LAPTOP-N37H LE

Recards visible: 1. available: 1

Cancel

U EOREIZLY .,
Fl— 7 NV—7IZFTE LT\ D 2 —P—[L,
Tues/A4Tx5k9
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6.5. g 7 A LV RBEIB DR E

TV T — bRy FU— 7R T, e A CREES LEWEEBA TGS, EOT AV bary 7 TEET,
gt 7 A KRB D L EVEEZZEE T L FIRICOWTHA L ET,

DO SESDODA=z—n—%D,
[Tools] -> [Preboot Network(PBConnex)] -> [PBConnex Global options]
7 Vv LET,

@ TEOTNAAABLIOEH—~OT/NA AT, #Efgn 7 L RREEEZBEE L5 ID 20y 7 35842 HEELET,
%2, <Save> RZ %7 Vw7 LET,

PBConnex Global Options X

Allow/Deny Precedence:

Where conflicting PBConnex allow/deny rules apply for a user/device combination, the following settings define
rule precedence. For greatest security, accept the default.

Deny access where rules conflict (default)

Allow access where rules conflict

Failed PBConnex Login Lock-out Rules:

(O Users are allowed unlimited attempts to enter valid credentials using PBConnex login (not recommended)

(@)Limit number of failed PBConnex login attempts (default)

Lock out user, and notify Admin/Security by email after a maximum of:

n consecutive failed PBConnex login attempts on any client machine
ﬂ consecutive failed PBConnex login attempts on a single client machine

For SMTP settings, please run SDConnex Configuration and go to "Alerts"

Windows AD Authentication

DAuthenticate user against Active Directory

Access for Computer Users

[]Allows PBConnex access for users assigned to device

Save Cancel

H H ‘ o B

Failed PBConnex Login Lock-out Rules:

O Users are allowed unlimited attempts BREEH (ID/XAT—R) OADZEERIRICEIT & £97,
to enter valid credentials using (HEZEL EHA)
PBConnex login (not recommends)
© Limit number of failed PBConnex login 07 A AT ORI A FIBR L E T,
attempts (default) (FT 74 1F)

Lock out user, and notify Admin/Security by email after a maximum of:

XX consecutive failed PBConnex login EEOT ANA ATHfEn 7 A JEEZBiE L= 5 ID 21
attempts on any client machine 7T HEEAERELET,
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H R #oH
XX consecutive failed PBConnex login WA 2 CHlifer 7 A VRIS Z @i L5 ID 21 v 7
attempts on a single client machine THEEAETRE L £,

Windows AD Authentication

Authenticate use against Active Directory T 7 NV MNREDOA T TIL, 22— —D ID//RA T — KX SES
WKLo TOHRT =y 7 ENET,

IOF T arEAENNCTHE, a—PF—D ID//NAT— R
IZ. SES & Active Directory i i TF = v 7 Sk,
2—H—D ID |L SES 7 —F# X—R|IHEFEINTWDHZT TR
<. Windows FAA Y THHNTHLIVLERH Y £7°,

Access for Computer Users

Allow PBConnex access for users assigned | 2047 v a &9 25 &, AutoBoot (£ 7/ —7 D% ET
to device W37, 2= —/T A ADOFMRICHE S ZENRTEET,
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6.6.—¥—mu v 7 EER

DO SESDODA=z2—R—5D,
[Tools] -> [Preboot Network(PBConnex)] -> [Reset User’ s Failed Login]
Vw7 LET,

@ TROLIZEENFRINET, EXM LD, vy SNFa2—VF—DBHGEINTWL 7+ VX R R L, %4
2P BBRLET, £ VAT A% L0 T CRIRESBRTRSNET, H—07 /1 ATa v 7 Shk
LA, ETFICHD <Reset> RF %27 Vv r45L, IDOvy 7 BMiElrsnEd,

B | Reset User's Failed Login *
= i Eolders Computer /| _Failed Login Times
SES Administrators I Ksuzuki-PC 5 I
E|Q,,L, wimj.local

il Domain Controllers
W B

[ tookawa
el s

Reset the selected user's failed login on selected computer

Reset User Reset the selected user's failed login on all computers

Reset All User  Reset all users' failed login

oy VIERICOWTIR, FRoT—7 A2 BB LT EE N,

H H ‘ B
<Reset> Reset the selected user’ s failed | B—DOF 4 2T, IR LTzax—F—D o 71 o Ligm¥ks Y
login on selected computer Ty L, By 7 ZERLET,
<Reset User> Reset the selected user’ s TRTCDOTNA AT, BIRLmax—V—Dnu 7o R iiml s
failed login on all computer Vey hL, vy 2R LET,
<Reset All User> Reset all user’ s failed TRCOL—H—Du s RREEzV Yy FL, vy %
login fifgbR L9

@ [Confirm: Reset failed login number on the selected computer to zero for the selected user?] &9 & A

TRl REREINETOT, <FWV> 27Uy 7 LET,

@ FHAAVZERENTOWET AL ZEN7 VT ENET, EYa—V—0r v 7 BBEREINTHNDEDT, IELVVIR
J—RTa s A TEADMRLET,
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7. X< H2ERLHEZ (SES)

7.1, 2—H%F—PR—Fk

B 2—F—DRRT— FERL~ORLSE (Fx L v VL AR AHEE)

2—PF—=RNRRAT—RFERELTLESTSHE, TY LV VARV ABREICE 5T, U AU BHRETT,
TNA ANy P =7 ICH SN TV D RBETR ERfICE DA T = RU B Y OB R— B FRETT,

O ===z, YU T7— FRFEME T, [SNATV—FEENSE] 27V v 7 T585 182 FT,

PSS UserlD (Enter for default..):| /|

BB Password: ‘ -1 1D (Enter for default...) :

FrLoILARIR

@ BMIT<KFXYLUPLARVAS REEZ7 Vw7 LTHBY, Fy Lo PEEFERSEET,

a—-#-ID:  User01

Ty VID: 9FFFC879C3FD97CIC303A1492C28996A
N FrelUUl: 707CE7 94 D2FS 2F

LARYAfE: |

(O

071> [+

® SES&HEIL, 22—V —»b, WHICFRENTWDS (22— —ID] #f&, SES =2 Y —/L® [Users] ¥~
T, ZOID #HEELET,

@ #Ya—H¥—%42Y v L. [Challenge response] 22V v 27 LE7,
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® FrLUVRUVARVABENDFRINET, @QTHRAINTNWDL T ¥ Ly Vi a—F—1ZHiA P TH b0
[Challenge] MIC AN LET,

Challenge and Response

User D Userll erify:

Device Info Detault

User Authentication

Question Answer Edit

RMCE Recovery parameters

RMCE Recovery Key: Search

SecureDoc Challenge Response Recowery

Challenge: |[70 7CE7 84 D2 Fs 2H | | (CgetResponse D

[JUse numeric input (Challenge 2) /v

Response: |

Exit

® iy T, <Get Response> R"&# > %27 Vw3 5%&, [Response] Ml L AR AMENRFRINET,

SecureDoc Challenge Response Recovery

Challenge: |?D JCE794D2FR 2F | l GetResponse

[JUse numeric input (Challenge 2)

Response: | 24838233 1c 606852 dd9c25 |

@D 2=V VAR AMEREZ, ANEIC <alA4r> 22097 LTHEHWET,

a-#-ID:  User01

I VID: 9FFFC879C3FD97CIC303A1492C28996A
Fv LfE: 707CET7 94 D2 FS5 2F

LR 2 f8: I 70 83 82 33 1c 6d 68 Se dd 9c 25 I
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Windows 2 A > A 55 L, NAT—RHDHVNEPIN DEEEZETH A 7T u S REREINET,
<OK> %7V vy 27 LET,

SDa Ol - *
) SecureDoc
FEAD— B A N ESEFTLESEDL, SHFIAT-F/PINE
ETEILLENEIES,

@ RRAT—=FHDHWEPIN 2B ETLH7-OOBEEMNFRINET,
a—HF—HHIZEoT, HFLWWARAT—FHEWIPINEZASL, <OK> 227U v 27 LET,
a—P—|ZLDHRETHY, EHEIHE LA,

F-TrAIVETPM + PIN(REICEEITT 2 X

) SecureDoc

F-p L EIRETDEMIZ, FLLPINESREL TS,

SecureDoc3 —H—:

SecureDoc TPM PIN:

TPM PIN%EREEDLEE:

PIN %5507 d5: | PIND&- |- 354 PIND& & &

QK

¥ BRESNTVDIEIEHEIC LT, RSNDIEHEARLRY 9,

NAT = RFREHEENTZEVWIXATRI A v —UNERENETDOT, <OK> 227V v 7 LET,
wEla 74 XY LSRR T —RE AN LET,

SecureDoc >

€3 SecureDoc

SecureDock =27 JLO{FFEATPM + PINCEEEL,
Flite OHAFREER. FLOPINEERLTHE

X ORESNTOWDORIESIECL > T, RSN OBEBERLRDGENRHY £
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B RRAU—FOBRAAEZHERVIEL, vy 7S TLENELL

2P PR AT— FERELTLESTBEERL [Fr Lo P& VAR AERE] A5 Z LT, UB Y HRA]
BETT, AT ROFREL, ELWRAIEELTIZI,

B UEFI/BIOS ORZITNHAKEAT, vy 7SN TLEVELL

R %8 2 CRIBICEA TN 5 &, SecureDoc IIRIEERITA L AR LT, 22— —ID&x v LET,
BT IC kb v 7 OFE, 22—V —RNRX2AU—RERELTCLESTEHELERL [Fy L T& AR AKEE]
O Z LT, UBARNYMNRARETYT, NATV—=ROEHREL, ELWFZNEEL T EEN,
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7.2.SecureDoc 7 7 ATV b T NA ZADEHE

B SRS RCHAINTWATe 7 7 A VEREE LD

SES 2V — /L TiE, ENENDI TA TV bT AL RAZWHINTNDE T a7 7 A VEERTEET,
SES CEEfF 7R 7 7 A NDOBREEER LIZGA, TNENOI T TV MTAL ATHEAEINLTWA 707 7 A VBRE
FRIO DN, BFEHZEDOL DO SES 20 Y — LV THER TE £7,

SES @ [Devices] # 7T, WA LIZWT A ARV L ET,

ro‘] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - ] X
Database View Folders Keys User Tools Help SecureDOC

J 8 X & @ a = |2 |

Add Refresh Del Generate Key File Install Filter Help
-k, Folders ~ & Usersl M Devices  § Keys | R Groups | | Folder Enciyption Palicies ‘ M Diives

----- SES Administra Status hodel Last i L Pfi\e i - i
el wmidocal f The device is in U20NBC 202, T4 I0I7 A 90 E
iU Domain Co
el ¥EEEER

[Profile] & TWZRRENTT AT 7 ANVENBIET FAT Y b T AL AZHEAENTWDE T B 7 7 AV TT,
[Modified Profile] ®% 712K RSNDAFICONTIX, Tred &0 TT,

[Up to Date] : SESIZHD7u 77 A NERUKFOLONEHASNTHET,

fOut of Date] : SESIZHHTRT7ANED bEWT BT 7 A LBREDOT /A ZZTEH SN TWET,
SES L CFu Ty A NVEEH LN, TNNRT T4 7 2 MIEH I TWRVIRIETT,
TRT7 7 ANVDRELMEELL TWRWESTH, 7’r7 7 ()L T <Save> 227 Vv /35L&,
7747 MTEA SN TWS T 17 7 A /L SR H AR 72 % 0T TOut of Date) 72 ¥ £,
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SecureDoc
B SARAARZEAL WD a7 7 A NVEERE LW (7 3 VA BN
TANVZIHR L TS T NA ZAETIZ, JloTa 77 A VOEASe, BELEMEOT e 7 7 A VEEHTLH5E
X THAFHMNT, TIZICHBELTWAETF AL ATETR L0 7 7 A VREEAFERT 55O EEHFETT,

SES DENRA LY, TuTd 7 A NVEELLIEZWT NS ARFET D 7+ VA &8 NE, ~TADI LT HA KA
== —7/ 5, [Assign device profile to devices] #7 U v 7 L%,

. 2
h wmj.local

4y Domain Controllers

_ Hirayuki Tanuma@winmagic h\rO\ukManumaﬂw

(0‘] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - ] XK
Database View Folders Keys User Tools Help
‘ < PR — - - | V]
sl % X bl ?
Add Refresh Del e Key File nstal Filter Help
= |, Folders A Users M Devices | YW Keys | -45 Groups I ) FulderEncwplim Policies | M Drives |
SES Administrators Num User ID Dnmam Name First name Last name email

E|
N 2= ﬁ
| A1 Folders -
g Purged Devices
= )
g Exempted Devices
‘; Recycle Bin
@J Profiles 4
b=
fi4) Installation packages &
’[l‘ Machinelnfo files -
] Legs I ay

Assign device profile to devices I

Cancel all active commands
—

1 kaida kaida@wmjlocal EZ 88 koji sida@winmagic oo
2 ktanaka wmj ktanaka@wmjlocal 23] B kenjitanaka@winmag
2 skohaashi i skobayashi@wmjlo E— o shojikobayashi@winr
Add Folder Insert l
Add Group
Folder properties F
Member of groups 4
Delete Folder Del
View Audit Log >
Activate auto-boot
Reboot devices Serial Modified Unique ID Created

. 2022/09/15 &07:23 | 5407474336c1093d 151792621 7dech3? 2022/09/16 1:09;
Lock devices

@ Ty A VERERAERSNET,

i1 Select SecureDoc profile

! FLO=dE)t

View/Modify profile

® T7H/NVFWNO SecureDoc 7 T4 T v ik

r L
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Num Profile name

_ 7724 b70771 )b

bes

Comments
T|/'j f’fﬁj’h‘fl SecureDon
>
Records visible: 2. available: 2

A

WHLEZWT e 7 7 A VEERL, <OK> R¥ %227 Uy 7 LET,

. &klal, SDConnex & DBEHFC T 2 7 7 A M ESZITED £97,
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A

AN
B SARARIEHAL WA 0 77 A VEER LW (5314 ZAEND)

EHRLEBEGFOTe 7 7 AV EEHALIZ0 75546

TN RABENT, BloTa 7y A VEEA LY

@O SES® [Devices] #7 T, 7u 77 ANEEELIEZNWT AL AT RE, ~TVRADIAVTHFARA=Za—0n5,

[Assign device profile to devices] #7 VU v 7 LE7T,

m SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - [m] x
Database View Folders Keys User Tools Help :,,r Modify device info Enter |
< e ") = . " - 7 .
it + X ## i ? |8 Deletedevice Del
Add Refresh Del Key File nstal Filter He\p Move to Folder...
= ), Folders U*(s - Dew es W Keys -ﬂ Groy View Audit Log
SES Administrators Num Device Name / Manufacturer View SFE Log Deployed State SFE
) 1 LENOVO ployed
N wmilocal View RME Log
By Domain Controllers Set Filter I
p— i
L‘ BRH Refresh I
- = & Add keys to device
- A%  Add ysers to device
il All Folders
=1 l o® Assign device profile to devices ]
a Purged Devices
- Assign folder encryption policy to device
g Exempted Devices - = L —
= = Member of groups
5, RecycleBin < - =l >
& J Profiles ™8  Create emergency disk
#
1;.J Installation packages Num User ID / First File Ouwner
Jf Machineinfo files " Hrgy kilTanimabvnmasic Mark as parent device Ves
v 1 SDAdmin X o
4 Logs A Activate auto-boot
B Reboot device
< >
= - 3 Lockdevice
Assign SecureDoc profile to all the selected devices I

a7y A VEREEN TR INET,

BWHLEWT e 7 7 A L EER L, <OK>

NEZoas )y LET,

i Select SecureDoc profile

%
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oA 2,
FLI- Dﬁﬂ\—fl

Num Profile name
_ 7724 b 0771 )b
1 T LI=hre)t
<
View/Modiy profile

s

Comments

Secure Daow

Records visible: 2, available: 2

Cancel
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B SRS RCHEHALTWS a7 7 A VEBBICTERH LV (2T /31 R)

TIAT v "NTNARZHWHAFE 70 7 7 A Vi SES TREER LT-HA. U T2 74TV F T XL ADT 7
AN E BB TEHIE I HE

F OREERETLHOT e T s AAREH SN TWDETOT A ATEERH D DT, +oRIEERSBETT,

O BFOTa7 7 A NERELEET DN, WOREELRBZRVET,
SES ® A =2 — =5, [Tools] -> [Options] #FEfT L £,

F:] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - O X
Database View [olders Keys User Help

el * X i ?

Add Refresh Del nstall Filter Help

® [General] ZBE £,

] Automatically update device’ s profile settings when profile are modified] (25 = v 7 % A%,
<OK> 27U v 7 LET,

QOptions X

P

General

General

['When moving user or device to a different folder, also move all related users, devices and keys

[C]'When moving user ta recycle bin, remove user key file from all devices

- [[] Delete diive information when computer is deleted from the Recycle Bin
Server's RSA [[] Hide Machinelnto files after extraction
keys [ Rename old key duiing extraction from machine info file

d ] Enable "Crypta-erase device™ remate command
{\G_;f [ Automatically update device's profile settings when profiles are madified

Authentication Show top 1500 : records in table views
questions

Password recavery length |10 4 [the length can I]:e from 8 to 32 bytes: Longer values
v | are more secure
KJ Command Expiry |30 : day(s)
Key file options Delete commands from history |10 : day(s) after expiration date
os. Use SDConnex to communicate with SecureDoc client machines
o
V7=
O'th_ ] Allow duplicate User Names - Duplicated user names will not be automatically resolved
er
O Users may also login using SAM, UsedD@domain.com [UPN), UserlDi@domain, DomaintUserD,
c Domain/UserlD formats
i ”J [ Use taken pratection as default protection type
R
censes Default token type for new users | iKey 2032 v
Password rules
Authecn:liation [ Disable AD folders structure Browse for oot folder
£l - 3
[] Do nat impart groups Key Usage 0 Configure Key Usage

Cancel
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® BEOTu7rANERELEELEL, <Save>% 27U v 7 LET,

SecureDoc profile

Frofile name |zl

Comments |?3‘71'be‘ - TP/ 350 |

Twpe |SecureDoc Enterprige forWindows |

Profile data
General options Boot text and color Boot configuration
Authentication questions Fart Cantral

Disk access contral

Edit manually Cancel

@ ZoFuTrAnE By F2—F—DF7 A 2 THDATWLOT, RO KD ITEFMROT 7 — b HEiHE»
FoRENET,
<FW>EZ U w7 LET,
SDDB
WARNING: This Profile is currently in use by one or more Users or
I Devices. If these changes are committed, all affected users or devices
will be updated automatically.
Confirm: Commit these changes?
W DR

I Automatically update device’ s profile settings when profile are modified] (25 = v 27 % AT

WRWT 74V NORETIE, 7077 A NVOREXLEE L T<Save>%2 27 Vv 7 LTHIDT 7— MIER

ENP, IIAT U TR ACHEAENTWA T a7 7 A VIZEHBITERESNEE A,

® SecureDoc 7 7 A 7 b, ®lEl, SDConnex &lfE LIZBRICHH SN 07 7 4 LV E2ZITHY £9°,
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B SESTIIAT VI TNAALRIZBIRoT-BEOREREZHER LI

FHENSES 2 Y=V T, JIAT UV TN ADT 0T 7 A NVERR, a—F—2BMLIEGERE 7747
YT A L TEB IR TeBMEOR R MR T2 Z LA TEET,

O SES @ [Devices] # 7' T, B LIZWT A A& RIRLET,

l:;] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin

- O x
Database View Folders Keys User Tools Help gsecureDOC
@ x & B a4 = | 2
Add Refresh Del Generate Key File Install Filter Help
= |, Folders A [ & fsors | ® Deviber 9 Keve | 2% Growps ‘ )i Folder Encryption Polcies | 8 Diives
‘ SES Administra A — icated ified Profie
= wmjlocal = — . . ate
4y Domain Co
L o=

@ ~UROEZ Vv ZICEkDarTE A M A=a—25, [Show commands] #27 U v 27 LE4,

=4 Activate auto-boot
B Reboot device

B, Lock device

Show command

Cancel all active commands

Save to file
Check PBConnex Access
Intel AT 4

Lenovo Hardware Password Manager 4

@ avrRF—TrFrREhEY, [Command] #llicZ A4 T h~Da<y RRRFENET,

B SecureDoc commands

Cormrman Creation tirme Status

Execution status

file 11 e outed | Ok |2

Add DEK file ""SDAdmindbk”, UserD 2022/10/22 1156 Exscutad 2022/10/22 1156
Add DEK flle “KF9256 dhk”, UserlD “£ 2022/10/22 1156 Executed 2022/10/22 1156 ~—
Remove key file , UserlD “SDAdmin”  2022/10/22 1155 Bxecuted =

Import Device profile 2022410422 1145 Executed
Add DEK file ""SDAdmindbk”, UserD 2022/10/22 11:20 Exscutad
Add DEK file "KF3277 dhk”, UserlD “£ 2022/10/22 11:20 Executed

Execution time

AT —H A

Delete Modify Refresh

TERRIREZ]
~—
aw R

@ AT T ARA AR awy REZITRY FETIND5 L, [Status] 23 TExecuted] LR RS, £Ooa~<y
FO#ERNFH LT % &, [Execution status] #ic TOK] EFRENET,

® varFUzL2I2iE, <Close> #7VU v 7 LET,
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B SES IIBEFEINTVB2—F—H LTS RAZREBLEZND
[Search] #AE T, SES ICBEHIN TNDL 2 —HF =0T (A ZAERBTE £ T,

O SES®A==2—"—05, [Tools] -> [Search] %7 U v 27 L%+,

ro'] SecureDoc Enterprise Server SQOL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User na... - O X

Database View Folders Keys Qserelp g SecureDOC
. = o = a— = Enterprise Serve
r;. s ~ & B o ?

Add Refresh Del Generate Key File Install Filter Help

@ MBA=a—DBERENET,
a—H%— or 731 Z or

Search |

Search Options
Mmain UPN
Search B /
Search For

| |
() Match walues exactly }

First Name L 2 Etdail *ﬁ?‘éj{?‘iﬁlj
|
—% or #WH—%

(@ Match walues cortaining

MR 4 —/ N

In Fields UserlD
[ 1Domain
Jupn
C1First Name .
[LastName
[ 1EMail
ClPhane

[Search By] #T. M%Ex%% [Users]. [Devices] . [Keys] 7Hi#EIRL £,
[Search For] #iZ#HZBE L=\ 3eF55 A LET,

SEAHELITH S EEB®IRL, <Search> 27V v/ LET,
O Match values exactly - - - 5242—%

O Match values containing -+ - -  #B%—%

® THROLIIZ, MEMEDETESNET,

Search X
Search Options
UserlD Domain UPM  FirstMame LastMame EMail Fhaone
Soarcn By Usertt |DEskToPEUBGE3 | L ||
Users ~
Search For

|USET’

() Match walues exactly

(@) Match walues containing

@ Forahie, flziFa—F -T2 ) v $5L, SES DFENA VICRERHRPERSNET,
[X] R¥ %227V vy LT, MERy 7 ZAEHALCET,
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B JIAT Y N TARA RCBBEEHER 2 —F—ZBML 720

O FANEHEEHER——2ER L ET,
JERA VTR T DT AN BT, A D ETYTADE Y Yy 7 TaryTFA A= a—%2FRL,
[Add User] #27 VU v/ LET,

ﬁ’] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User na... - O ped
Database View Folders Keys User Tools Help Secure

. X & B ' ?

Add Refresh Del Generate Key File Install Filter Help
| Folders A Users M Devices |‘{; Keys | o™ Groups | | Folder Encryption Policies | & Diives |

| SES Administrators MNum User [0 S Domain MName LIPM First name | ast name

: L0 [SDAdmin I Y R I
N wmjlocal 1 SES Adrmin

&y, Domain Centrolle

L EER 2 CAdd User Insert

) i & Modify User Enter
, fEEEER
e & Delete User Del
\11) All Folders
g Purged Devices Move to Folder...
g Exempted Devices View Audit Log
& Recycle Bin View RME Log
21 Profilac

@ Typelix. T[Regular] %W, User ID & Password # AJJLET,

[COOUser must change password at next logon| %, /XA T — ROEFRFERTT,
EREBERWVGEITT = 754 LET,

MR E T, [Admin Rights] Z®O0 £,

Add User

LUser properties

Type |Regular ~
User properties e
% UPM name
MEmBEron SAM name OUser rust change password at next logon
groups Domain First name
Email | Lastname
Description Phane

Create series of + | useraccounts

Use this screen to manage this user privileges on all hisfher devices
Use groups to manage privileges of multiple users on multli\e devices

Directly Assigned Privileges: O User Rights dmin Rights
Modlfy Password Modlfy Profile Cnnvert Removable Media
Modlfy Rey Sele:t Profile Cnnvert Hard Disk
Expon and View Key Conﬂg SFE Dlsklntegmy Check
[]iew Transaction Log [¥] Create Emergency Disk

[C]Exclude from DAC {password sync should be enabled)
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T ZABALT, BHE2L—YV—2BNT 256

O [Devices] #7mnb, ST A AEHI D v 7 LET,
TR A M A=2—m5, [Add users to device] #7 VU v LET,

F:] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESA.. - O pad
Database View Folders Keys User Tools Help Secure
‘ - ;.:v‘ PR = - =
& * ?( '(;} r% & Modify device info Enter
Add Refresh Del Generate Key .
& Delete device Del
Folders A Llsarsl M Deviees  §f Rews I
SES Administrators Num | Device Mame Move to Folder. Bte i Wi
X T OP-EUBGIE - - T A I007 Up to
 wmjlocal o¥ i BEDATIRIES 7 I4)/h 077
&y Domain Controllers View SFE Log
o
% B View RME Log
W _
U vz Set Filter
|1 All Folders Refresh
Purged Devices # Add keys to device
Exempted Devices P -
= ) G* Add users to device
». Recycle Bin
:] Profiles »% Assign device profile to devices
J Installation packages Assign folder encryption policy to device

@ aA—V—oBREENFRISNES, FHEHRL -V —28R L, <OK> 227V v 7 LET,

| Select users X
=- Falders Num User ID /___Domain Name UPN
’ £ 0 [SDAdmin I S
) 1 SESAdmin
=0y wmijlocal
-y Domain Controllers
ol BEED
-0 e
U wwsm
£ >
isplay itemns from all folders
Display items irom all fold
Fecords visible: 2, available: 2

BEOT A Rz, BHEE2—F—2BMT 258

[SecureDoc Enterprise Server Version x.x 7 A v 7 A > A =)L A K]
[12.8. 7 4V OMRERH - THHE ID ORMELIAHEDIEN] %2 ZBWL EE W,
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B EHfE., BELTVWARVWTIAAS ZZEHL-0

FRE LI2WIRIFIZ, 7314 223 SDConnex & —E L I8E SNRWEE, 73 AZEBELTWARWT 7 7 %3 T,
SES & ¥z —)L® [Purged Devices] IZB# L £,
COMREIC LY, Bk, BEE, EEHT -~y FSNEWREDOH 2T N R ERFETE £,
[Purged Devices] WD T /XA A%, SecureDoc 7 A B A&MEHAL Tt RS, thoT (4 2AD7dizzh
LDOTA B AEMHRLET,

@ SES D A==z2—s—XV_ [Tools] -> [Purge Devices] #7 U v 7 L%,
Purge Devices O EBHE ARSI ET,

Purge Devices X

Scheduled purge

Run automatically on SES exit EEY |2 day(s)

Mext scheduled purge will run in 32000 days

Purging rules

Purge devices that haven't communicated for more 365 : day(s)

@ TROT—TINESZRLTRELTIEEN,

gl:lg

H H ‘ B

Scheduled purge

Run automatically on SES exit X day(s) | SES = YV —/LD#& T, XX HEIZ A=Y E2FEITTDH L1
AT a—)V LFET,

Purging rules

Purge devices that haven’ t X X HELE#@{E L TWien7 731 2% Purge Device 7 4 /L4~
communicated for more the X day(s) BELET,
<Start>R % Bt L £,

¥ T /NA A Purge Device & LGl S NZ3, ZORERRWIGEE, ZOT N, AL TEET,
[Purge Devices] 7257 /31 A% 427 U » 27 L, [Restore selected device(s)] #7 Vv 7 L9,
BREINTZT AL AT, A B AOHEREZFELET,

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

B SES hoR/E—BEEHHILEN
SES LV, o —0F A 2ERA LD B HTH LA TEET,

O SESOESNA LD, HALEWEBNEGEENDI 74V E %527 Y v 7 LET, I, WO LEWERNEGEEND

&7 (ZZTiL, [Devices] #7) #7 Uy 7 LET, HALIEVTERIRLET,

FD] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESA

- O *
Database View Folders Keys User Tools Help SecureDOC
— ) N Enterprise Servel

B X & B & ?

Add Refresh Del Generate Key File Install Filter Help
= |, Folders £ Users M Devices ‘“ Keps ‘ li?'_. Groups | | Folder Encryption Policies | A Diives |

: SES Administrato i i
, wmj.local

Purged Devices
g Exempted Devices
‘-5; Recycle Bin

3| Profiles

p,L.‘] Installation packages
,Jﬂ Machinelnfo files

@ HHLIWTEEIRLTRRET,

H7V w27 LT, ar7%¥ArA=a2—inb [Savetofile] 47V v 7 L&
R

®. Lock device

Setup Port Control

Prevent Login to Device(s)

Cancel all active commands

Save to file

Check PBConnex Access

@ REREEY, 77 A4 EANLT <OK> 2270 v LET,

Save to file Options

Folder: |C:¥Program Files (x88)¥WinMagic¥SDDB-NT

Browse

File name: || | (*00)

Save Column Headers
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B ERXus2ERLEZV
SES &£31 > ® [Audit Log] TiX, 7 74 7> s RN SES OfpfEr ZMrESNE T,

O SESokE~A kv, [Auditlog] TAar %27V v s LET, A iculRERENET,

f°] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDE, User name: SESA... — O X
Database View Folders Keys User Tools Help Secure
- - PR — < =
" * x & B | ?
Add Refresh Del Generate Key File Install Filter Help
=k |, Folders
SES Administrato R Iurm Aplltlo vl - Action . . Staus
reDoc Enter T g Suc
“ iy wmijlocal 72 SecureDoc Enterprise 2022/10/23 11:23:03  User “SESAdmin” login to “SESDE” d Suc
All Folders 71 SecureDoc Enterprise 202210722 23:0454 User "SESAdmin” login to “SESDE” d Succeed SESAdmi
.- . 70  SecureDoc Control Ce 2022/10/22 12:3259 User “Userd” login on device " DESK Succeed  User(
2 purged Devices 69  SecureDoc Control Ce 2022/10/22 12:3258 User “UserD” key file pratection type Susceed  User(l

EL Exempted Devices Jat:] SecureDoc Enterprise 2022/10/22 12:31:37 User "User01” performed challenge re Succeed SESAdmi
= . 67 SecureDoc Enterprise 202249 0/22 122706 User “Userd ™ performed challenge re Succeed  SESAdmi
&, Recycle Bin 66 SDConnex Communics 2022,/10/22 11 5644 Device " DESKT OP-EUBGIB3” prper Succeed  SES Admi
1 Profiles 65 SDConnex Communics 20224 0/22 11 5640 Device " DESKTOP-EUBGIES” proped Succeed  SES Admi
654 SecureDoc Enterprise 2022/10/22 11 5620 The creation of the command “Import Succeed  SES Admi
" 63 SecureDoc Enterprise 2022/10/22 115620 Profile “T*2)Ub 30770l assignme Succeed  SESAdmi
2 Machinelnfo files 62 SecureDoc Control Ce 2022/10/22 115610 User “SDAdmIn” key file was removec Succeed  Ussri
61 SecureDoc Control Ce 202210722 115610 User “SDADmin" key file was added to Succeed  Useri
G0 SDConnex Cammunics 2022,/10/22 11 5608 The creation of the command ™ camm: Succeed  SESAdmi
50 SDConnex Communics 202249 0/22 11 56:08 Key file ™" creation for user "SDAdmI Succeed  SESAdmi
58 SDConnex Cammunics 2022,/10/22 11 5609 The creation of the command ™ camm: Succeed  SESAdmi
57 SecureDoc Enterprise 202240722 11553 Folder " B3 ER" update Susceed SESAdmi
56 SecureDoc Enterprise 202240722 115530 User "SDAdmin” assignment to compl Succeed  SES Admi
55 SecureDoc Enterprise 202210722 115520 The creation of the command “Rermoy Succeed  SESAdmi Y

o)
B

1J Installation packages

@ MWEEHoA=a— =50 <Filter> #iEEZEHTLI L, v 7 2&BT LI ENTEET,

B | Filter Active Audit Log X
Application [ALL e
Action [ALL] “
Object of [ALL] w MNarne
Fef Ohject of [ALL] ~ MName
[ostelogged  fom [23 102022 0707 i | 0 [zinomz oo
Filtar:

@ [Application] ##2>% [SecureDoc Control Centre] &R L7-H4E. (KEkET) © a4 Riiy Ln»
SleA Xy MBS ET,

¥ <ClearFilter> #27 Vv 7 35AF T, SES a2 V—LOFERIZIT A NF —HEEEICL > TRERBESNETEIC
IRoTND I LIZEELTLEEN,
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B SESEEEID ZEBMLEZY Bl : RRAT—=KRY INY OADOEHE)

F &35 SES HHE LM, BOEBREZERT LI ENTEET,
NAT =Y AN OB aEfMTELEHE, FEOTANFDOHOEMERELERT L2 LN TEET,

LR E LT, SESA VA M—ED, BHIDOEHEX—T7 7 A VEVERT DERIZ,
A4 Allow user to add other SES administrators| (ZF = v 7 # A TEY . Bl SES & BLEVER OHENR % £
STWVWAHRERDHY ET, ZOREDINTWRWGE, B0 SES EHEEIERT LI LN TEERA,

Administrator access rights X

MAIN ADMINISTRATOR

UssriD [SESAdrmin |

User's default key ‘AES . |

Access rights

Only allow access to the "Password recowveny” feature ] Arccess To Folders

Prewent access to the AuditLog
[JPrevent use of remate control

Presvent access to Sel-Help answers
DAHDW userto add other SES administrators
Al:r:ess to global SES settings Current: Full Access
[v]Access to SD profiles Current: Full Access
Access 1o installation packages Current: Full Access

[¥] Allaw deletion of encryption keys Current: Allowed to delete encryption keys

Save Cancel

© SES »fE~A > kv, [SES Administrators] 7 4/ # &R L £,
[Users] # 7T, Y—nA =D [Add] #7 V v 7 LT, FRlcz—F—ZERLET,

©@ a—Y—0Fa T EHEIRRENET,
[Type] i%. Regular &R L, [User ID] & [Password] # A7 LET,
[Following keys are associated with user] #i T, <Add> %7V v 27 LE7,
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Add User

LJser properties

Typa | Regular ~
User properties I 2 I

2 e | R —

UPN name
Memberlof SAM name User must change password at next logon
groups Domain Firstname
Ermail Lastname
Description Phaonge

Create series of

2 ugeraccounts

Use this screen to manage this user privileges on all hisfher devices
Use groups to manage privileges of multiple users on multiple devices

Directly Assigned Privileges: (@ User Rights (O Admin Rights
hodify Password [CMadity Profils [ convant Removable Media
[idadify key [ select Profile [ ConvertHard Disk
[ Exportand iew Key [C]Contig SFE [ Disk Integrity Check
[Jview Transaction Log [(Jcreate Emergency Disk.

(] Exclude fram DAC (passward sync should be enabled)

[(User Key Fila(s) will he protected by taken Userx503 certificate
User's token type iKey 2032 Add Delets Wi
Following keys are associated with user
Key Name On-Dema. Add ‘
Femove Keyto protect user record in SES database
Edit AES WhdJ ~
Create Reset Exit

® [SES Administrators] 7 4/ #\2&% 5 SES O#EZEIRL T, <OK> 227V vy 7 LET,

B Select keys K

Num | Key Name / Key Type Prote

=2 Folders
| SES Administratars

) wimj.local

[ Display items from all folders
Records visible: 1, available: 1

Cancel

SecureDoc Enterprise Server Version 9.2 U 7
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@© #ERBNEN=Z &t 2R LT, <Create> R¥ %7 U v 7 LET,

Add User

Lser properties

. Type Regular v
User properties
2 i | e
P@. UPMN name

Member of SAM name [JUser must change password at next logon

groups Demain Firstname

Email Lastname

Description Fhone

Create series of “ useraccounts

Use this screen to manage this user privileges on all hisfher devices
Use groups to manage privileges of multiple users on multiple devices

Direclly Assigned Privileges (@ User Rights () Adrmin Rights
Modify Password [CIMoadity Profile [ Convert Removable Media
[ Madify Key [ =elect Profile [ Convert Hard Disk
[CJExpart and isw Key [l config SFE [l Disk Integrity Check
[wiew Transaction Lag [C]Create Emergency Disk.

[JExclude from DAL (password sync should be enabled)

[CJUser Key File(s) will be protected by token Userx509 certficate
User'stokentype: ey 2032 Add Delete Wiews
Following keys are associated with user
Key Name On-Derma. Add ‘
Wb False
Femove Keyto protect user record in SES database:
Edit AES W] ~

Reset Bt

® EkLiza—P—%f27 Vv 27 LT, arTXAMA=a2—)5 [Create Key File] 27 U v 7 L%,
<Browse>HR¥ %7 U7 LTHR—T 7 A )VORIGFGFHEERELET, "AV—RIDBIZREEFDHLDEZD
FEHEMAIT A0, O Apply use password from database] #F=v 27 L., <OK> 227U v 27 L%7,

Create Key File x

UserID |P¥Fadmin

Key File |CASESKeywPWhadmin dbk ‘l Browse I

Store file on token

| | d from datab
ppyuserpaﬁﬁwur fom database Protected by

(@) Password
(O Taken

Password

Confirm Passwiared

Change initial password

[[JAsk userto comvertto token pratection

Tokentype ke 2052

Protection method | Lse token RSA keys

[JKey Fila will be expired on (2022410424 with warning a : day(s) earlisr

®  [Key File successfully created. : (F—7 7 A AIMERESNT) EWHI XA T/ RNFRENETDT,
<OK> %7 Uv 7 LET,

SecureDoc Enterprise Server Version 9.2 UV 7 7 L >/
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@ SES ®A==z2—s—1X 1 [Database] -> [Access rights] #27 V v 7 LE7,

Key File Info

Change key file password

F’] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESA..

©Miew Folders Keys User Tools Help

- O
= P = -
" e | ?

Generate Key File Install Filter Help

A Users M Devices “{a Keps | ﬂ Groups ‘ | Folder Encryption Policies ‘ A Drives |

MNurr User D S Dornain Mame LIPN First name | ast narme
. nin I L
1 S0Admin

2 SESAdmin

Exit
B R

<Add>RZ a2z U v 7 L, Bl LIEF—T7 7 A VaBRLET,

Users having access to the database

Foot InUse UserlD

w w

Key Name
SESAdmin AES WhiJ

Edit

Delete

Close

[Key file password] #iiz/ "2 U — K& AJJL T, <Login> 27V v 27 LET,

VBTG UTCHERR Z IR L7, <Save> #7 U v 7 LET,

Administrator access rights

ke File password |\

‘ | Laogin

User|D |PWF\ADMIN

User's default key

Access rights

[ Prevent access to the AuditLog

D Frewvent use of remote control

[ Prevent access to Seli-Help answers

[ JAlows user to add other SES administrators
Access to global SES settings

[ Access to 5D profiles

] Access to installation packages

[~ &llow deletion of encryption keys

1 0nly allow access to the "Password recoven feature

Access To Folders

Current: Full Access
Current: Full Access
Current: Full Access

Current: Allowed to delete encryption keys

Save Cancel

MERDREIZOWTIL, ROT—TNLEBRLTLEEN,
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H B B
Access rights
© Only allow access to the “Password AT =R U BNV ERE~DT 7 & 2D THFFA]
recovery” feature
<Access to Folders> TIRAFRELET L7 LA ERRELET,
[J Prevent access to the Audit Log [Audit Log] ~® 7 7 & & % #ilBR
[ Prevent user of remote control VE—har ha—/ LR
[0 Prevent access to Self-Help answers e T~ VT OREZE] ~DT 7k A zkKik

HAGEBREE ClL, ZHERWEZE T EEA
[0 Allow user to add other SES administrators flio> SES EELH 2 EK « IBITE A L2l LET,

A Access to global SES settings 7a—sL SES BIE~DT VA

A Access to SD profiles [Profiles] ~»>7 7 & =%

A Access to installation packages [Installation packages] ~»7 7 & =X
A4 Allow deletion on encryption keys FEDOHIBRZ TR AT

<Access to Folders> O EIZOWT

B Access to folders *
(@) Hide selected folders Claar Al

() Show selected folders only

Mote: If folder is specified to be invisible, its subfolders will also be invisible. SetAll

Show Objects under Folders Root and Recycle Bin

B Folders
------ ] SES Administrators

| Domain Cantrollers
Ol =%
0 i
o DM LFEER

B H ‘ B
O Hide selected folders BIR LIz 74V Feay ) — IR RLERA,
TV RARAET DT VBRI 7,
O Show selected folders only BR L2 7 AV EORFRL, 77 & AHEE
J Show objects under Folders Root and T NEDN— kL& Recycle BN DO FiZhor 4727 b
Recycle Bin FoRLET,

Bl : NAT—=RUBNYDH DF—T 7 A )VEIERR LTZSHE

O <Browse> #7 VU w7 LT, HIERLIEF—T7 7 A VEBIRLE T,
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"ﬁj Login to the database X
Key File
Key File Path: |C\SE5KBy\P\NRadmin dbk ‘ I Browse II
Password |‘ Login Key File
Cancel
[~ Automatically cannect to the database last cannected-to

@ TROBEEARTRINEL, SAT—FE2 AN L, <Login Key File> %7V v 7 LET,

TH Login to the database x

Key File
Key File Path: ‘C'\SESKey\PWRadmm dok | I Bimee

Passwurd.l Login Key File

Create Key File

Automatically connectio the datshase last connected-to

Database Information
Create new datshase
Senver Namea: Create new connection
Databasze Name: Delete database

Delete connection

Login Cancel|
@ <Login> %7V v/ LET,
-‘j?.- Login to the database %
Key File
Key File Path: CASESKeyiPéwRadmin.dhk Browse
Password: eesess Login Key File

Automatically connectto the datshase last connected-ta

Datahase Infarmation
Create new datahase

Server Name: SEE\SQLEXFRESS v Create new connection

Datahase Name:  SESDE ~ Delete database

Delete connection

Cancel

SecureDoc Enterprise Server Version 9.2 U 7
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@ SESEHaLY—)LT, F¥L o IP&UARLZ BHOay Y —)LER ) 4,

Challenge and Response

| | Werify |

User|D:

Device Info: Default

User Authentication

Question Angwer

RMCE Recovery parameters

RMCE Recovery Key: Search

SecureDoc Challenge Response Recovery

Challenge: ‘UU goooooooaooo GetResponse

[]Use numeric input (Challenge 2)

Response:

Exit

B RERSAEBVRZ@EHELIZN
SecueDoc %7 A A b=, OS 2 U AN LA, SES EIZ0OS U AN RIDT /SA ATFRNE
D, 4B ANMERAESNT-EEDIREETT, SES @ [Device] # 7L EWT AL AZHIBRT S & T4 B A0 R
BEnEd,
@ SES ® [Devices] # 7MiM DT NA AERY, 7Y v 7 LET, IV TFA A= 2—0b

[Delete device] #7 V v 7 LTT /A AEHIBRL £,

® F31 A%, [Recycle Bin] (CB# L £7,
TA VAP ENET,
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B ATV NORIALYVITNY A U F U DOREIZLIZN
O BHEOTe 77 ANERETLZN, BEO T 77 A Eat—LTH L Fu 7 7 A L E2ER LET,

@ v 77 AT, Credential Provider 3% /E L £7,
[General options] -> [Credential Provider]

] Automatically log in to Windows with Credentials entered at Boot Logon] (25 = v 7 # AiLE 7,

@ A7 VU—rurvrnboOfEkRiz, SecueDoc Credential Provider %1 5 35413,
] Use SecureDoc Credentials to log into Windows] (ZF = v 7 # A E T,
SecueDoc Credential Provider % ET 2 &, A7 U —rm v 7 Offkk (Windows ~DHA A ) 12,
SecureDoc 7'V 7' — FRERETHE L TWDH 7Y 7 — FERETHF A S D 1 7o RGO i RIEASRE S AU E

TO
SecureDoc options bt
4 Credential Provider
General Define whether credentials entered at Boot Logon automate user's logon into ‘Windows
P Automatical\y log in to Windows with Credentials entered at Boot Logon
ﬂi‘_@ |:| Llsers can single sign-on with Smart Card or Token
Communication [ Automatic login to Windows will time out after 32 minutes
j& [ canfigure Windows Credential Provider as last logged on user's provider
BitLocker Define how SecureDoc credentials are used to authenticate at'Windows Logon
M nt USE SecureDoc credentials to log into YWindows
Additional options for token-based Authentication
[JLock computer when token is removed
Credential Provider
[T owin to Windows with ohone orotected kew file (Bluetaathl

H H L B

Define whether credentials entered at Boot Logon automate user’ s logon into Windows

A Automatically log in to Windows with 77— FERAE OB ® A H LT Windows 1Z HBIRJIC
Credentials entered at Boot Logon VA4 LET,

Define how SecureDoc credentials are used to authenticate ad Windows Logon

4 Use SecureDoc Credentials to log into SecureDoc Credential Provider %z {#H L C Windows (2
Windows A4 LET,

a7y A IVERELET,

@ [Devices] # 7T, BHDT A A%EHI7 Vv 7 L, 2arTFAMA=a—»5 [Assign device profile to
devices] 27 Vv 7 LET, 7077 A NV—BERERINDLDT, BIHEHR LT 07 7 A LV EBRIRL, <OK>
7 Uy LET,

¥ THNFEIRLTCT R T s ANETYA L THIELARET, 7AHNVTHOETOT /A ATHA I IET,

® 77472 MFAL AL, EMEEE T, SDConnex # ML T, a7 7 ANV EZITERY £,
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® WE, 7V T NRREERERT DL VAP A A OREICL Y. Windows ~HETHA A LD E
D

@ IO Use SecureDoc Credentials to log into Windows | IZF = v 7 Z AN TCW=HE, A7 U —rnu v 7 Off
BRIFFICIZ, AW ID OMRBEHEARTINET (EEO2—F—ID REEFEIN TV IHEE) .

Secure

J-todAna—H-ID:
Lzer0 ]

<OK> 7 Vv s 5L, MEANEDLY, NRATU—FRKEZROLNET,
ZDORAT— R SecureDoc 7Y 7 — FEF LRI U SAT—RTF, ELWIRATU—REZANLT <ul’fr>
U v r45E, Windows ~% A A L TXE9,

B TPMIZEoT,. TRARADEX2VT 4 ZmD-N
TPM %45 L F A R EMMST I, A R L—UEF AL ARKN RPN EDOEF 2 U T ¢ LN THETT,

O BFEO7Ta7 s ANERETLIH, BEOTo 77 AV E2abt =L TH L a7 7 A LV EERLET,
TPM ORENEGEND T 77 ANERETDI T4 T MM Liz%54. UEFI / BIOS T TPM BNA®NZ/2 > T
WRWT A 2T, TPM O EFER I, =7 — L3720 £8A,

@ Fur7yALT, TPMOFEREZZRELET,
[General options] -> [Hardware Authentication]
[TPM Protection for Key Files (for devices with TPM available)] O EEH T, FAF T A =a—hb
[Automatically TPM-protect Password-protected Key Files] &R L £,

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

SecureDoc options X
g Hardware Authentication
General TP Protection for Key Files (for devices with TPM availahle)
ﬂié IAutDmatlcaHy TPM-protect Password-protected Key Files ~ I

TPk supportis enshled. f TP Chip is disabled or reinitislized. user Key Files with TPM protection will be

Communication locked. For mare informatian, plaase rafer to the user manual regarding TREM protection

4

BitLocker
Management ] Defaultto use "Key File on Token" at boat lagon
g [JKey File suppons both Password and Token-based protection/authentication

. . Once token is used to authenticate, Key File no longer supports Password authentication
Credential Provider

e

Media Encryption

|:| If "Key File is on the Token". remember Key File to be used nexttime

@ [ Ask userto switch fram password to token protection

Password based Key File will be created in remate installation. When user logs in firsttime, he/she

SecureDoc File will be asked to inserttoken and change protection method of the Key File.

Encryption
Tokentype | ActivCard ActivClient W5

Protection method  Lse token BEA keys

Trusted Devices

a7y A VR RELET,
® E o B

TPM Protection for Key Files (for devices with TPM available)

- Do not use TPM - TPM ZfEHI L E£H A
- Automatically TPM-protect c NAT— R TRESNTF—T7 7 A L% HEIT TPM {REICUI D Bz
Password-protected Key Files *7

- Create Key files protected by TPM N2 T—= KOO VIZ TPM & PIN TR#ESHZS— 7714 %
and PIN instead of a password Bk L&,

@ [Devices] # 7T, HHOT A AZHEI Vv 7 L, ar7FAMA=a2—n05 [Assign device profile to
devices] #7 Vv 7 LET, 7077 A NV—BRERINDIDOT, BIHER L7077 AV ERRL, <OK>
Uy LET,

@ 77472 TS AL, EHREE T, SDConnex # LT, a7 7 A VEZITERY £,
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® &l 7V 77— FRIEA @B L. Windows YA > A D% [ —7 7 A4 113 TPM R#I1C ICEBINEL
721 EFRREINET,

SecureDoc

o9 =77 L. TPMIRGEERCRIRENAL

2—F—DF—T 7 AL, NAT— FREND TPMREICU DV FELOD E LN, 2a—F—RBZRI> T T—h
muuﬂi(@jﬁ(ﬁ%]\ﬁ—aﬂé/\x 7 — ]\ 733429 n Vi?} ] i“ﬂ_/\/o

@ 7 IAT }\VC\ 709 7_ ]\umuEi& PIN Tmuuﬂzb Windows | ‘3‘4' A /?& SDConnex &1 1::'?‘%) gf 74
7 v hOIERN SES ICELILE T, SES @ [Devices] # 7 LV, %4 =—¥—o [KeyFile Protection Type]
WEHeRT 5 &, [Password + TPM| RSN TEY, TPM CHRESNTVWD Z ERMRTEET,

I'O'] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - O X
Database View Folders Keys User Iools Help Secure
@ 9 Fo an b ol ?
Add Refresh Del Generate Key File Install Filter Help
= |, Folders A | A Users | B Devices  §f Keps ‘ o Groups ‘ | Folder Encryption Policiss ‘ M Drives
SES Administrators Mum Device MName S Modified Created Enc Deploved State Profile Mud\ﬂed
S W wmilocal [0 |DESKTOP-EUBGIES |2022/10/24 1 114 oy 7 1) o Da
Ly Domain Controllers
L =T
W TR
-y EEFEER < >
-\ All Folders
g Purged DEWCE% Num User ID Owner  / KeyFile Protection First name Last name ermail
3 g Exempted Devices 5 DAdmin Mo Passwinrd Prase
T i i et oo I E T
%, Recycle Bin - = i i
@) Profiles
=
44! Installation packages ~
< > < >

Record(s) visible: 1, available: 1. Total user(s): 13. Total computer(s): 2. Total key(s): 6.

£ 73 A0 UEFI/BIOS #%ET, TPM &b 50E7 V7356 L, 7V 7 — MRGETELWID//RA T — K
EANLTbr A TERIBVET,

B TPM+PIN i2ko T, SXAMRDEF 2T 4 2EmDIN

V9.0 TEBMENT=HHEEETT, TPM L PIN 265 &, BRIZT A A LSBT onized =2 VT {R#EFELRY
¥4, PIN %252 & T, BHLEWSZAT— REFERTALERRL Y 7,

O BHFEOTa 7y ANERETSI, BEOT0 77 A N abt— L TH L e 7 7 A VE2/ER L 7,
TPM ORENEENDI T T 7 ANEETDI TA 7 v MM L7284, UEFL / BIOS T TPM BRAM2->T
WRWT A ZTiE, TPM O EITEE S, =T —Lid72 0 8 A,

@ Tr7yANT, TPMOERZHELET,
[General options] -> [Hardware Authentication]
[TPM Protection for Key Files (for devices with TPM available)] O EEE T, 7AFX T A =a—hb
[Create Key files protected by TPM and PIN instead of a password] #&iR L £9,

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

SecureDoc options

General

)

84
Communication
BitLocker
Management

Credential Provider

S
Media Encryption
IS
SecureDoc File
Encryption

Hardware
Authentication

sl
“a

Trusted Devices

o*

Hardware Authentication

TP Protection for Key Files (for devices with TPM availahle)

I Create key files protected by TP and FIN instead of a password I ~

TPk supportis enshled. f TP Chip is disabled or reinitislized. user Key Files with TPM protection will be
locked. Far mare information, please refer to the user manual regarding TPM protection

Minirnum FIN length: B :

FIN complexity rules: AHDW alpha characters in PIN

] Defaultto use "Key File on Token" at boat lagon
[JKey File suppons both Password and Token-based protection/authentication
Once token is used to authenticate, Key File no longer supports Password authentication

|:| If "Key File is on the Token". remember Key File to be used nexttime

[ Ask userto switch fram password to token protection

Password based Key File will be created in remate installation. When user logs in firsttime, he/she
will be asked to inserttoken and change protection method of the Key File.

Tokentype | ActivCard ActivClient W5

Protection method  Lse token BEA keys

Cancel

SecureDoc Enterprise Server Version 9.2 UV 7 7 L >/
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TPM Protection for Key Files (for devices with TPM available)

S
N

- Do not use TPM

+ Automatically TPM-protect
Password-protected Key Files

- Create Key files protected by TPM
and PIN instead of a password

- TPM %] L £ A,

CNAT— RCRH SR — 7 7 A VA& BT TPM (I8 0 B
=7,

c RAT—=FRFORPVIZ TPM & PIN TRESNT-F— 77 AV %
e LT

PIN complexity rules:

[J Allow alpha characters in PIN
Minimum PIN length: X

PIN (295 &7Fal L £,
PIN O s (&/h)

@ [Devices] ¥ 7T, HMOT A ZA%HT Y

v L, 37X ANA=a2—25 [Assign device profile to

devices] #27 Vv 7 LET, 7077 A V—ERERINDIDOT, BIHERLIZ7 a7 7 AV EFIRL, <OK>

7 Uy LET,

I IAT VN FAL AT, EMHREE T, SDConnex LT, Fu 7 7 AL EZITERY £7°,

® WE, 7V T7— FNEFEA @ L, Windows 1 A DT, PIN ZRETAH1DDOR Y 7T v I A= a0 —nNHKR

ShET,

F-I771LETPM + PINGREZLEITTS

£ SecureDoc

TPM + PINM AT - FICEEATHEM ZZT Y.

Tis

SecureDoc] —1f-:
User01

F-77)0 KAD-E:
I
SecureDoc TPM PIN:

TPM PINEEEERLEF:

PINCEF%EFoI 98 v PIN(D& |\ JLFEY

1Y =D =74 L FHE, PINET ) ADTPMF v I &(EALTIRETD
&P - FIRERITETOET. PINOICFFLERROT I

PINDEME 6

[F—T7ANRRAT—F ] fliCid, 7V 7= bifECINETHEA L TV "2 U — K& AH L, [SecureDoc
TPM PIN:] #RiC, BEEICFIZR RSN TNDAL—IZ%E > TPIN Z# AN LET, [TPM PIN 28 LET : ]l
X, HEROZDOLDROT, WUPINEZAAL, <OK> 227U v 7 LET,

® FELLEENETTHE, [SecureDoc F—

T 7 AINVOHENTPM + PIN ICEEENFE Lz, ol (95L&

T, HTLWPINZADLTLEE, | EFREINET,
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B 7 UERMEALT, ZERFEHRLTIREICLEZY (FuT 7 AV TORE)

BRE (ZHEAN) mic, SecureDoc MY R—KLTWD h—7 U THEINEHRL T IEEW,

O F=7 OYHREEZTOREETHBE, b—27 2 Windows LTRSS DIREEICHEN L T E £,
VIR EFIEIL, b= vDO~v=a T VESRLTIIEE N,

® Fu77ALd<General options>7T, AT F—27 L &BEIRLET,

SecureDoc options X

Hardware Authentication

General TP Protection for Key Files (for devices with TPM available)
iii Create key files protected by TP and PIN instead of & passward ~
o TP supportis enabled. [f TPM Chip is disabled or reinitialized, user Key Files with TPM protection will be
Communication Incked. For mare information, please refer to the user manual regarding TP protection
& PIN complexity rules [~ &llow alpha characters in PIM Minimum PIM length: |8 =
BitLocker
Management [[] Defaultto use "Key File on Token" at boot logon
@ [key File supports both Password and Token-hased protection/avthentication

R . Once token is used to authenticate. Key File no longer supports Password authentication
Credential Provider

&

Media Encryption

[JK"Key File is on the Token", remember Key File to be used nexttime

() [ &ssk user 1o switch frorm password to taken protection
Jl 1

Password based Key File will be created in remote installation. When user logs in firsttirme, hefshe

SecureDoc File will be asked to insert token and change protection method ofthe Key File

Encryption

¢ .

Advanced Options

Tokentype  ActivCard ActivClient Vs &

Protection method  Use token RSA keys i

Hardware
Authentication

O Ask user to switch from INAYT— R CRESNTXF—T 7 ANV E =0 U ClRiETHX—T 7
password to token protection ATANTEH L ET,
Token type [Token type] TiE., VAU A=a—nbEfT5 Fh—7 v &2
Protection method RLUET,

[Protection method] % F—7 Y OREIZH T ET,
F—2 NZ L > TRINTE 2 HETRRY 5,
- Use token RSA Keys
- Token contains PIN
- Use Certificate on token - h—2 »ZFHE
- Use Certificate from windows store
- Windows A ~ 7 » 5 OFEIE

DIAT T NAA A AER LT n T s A v L ET,

TIATV NTNART, b= &R LET, 7V 7 — 82/ YA U — KTl L, Windows #1 > 1
#%. Windows 7 A7 b v 72 b —2 MREIZHIN B Z 272D DR v 7T v TRERINET,
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r=OVEEITH-I7 IV ERET DEICERTD

SecureDoc Key File is currently password-protected but has a setting specifying it must
change to Token-protected.

Before pressing OK, insert the token, type in the current Key File Password, then type in the

<\/ @9 Token PIN below.

Click Legin to login to the Token, then press OK to complete key file conversion to token-
protected.

F-TPA N (RT-F: I

-TiRE

b= DER: Yubikey ECC Token v
A0vhDER: v
AEDER: v

FrEIO

® Fr—rrEBEHTLLE TAmy FOBR | ITER LI N2 VBRI SNET,

=2 U EFBLTCWRWEGEE, <FryrtA> 271U v 2 L, SecureDoc =2 h— o ¥—%FTLET,
BHE, Fh—7 MBIV EZ DD OREHTNFRINET,
F0VEBoTH-Tr AV ERES &5 TS

SecureDoc Key File is currently password-protected but has a setting specifying it must
change to Token-protected.

Before pressing OF, insert the token, type in the current Key File Password, then type in the
A /' \ Token PIN below.
)

Qy Click Login to login to the Token, then press OK to complete key file conversion to token-

protected.
F-T74 ) 1TAT-F: [ ]
F-TuiRE
h-TUDER: YubiKey ECC Token v
A0whDER: Slot 0 - Yubico Yubikey CCID 0 v
AEDER: -TUDARSEERTD v
b= £ [ ] (071v]

£ovbIO

[FHEDOFR | X h—7 v OBREICAEDEE T,

® F—TFANDNRAT—REL =7 DNRAT—F (PIN) # AiLT, <nr/Ar>&7 0 vy 7 LET,
@ b= AT—F (PIN) RELWVES, [F—F AT Vxs F T UVIRERENET,

<OK>%27 Vw795l [F=T7ANDOF—R#ETIEN b= NZIEFICEBRSNE L) EFRRENET,

WEILARE, 7 7 — RRRRERHC h—27 b b= D82 T— R (PIN) 2R%ETRY £,
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B 2 UEMBEHALT, “EBERFFELTIREILEY (F—T7 74 LV TORE)
FE (ZHEAN) BIZ, SecureDoc THAR—FLTWD h—27 o THIMEMHRL T IEE N,

O P OPHRETTOHREETEBE, F—7 5 Windows Tk SN A REEIZHE R L TR E £,
VIR EFEIZ, F—2 v D~=aT L EBR LTI,

@ [Devices] # 7T, TN RIHBINTVDHL—YF—ZE RN L, vUVAOLEZ YV v 7 2L THFAMA=2
—7% [Create Key File] #27 VU v 7 LE7,

F:] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin

Database View Folders Keys User Tools Help

= = —
- ¥ X & B @ ' ?
Add Refresh Del Generate Key File Install Filter Help
E- | Folders A A Usersl & Devices i Keps ‘ B Groups ‘ | Folder Encryption Policies ‘ & Drives
i SES_AdmlnlstratDrs ] Mur alel ‘ Enc
h wmj.local
- Domain Controllers
o] L ==
W =HTE
W wER @
i1 All Folders
- @ Purged Devices
] g Exempted Devices ONum SDAdnLqJ?:r D £ First name Last name email -
e 2; Recycle Bin L | Precd
. L,’_] Profiles % Remove user from device Del
1;1] Installation packages v @ Accessrights Enter
g > ¢ Set Filter

Remove the users from devices
Refresh

& Modify User
% Create Key File
Z¥  Challenge response

% Remove key file from device

FileVault

@ F—T7rANOERBEENRRIINET,
[Key File] #i <. <Browse> %#7 U v L, —BIERAT 2% —7 7 A L OBEFRERELE T,
h—=2 OV EZNET LIELHIRT 22 ENTEET,
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Create Key File X

UserID UserD1

KeyFile |CiJsers\SESAdmin\Deskiop\Userd1 dbk | | Browse

Store file on token

[ lapphy user password from database!

Pratected by
(@) Pagsword

() Token

Fassword

Confirm Password

Change initial password

@Ask userto convertto token protection

Tokentype I Gemalto Lexar Taken If

Protection method I Use Cerificate on token I’

|:| Key File willbe expired on  |2022/10/24 with warning 0 : day(s) earlier.

@ RRAU—FROFREE, SecureDoc DFBFE/SAT — Rvh h—27 NI X HBICHEAT 5L D TY,
] Apply use password from database]
WWTFzw B AND L, T—FR_R—RRFEIN TN D 2= —=PNRE LTS AT— FEFHT&EET, SES FH
FPRNAT— NG T 20ERH Y £ A,

® ] ask user to switch from password to token protection] (ZF = v 7 Z A E T,
[Token type] THHD b —27 > %#®IR L. [Protection method] X b — 72 L MOREICHHEET,

<OK>%7 Vw7 LET, 77T bT AL RAXEHRBEET, ZOa~vy FEZITRY E3,

@D I7I9ATVITAALAT, VT — bRiEZ i L, Windows ([ZVA A 95 L, Windows A7 kv 72 b
— 7 VMEEIH VIR Z DT ODOR T T v TRERENDDT, b= U EEHRLET,

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

r=OVEEITH-I7 IV ERET DEICERTD

SecureDoc Key File is currently password-protected but has a setting specifying it must
change to Token-protected.

Before pressing OK, insert the token, type in the current Key File Password, then type in the

~ r@\ Token PIM below.
~
Qy Click Legin to login to the Token, then press OK to complete key file conversion to token-

protected.

F-TPA N (RT-F: I

-TiRE

b= DER: Yubikey ECC Token v
A0vhDER: v
AEDER: v

FrEIO

® b= rERHTDE.
h—2 %

(Zmy NOBIN | IZERE LT h—7 U RFRENET,
LTV ARWEA, <FxyrtBA> 227V 2 L, SecureDoc 2> h—t X —%FITLET,
HE, b= AU BEZ AT OOREBENFREINET,

PO ETF-I7 I ERETILICFRTS

SecureDoc Key File is currently password-protected but has a setting specifying it must
change to Token-protected.

Before pressing OF, insert the token, type in the current Key File Password, then type in the
A /' \ Token PIN below.
)

Qy Click Login to login to the Token, then press OK to complete key file conversion to token-

protected.
F-T74 ) 1TAT-F: [ ]
F-TuiRE
b= T DER: VubiKey ECC Token v
A0whDER: Slot 0 - Yubico Yubikey CCID 0 v
AEDER: -TUDARSEERTD v

r=72)(27-F | ] ngy]
FrO

[FHEDOFR | X h—7 v OBREICAEDEE T,

Q@ F—T7ANDRATY—FEL =27 DA T—FK (PIN) ZANT, <aZAr>%27 Vv 7 LET,
® bF—2>02T—F (PIN) BELWES, [F—447 V= b IT_LIRERINET,

<OK>%Z27 Vw7 325L, [XF—T7ANOF—REFENN—7 ANIEFIZEBRINE L] ERREINET,
WEILE, 7Y 7 — FNRGERFIC h—27 v & b= DA T —F (PIN) ASEICRY £9,

SecureDoc Enterprise Server Version 9.2 U 7 7 L ./ &
© 2025 WinMagic Inc. All Rights Reserved.




WinMagic
\id SecureDoc

B 7Y T —FTOFREEIZ, A~v— P 7V 2ENZND

£ V9.2 TiX, A~— b7 % IZ MagicEndpoint2 BB TY,

® SEST, V—hulF4r7al I ACPBLU 2SS A A ML —a Xy —U5ERLET,
7’'va 7 7 A LN® TUEFI Boot Loader] ®i%ET, PBLU Z &R L7177 7 A VEERLET,
[General options] -> [Boot configuration]

UEFI Boot Loader
() PBU: Native UEF pre-boot emvironment
(@ PBLU: Linux pre-boot for UEF| devices

teximum number of failed FELU boot -
attempts permitted before Pre-Boot -
switches to PBU

PBLUICRRE LT B 7 7 A VEBIRLC, A VAR = a RNy r—U%ERLET,

@ SecureDoc %7 A7 v MIA A M=V LIFE(LLET,
74T v T3 A0 UEFI/BIOS KO Windows . Bluetooth 23F I AJBEZRIRBETH D = & 2R L £,
@ SEST, YUV 7 —bRAECTAY— b7+ v EFERATHdOT a7 7 A VEERLET,
A VAR LB FEO a7y A ViR 27 Y v 7 LT, [Copy profile]loife s 5 &, VB EfT D &
WETEET,

[General options] -> [Hardware Authentication]

©

SecureDoc options hed

General TP Protection for Key Files (for devices with TPM available)

33 Do natuse TPM
2

Communication

Hardware Authentication

BitLocker
Management Allow Mobile Device-based Authentication using Network
Enakle Managerapproved Recovery Logir

ﬂ EIAIIDW Mobile Device-based Authentication using Phone Token (Blustooth)

Credential Provider |:| Enable Push MNotifications far Bluetooth Phone Tokens
) [[]Ask users to enroll OTP protection on their phones

[%I Requires enabling MagicEndpoint in Communication options

Password Manager ["]Detauttto use "Key File on Token" at boot logon
_ [ Key File supports both Password and Token-based protection/authentication
&

[ ] Once token is used 1o authenticate, Key Fila no longer supponts Password authentication

Media Encryption
B [C]it"Key File is anthe Token®, remembier Key File to be used next time

i
SecureDoc File Ask user to switch from password to token protactior
Encryption Password based Key File will be created in remote installation. When user lags infirst ime, he/she
will be asked W ingert token and change protection method of the Key File,
= Token type ActhvCard ActvClient Y5
Advanced Options
Prataction method | Lise token RSA keys

Hardware
Authentication

2
d',Jn.l

Trusted Devices

Sl

® A4 Key File supports both Password and Token-bsed protection/authentication] »F = v /7Ry 7 X%
FoACT il A= TV OFRBYINRE, A~v— TV EHZRVES, SAT— R TRIETE £,
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® SESHOIER L7077y ANETTAT Y T L AZHALET,
@ I7FATVRTARA AT, 07 7 A NVZEZROFRERE, AT — NME#END A~— 87 4 I X D8GEICY)
NWEEZBTDDR Y TT v T A B—IRNERENET,

BNT, F—7 7 A NRFETIEOEEBEH R FR SNET,

=0V EETH-T7A N ERET BLIEHRT B

E [ ﬁl E SecureDoc ¥-774 VFRE/(AT-FRBESNTVETH. M-IV RBILZE T ILENBYET.

EIMNTIAR (A¥-FIAY) [ MagicEndpoint Mobile Authenticator PFUHM Y AR-ILEh
TWEWMER(, [OK] EFTHIC

1) Bluetooth H'E#CE->TNWITLEEELST.

2) £0 QR I-FEZFvYLT. MagicEndpoint Mobile AuthenticatorP TUE45%0-F/4 U A
r=ILLET.

3) 7TVEEELET.

EIANFIAR (AV-bT4Y) 2054 L. MagicEndpoint Mobile Authenticator 7 TUE T
UEREBT.

1) ¥F-IrA VDN RT-FEL FICANILES.

2) [OK] 87YvILET.

F-774 ) S(AT-F: | 1
M7URE
M2U0ER: Phone Token (Bluetooth) v

02O

©® WinMagic Authenticator (MagicEndpoint2) RNA~—h 74 1A VA P—=ALENRTWRWEAE, QR =— K%

AF vy LTA VA =L LET, v9.2 Tid, MagicEndpoint2 X% E T,

MagicEndpoint2 Z &) L. HE#EIZiE> TRE L T EE0,

Bl %1%, iPhone ®¥54& . MagicEndpoint2 #3479 % &, ["MagicEndpoint2”-C Bluetooth 7 /31 A& FE4 =
EERFFRILET 2 . ["MagicEndpoint2”iTidaz =G5 LET, TALWTTN? ) ERREINDIDT,

<HF> B2V v LET,
[F—T 7 A ARAT— W7 Y 7— FRIEECHAI L TVWA AT — K2 AN LT, <OK>%2 U v LET,

WOEENFREND DT, A~— k74O MagicEndpoint2 T, [Accounts] T [SecureDoc| %#&EWN)
[+ #27Vv27 LET, ["MagicEndpoint2" 23 h AT ~DT7 7B A%ROTNET)] ERRENDDT,
<#FA[> 7 Vv 7L, QRa—RERFX¥ L LET,
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SMBEL T

16:34

F=TVEETH- IV ERETDLICERTD

Accounts

Search account X

=THRE
=2 MER: Phone Token (Bluetooth) w

@ RNAT=NMRENPDURAICEINT DL, ROA v E—VPRRRENET,
24T FO/EEBEZ, Av— P74 K DREENTREL 2D £,

BLECAN-FIAVERSH

SecureDoc

by WinMagic

o TP VEAT-FIA Y (ELERECEI Z el |

OK(O)

@ 7V 77— NRFEEE T [Bluetooth ZFIH L7c A~— b 7+ VERAE] OBE@EAERTINET,
A~— k7 # > C MagicEndpont2 @i %~ LT 72 &V, Bluetooth i pkth 356 &, A~— K74+ 1C
0T A DR ERDD Ay E—UNERINET, <Approve> %7 U v 7 LET,

Z D%, EMAFERE,

BHANNIAT— T+ DNNAT—RKEAHLT

SIMGL T

-

)

a—4— User-B H'7/{+( X PC-002
KOJ1 Y TERLSKLTLLEZ

177

® MagicEndpoint
P Li.”." P

by WinMagic

L secureDoc 7—hO%# > o

5

BB IZoTLIEEN,

W,

Reject Approve

Authenticate. Encrypt. Achieve

7Y 7 — FEREEEE T [Bluetooth ZFIH L7z 2~— k7 4 L 3R3E] OEEAFRENET,
A~— N7 % T MagicEndpont2 Ol %~ L TL 728V, Bluetooth Bl ckth 325 &, A~— 74 1C
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A DR ERDD A v E—UNERINET, <Approve> %7 U v 7 LET,
D%, ERBIE. HBEVEIAT— R T DNRRAT— FEAN L TRIAEBIR>TLEESN,

K a—F—RRAv— 7+ CEFEATERWGS, REICIVARFRIAT =Tl T2 LRTEET,
=P =P T = RERELTVEEE, TY LUV L ARV AL S TRAT—RU B8 BA[GETT,
RELTNHAS— F 74+ OlER ET, HTE R Rol e, NAV—RICILRBAEICRL, 7rn7 7 A1
DREBAVT— M7+ N R DBIEEWN L T2 0T 7 A NET TAT VT AL RZWEAT 2RERH D 7,
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B FEECRELTWDIARAY— 74V ERIDAS— h T+ VZEE LT
¥ A~— 74 12 MagicEndpoint2 2348 T

® 279472 T, SecureDoc = h—Lv v Z—%EEHL, v/ A LET,
[BIER—] T, "= AR o) v LET,

SOIYLO-I A~ - o x|

SecureDoc &

by WinMagic

FHSYa-tHYFEIDIERT BN, FHEERIOET VIV Y-Il(-2ETERNOE T U3V ICERL T L.

M=7uRE NINNT ZHEXETD ‘

)
@

FEGERICEIE. IR THE F-I71b0)AT-FEEELRY. IN-J10o-T1ATRERLE T 3ILA TEET.

@ WwoOEmEMNFERINET, A~— 7% T MagicEndpont2 B & £,

SecureDaoc *

SecureDoc

by WinMagic

LIgimMagicEndpoint 7T (A7-F742) A'SFLL\MagicEndpoint
77U (AR-FR74Y) MNETIERERSTICN LE0AT-FTAVT
HTUIIAMEZAL T,

EAHTT 3. FLWAT- T4 TMagicEndpoint PTUERE. -
IPANERIA-LCETENAQRI-FEAFvILTRITER TLIGE
AN

P

® A~—h74>r? MagicEndpont2 12, B/ A L DFA[ZRD B A v —URNFRENET,
<Approve> %7 U v +5 L, F—0 ARECY D B2 DWEAERINET,
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SIMGZL 16:20 - -
F=IVEETHF- TP ERET DEICEERTD
Accounts
[E 5@0DF/AATELE (Bluetooth) ERIELTZEOM VEEHICT TR AT-FT40
“ Sacuribon. | 7Eib0 MagicEndpoint Mobile Authenticator FFU T F () QRI-FEAFvYLET.
Search account X /
— Tl -
MagicEndpoint Rl 0
Please authorize user to login at
SecureDoc
Phone Token (Bluetooth) v
Approve

Fou©

@ IQRa—FKnb7 XV EFyre—R] 270y 7L, TRUDLRETHA~— 7412 MagicEndpoint2 %
A Z =/ L¥ET, ["MagicEndpoint2”T Bluetooth /34 2 AT Z L AR LETH2
["MagicEndpoint2”i3ili & 45 LET, LALWTT 2| LFRRENZL, <ffFAl> 27 Vv 7 LET,
® MagicEndpoint2 @ TAccounts| T [SecureDoc) ##EW [+ 27U v 7 LET,
["MagicEndpoint2" 3 A Z ~D7 7B A% RODTNWET) ERREINTZDH, <FR> 227Uy 7L, QR =2—
REAF Y LET,
® BT DHE ROA v E—VPRRRFENET,
IIAT Y NOFEBE, LAY — N7+ K DBRENAREE 720 7,

BLETAV-FIAVEESH

SecureDoc

by WinMagic

i o £ TP VAT~ FIAVBLEREEL(ERenELE, |
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B HAE REESNTWVEIARAY— "7 3 N KBRIAEPH/NRAT — RIZ K BA~EET 5 5
=T 7 ANVEEERLET,

O Av—b 73 afHLRNWT 0T 7 A NG TAT 2 T AL R LET,

© SES ®[Devices]# 7T, 2—HF—DF A ZEFER, TRIZRRENHIZYO2—F—2H7 Vv 7 LET,
[Modify User] & %17 L £,
TEZHD T4 User Key File(s) will be protected by token)] »F = v/ Ry A% 4712, <Save>%
7V w7 LET,

Cambhined privileges do not reflect unsaved group memebership changes.

D| User Key File(s) will be protected by token Userx 509 cerificate
User'stokentype: | Phaone Taken (Blustooth) Add Delete i
Following keys are associated with user
Key Name On-Dema.. Add
Remaove Keyto protectuser record in SES database:
Edit AES Wikl
Sawve Feset Exit

® ®HE a2—V—%2F7Yvr7L, arTXR M A=a—nb[Create Key File]2E/TLE T,

Create Key File x

UserlD User1@DESTOR-7AP303E

ke File | | Browse

Store file ontoken

Appl d from datab
D pply user password from datebase Protected by

| (@ Password

| () Taken

Passward |

Confirm Password ||

[ ]change initial password

[ ]Ask userto convert to token protection

Tokentype  jKey 2032

Protection method  Use token REA keys

[ Jkey File will be expired on |2023/04/25 wiith warning 0 : day(s) earlier.
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@ <Browse>HR&Zr &7 Y v LTH—7 7 A VORGEHFTEEELET,

® [0 Apply use password from database] OF = v 7Ry 7 R %A T HE, VT — MBRAE T2 —HF—»
RELTWZ/NAT—RT, BiECTEET, (BEHEHILSES 2 Y — L& ffio Ta—F—DRRATU—REMD
LIETETEEAN, 2= =D/ AT — FE#RIT SES O DB IZfRFS N TWET, )

® A=Y —BRT—REEELTWHYAIT. [Password] 7 4 —/L RicsxU— &2 AL, @@ Change
user password] OF = v 7Ry 7 A AN LET, 2=V —IZRAT - FOEFTLEERLET,

@ <OK> #7271V v7 LET,

Key File successfully created.] £ WH XA TR I NERINETDOT, <OK>%7 VU v 7 LET,

©® 27F47 > bFA 2%, SDConnex & DERETHLWF—7 7 A L E2ZTIRY £7,
FEEZRIT. SRV RICXDWIEL R0 £,

BENTET LIeh, @THEELLEEIREFEINTNDXF—7 74/ (*.dbk) IFHIFRTX E7,
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7.3.SecureDoc 7 ATV DA VAR M—)VERIE « HEIZDOWNT

B SecureDoc 7 FA TV FDA VA P—/L - BEZBEEIZLZW

TueYa =y = VEATLE REYA LY M A M= ARFRETT A, BECT Yy Fa—F =R L T
5T /3A A SecureDoc 7 74 7 v MEERT 561X, 22—V =X DA VA NV BEN KB D FT,
a—F— 2B ENTTIC, SecureDoc 7 7 A4 7> hEA A M—/F 5 HEE LTiX, Active Directory ® 7 —7
RV —%2FHLTY 7 =T %) E—FCA VA M=ATIHERSY T, TOHA, Windows f > A h—F— Xy /7
— [SecureDoc_64.msi] #{FHL £,

FLII=A 7Y 7 DOV A PR IZBRLIEE N,
%% : Microsoft KF¥ oAV b [0 —7 KYv—%2@HLTY 7 by 2T2)E—FCTA VA M—=LT 5]

https://learn.microsoft.com/ja-jp/troubleshoot/windows-server/group-policy/use-group-policy-to-install-software

B FREE ID Z Windows 1 A T H U FAUSATRE LW

INETU 42Tyl ZLOBEENLD T 4 — KRy 7 2WeEE, 7oy a = 70—k % ID OFF
RAEERE L CEE L, TrEYa=r P A— ML o7T, Windows A A 7w M4h b SecureDoc @
a—HF—ID ZHBTIERTHZLENTE, A VA M ARUOREXTWHICHEEEDL LN TEET, SecureDoc D7 —
bwrAd 7 a s sk, Windows OS Tz, Windows ¥4 A v T D v Mk a—F—ID LA T—F
WAL TH, Windows D/XAT—R7 Z w7 i EORBEFLR LIF720 A, Zhb0EMIZE Y, Windows ¥4
YA YT HY Y "% SecureDoc D —HF—ID & LTHEATL LT FArEnTnET,

ZIZTE, BERY —IZ ko T Windows 1 A T U N USND 22—V —ID ZEHTDIMERNDH D BED
A VA L= Ry =V OERGEZRE LT,

HEMcID 2% L, SESITA AR —FLET,

@© Excel %% -7, SecureDoc D= —HF—& LTS ID Z{ER L £,
T NAT—READLTLEE N, A =3y A2 T—FRELTHEHALET,
7747 2 FTHMT S Windows OH A ID T ED TSV, ZHUTIFARAY = RE AT 24 ETH Y
Fth, T2 Ra—P—LSD ITHMRLF v T 4 T EERA R F—F D55 T, /E¥EM® Windows ID %
> T Windows 291 v U 28561%. D Windows ID 7217 2 &0 T 7ZE 0y,
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Bl) TROLIITHA PMTENRRT = FEEDET,

A—%—ID | A= X ANRT—F k2 E:0) A—=LT KL R
PC-11 12345678 i
PC-12 12345678 / SecureDoc @
PC-13 12345678 r ID & L THEH
PC-14 12345678
PC-14 12345678 i
User01 i
User02 Windows @ ID
Uesr03 - /
User04
User04 i

CSV (CSV UTF-8 =2 ~RXUIv) X THRIFELET,
SES 2. FAflC, 2—Y—% A VR— T D7 4V EEERLTEE £7,

SES DA =2 — 3=,
[Tools] - > [Import from---] -> [Import users into from CSV file] #7V v 7 L% T,

ro'] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User na... - O x
Database View Folders Keys Qserelp Secure
Add Refresh Del Generate Key File Install Filter Help

@ SESDB®D7 4 —/L R&—HEEALDOWMERFRENETT,

Import User infarmation fram CSV file x

CEVfile

Match List Columns in C5V fils

Database field  kMatching CSY file colurnn
UserlD

Firsthame

LastName Delete
Email
Phone
P!

Set

Next >> Cancel
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® CsVfilex2rUvyZr L, EIT/ERLIZCSY 77 A V%

T
FAIABET,
Import User information from CSV file x
CitempiBook] csw
hatch List Colurnns in CSV file
Database field Matching C5V file calumn Set AL AT
UserlD
Firsthame
Lastiame
Email
Phone
Pl
Mext >> Cancel
- — B > ~ N .
® EICERINTWDHEHA EHRPAATLET 7 ANVDE A ML ERDE <Set> 227U v/ LET,
Import User information from CSV file X
CSW file Citemp\Book] .cawv
hatch List Columns in CSV file
Databasefield Matching CEV file column St * g:j);flbl:; ao-k
<t ﬁf
LastName Delete HR
Email
Phone
(Pec |

UserID & PWD (I TRELET, ~HIEL2L02BOIRL, RENFATDL, <Next> #7 VU v/ LF
j—o
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@ WwoWmE T, <Select folder>TA VR — M7 V&2 E L. &#%IZ. <Finish> 227V v 7 L9,

Import User information from CSV file *

Select Group

Select key

Protection Key | AES ‘Whid ~

AFoldersy O ER

[ To update existing records [nhotto add new ones)

<<Back Finish Cancel

EREZRDOBENDDT, <OK> 227U v 27 LET,

SESO 7 WV ZIZ, 2—YP—=IDNA U R—FrENTWBEZ L ZMHRLET,

SDConnex DEREZERELET,

@O SDConnex @ [Communication] ¥ 7 ZBH& £,

1% SecureDoc Services Configuration — O X
T7VEF)  BIEA) TRV AVTH)

o= z H

% SecureDoc Sevices i

% SDConnex Service

3 SDConnex Service -
% AD Sync Service -
% Analytics Engine Service PC SecureDoc Client Communication ~ | s Configure
Service Port Number: 7300 S Use restricted Ports (< 1024) [] B Monitor
2] ViewEventlog

Service IP Address: Any IP address
Start
Transport Layer Security (TLS)
Ciphersuites
Disable TLS V1 TLS_AES_266 GCM_SHA384
TLS_CHAGHA20_POLY 1305 SHA256
V] TLS_AES_128 GCM_SHA256
@) Server certificate source: SES database [[] TLS_AES_128 CCM_8 SHA256
[] TLS_AES_128 CCM_SHA256

Stop
Register

&
&
®
@ Unregister
N2
&

O Server certificate source: OS certificate store Apply
Reset
R »
Maximum Concurrent Sessions: 100 = B ~v
Receive Request Timeout: 120 2 sec Send Response Timeout:120 > sec
Check for Active Commands every 0 2 min Quarantine Timeout:0 2 min
Busy State Sessions Count: 10 : Idle State Sessions Coun 5 2

Keyfile Update Task Sleep Interval:600 ~: sec

Remote Installation
E User existence is required
Use password from user record for existing users

[[] Move devices into Recycle Bin in case of reinstallation of SecureDoc

X Reset o Apply
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@) [ 4 User existence is required) (2F =7 2 ANET,
¥ OZOREIZLST, HIZA VA= LIza—H—ID LSO ID 28> TEKRT 2 Z L 25 £,

® HOBMEASFALT, [Stopla 2z Uy LIEILEH, [Start] 22V v 27 LTEBH LT ZE W,
—BROBIETTOT, MGEOIZ TAT 2 MIEERSLZ LIXIFEALEDHY THA,

AVA L= a vy —UDER

@O  TSecureDoc Enterprise Server v9.2 7 4 v 7 A VA =W A4 K| 22 LT, 7rtEva=r7L—L0O%
EIRE—V Al T AVARL—Sar Ry b —U%ERRLET,

@ fERLIZA VA=Y a v Ry r—CEF 707 v LT, REEmERE £,

[General] 74 2T, WORELZEELET,

TROREHFICTF =y 72 ANT, <OK> 227U v 7 LET,
A Ask user to verify data before starting encryption

4 Default Use ID is empty

Installation package settings X

General

eneral

Package name |oomm>1m—\>aww - |

'XJ Comments | |

Key file

Create new users in this folder during the remote installation

@ OO | Browse

Authentication

Apply this SecureDoc profile during the remote installation

guestions
Q’% Device Profile |3173'JM‘3["D7?’“|1 | Edit Browse
Users sk user to verify data before starting encryption
[JForce userto complete all data fields
£\ [ ] Default device 10 is empty
Provisioning Rules E Default user ID is empty
Key name format
@ Device name Add random characters to key name to make it unique
[@]cl¥][s}

i eomrmunication fails, retry evere 52 minute(shupto 5 2 time(s) (0 = infinite)
[ JIn case of communication error, continue installation offline

[wvait for the file distibution software to reboot the system

[ JHide encryption progress fram user

Restart device when encryption is completed { for hardware encryption will power off )

[ llew SecureDnor installations to run silenty when deployed using file distibution software

D Suppress message after initial installation

® <OK> 27Uy 7 LET,

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
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@ fERRLIcA v AN —var Xy —U% 457 Y v 27 L, [Create package files] 227V v 27 LET,

PFGAT YV DA VA=)V
O ELieA AR L—var Xy r—U%FsT, A A=V LET,

©® BB AENC.  [SecureDoc MDEERT +—2b) BERENET,

£ SecureDocMEFTA-11

& SecureDocDEHFIA- [0

2=~ 10: [Pe-1i
J¥2—HID: [PC-11
PTLES: [
s |
T [
B [
FoiFc R |

% —1ID: [PC-11 key 541al6c06134957_ |
e | |

A

* B SecureDoc 3 2 |

SSS

®  [=—H—ID] #ilic, FAC SES ICBEKFD2—V—ID ZAH LT, <OK> 227 V) v 7 LET,
HANZR 222~ 7- SDConnex MR EZAFIZL Y, SES IZBEFEENTWARWID i~ TA v A b= &MkET 5 =
LiIITEEREA,
LT, 22Tk, TPC-11) ZANLET,

® SES iz, Deploying User & LC, =—#—ID IPC-11] BME ST,

SecureDoc Enterprise Server Version 9.2 V 77 L2 A~ =a 7 /)L
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ro] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin
Database | View Folders Keys User Tools Help SecureDOC
5 ;.v = f— - Enterprise Server
- s X & B Al ?

Add Refresh Del Generate Key File Install Filter Help
M Devices W Keys | % Graups | .. Folder Enciyption Policies | & Diives
Device MName / hiodlifiecl Created Enc

- O X

=~ | Folders
: SES Administrators
E| N wm].local
.l Domain Controllers
-
1w
L, OO=E
il All Folders
Q Purged Devices
g Exempted Devices v
_; Recycle Bin
&y Profiles - :
.j Installation packages - - — SEEEE
;} Machinelnfo files
Sl .
< > <
Record(s) visible: 1, available: 1. Total user(s): 20. Total computer(s): 3. Total key(s): 15.

@ 7747 MEABERLZRY . SRS ET,

7547 v T, 2O Windows ~H1 A L TW5 Windows ID 4 & [6 4RI ID # BBy T4 —F —
DID & LTERLET, 20 ID I, SESICb &I NET,

- | X

rsl SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin
Tools Help SecureDoc

Enterprise Server

Database View Folders Keys User

- 3 &
B X & 8 & ?
Add Refresh Del Generate Key File Install Filter Help

M Devices  §f Kews | M Groups | |/ Folder Encryption Palicies | & Diives
i Modified Created Enc

=~ |, Folders

: SES Administrators
=l wmjlocal

; hﬂ Domain Controllers
hﬂ Eaap

h!' 1HHER

: h!' %ﬁgﬁ

-l OO

- || All Folders

Q Purged Devices

Q Exempted Devices <

._; Recycle Bin

] Profiles

h.j Installation packages

}} Machinelnfo files

=- | logs

U Audit Log v

Device MName i/

Pagsword

Record(s) visible: 1, available: 1. Total user(s): 20. Total computer(s): 3. Total key(s): 15.

@ AT DA A=V BB TET T D&, [User01) & PC-11) &HFINTEY, EHH6ThHR

TATHIENTEET,
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ro'] SecureDoc Enterprise Server SQL Plus - Server name: SES¥SQLEXPRESS, Database name: SESDB, User name: SESAdmin - ] X
Database View Folders Keys User Tools Help SecureDOC
. = . — - _ Enterprise Serve
L * x & B | ?
Add Refresh Del Generate Key File Install Filter Help
=~ |, Folders A | B Users | M Devices ' Keps ‘if}‘_.liroups | | Folder Encryption Policies ‘g Drives
f SES Administrators MNum Device Mame / Enc | Deploved State Profile Modli
G~ 5 e ployed Up to
 wmjlocal [o  [Pc-11 Deploved
-y Domain Controllers
N zzx
L mwE
1 wmE
|, QO
- i1 All Folders
a Purged Devices
a Exempted Devices
-+ 5 Recycle Bin = %
;| Profiles
%‘J Instal!atlon DaFkageS um User [0 (O et S KewFile Protection First_name L ast name & rriall
4t Machinelnfo files L Lge 0y Yas
=~ ), Logs 1 Deploying User Password
L Audit Log e
B H % < >

[PC-11] Zffi~-T, a2/ A4 LE7,
WNRAT— ROEFHERBHDLDT, A =V ¥ NV/RAT—RELTHREFD/NAT— K% [(HVW AT —R] #llCA
Fl. HLWARRT— RERELET,

F-774IL AD-FOEE

TAAMES{ R/ AN - BRI E L TRED JOAD = FIL—LERIL TURENE R E T A AT -F

?OD UAEERERERLEES. RLOVEAD DB AN LTHE .

F=Ip )L ATk

1-#-ID PG-11

AT - |

LA -

HLLVAT - FDEAN

JAD=RBOE b

wEPS, 7V T — FRIET, EHELINRY—F&fioTr /A L TEET,
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(D) [User01] BAETHNIE, £27 Y v 7 L. [Remove use from device] #7 Vv 7 LE7,
74T NI, EMREET, ZomBEZTIRY £,

File Protection II
Y83 lie}

Deplaying User =S| [ Remove user from device ] Del

2

Access rights

Set Filter

Refresh
Modify User
Create Key File
Challenge response F4

Remove key file from device

FileVault

PC-11) %, Deploying User O£ £ TT N, ZOEFEFMHTHI N TEET,

@ F—F—L LT, BETHEAIL. [Set Device Owner] %27 V v 27 LE7T,

LJsers having 4
__Owner ./ KouFis Protoction First name |

#  Remove user from device

@ Accessrights
Set Filter
Refresh
Modify User
Create Key File
Challenge response
Remove key file from device

Set Device Owner

FileVault

¥ A UA =B £ TO Windows ~DHF A A N2, FvT 4 o FTHOEL ID 2o =841, [Users] # 7
TEZDID @5 L, TERONRRIIIREENTNDT A Z—ERRRENET,
B DT SA AT 7 b xR —%->GEIRL, /£7 YV v 27 T [Remo use from device] #7 V v L£7,
BTOTNA AnE, 2O IDIFHIREET,
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8. A=Y arvhrbDSEST vy 7L —F

U4~y 71 SES kU SecureDoc 7 TA T v b ERFON—Ta LT v 7L — RLUTHERT L Z L ERHER L
TWET, SESIXHN—Ya D7 547 v M HafEICERT 5 2 LN AR T,
SES D7 v 7/ L— Rit, BEfFD SES ~ EFHEX A U A FM— R AEETT 3, 7 v 7/ L — RENC Nl OEEFHEZ L35
ATINBEFEITLTLSEI N,

i [SDConnex Service] . TADSync Service] . [Analytics Engine Service] % SES & [@ U¥— —THEITL
Tnoakha., LEEA VA P—AORICENEND Y —ERAZAF T 2L ERH Y 5,

ENENOI—ERFE, vAf 7y 7 MEHa Y —/L (Microsoft Management Console) @ ETEITINTE
D, LEEA AP NEBIR>TH, TNFEFTRESNTWEERNEZILIEHBNT 2 V7 INET,

FARA D ] A==2—»2b<Configure>%7 U v 27 LT, BIEOBRENEEZ ATT 5, DV ITHEa E—72
EEBZ-T, Ty 77— REOBREICEILDI I LTI,

Fro, BEENERT 7 A0 B FRRRICBEEOREEZ AETT D, HOWVERHEIE—REEZB I > TIEEN,

T T T — FEOEREE AL — RSB T T H0IELHET,

¥ SESWeb OEELZ VT ENETDOT, ul A LV OEOFHBRENPLEIZLD 7,

S OSQLIZERENTWD SES DF —F_X—R, T 77 L — K7 ARy I T v T2 WMDH T ENTEET,
Ty T TR, T R=ADNRY 7T v TR D, FEBRREICEEL TWLERIA Ty Ty FEIRD
E, THIERAREGR A TOHLET LTI EE N,

SQL Server Management Studio Zffi> T, BEEDT —4 X—R%& Ny 77 v S T&EET,

FE L <X, SQL Server Management Studio BIF D H 1 b TIHERL 1ZE W,
F=BR—=ZADFRENY 7T v FOVER
https://leam.microsoft.com/ja-jp/sql/relational-databases/backup-restore/aeate-a-full-database-backup-sql-server?view=sql-server-

verle

¥ V8.6 SRLHF2 L i _— 5 UR0BEIC EOL & a5 TWANR—Ia v, Ifin—Yar~07 v 77 1L— R
OHE . BEOFMT v 771 —F (V8.6 SRLHF2 ITT7 v 77/ L—R) BUBEICRALEERHY 7,

SES #HIDOY——IBATT D2HEOFIEIL, KOLED TY,
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@ [A#— 1] > [SecureDoc Enterprise Sever] > [SecureDoc Service Configuration] #3117 L %7,

ETOY—ERZLH, O THE] A=2—hb<Stop>%27 U v 7 LTEIELET,

& SecureDoc Services Configuration - a X
TrIWF)  BER) RRV)  ALTH)
@ 3

%, SecureDoc Services SecureDoc Services HRIE
&, SDConnex Se ) A
onnexservice Service Name Description Status  Btartup  Log On As Path SecureDoc Services -
& AD Sync Service

& WinMagic SecureDoc.SDConnex WinMagic SecureDoc Communication . Running  ‘utomatic ~ ¥SESAdmin C¥Pr..
£ WinMagicSecureDocADSyncService ADSync Service securely synchronizes ..| Running Putomatic  ¥SESAdmin C¥Pr.. . §
q,WmMagic.Secu reDocAnalyticsEngine  WinMagic SecureDoc Analytics Engine..) wtomatic  ¥SESAdmin C¥Pr.. Lo Configure
B Monitor

& Analytics Engine Service WinMagicSecureDocSDCo.. 4

Running

[2] View Eventlog

@& Start
@ Register
@ Unregister
AT %
& SecureDoc Services Configuration - ] x
TrLE  BIFW FRV ALTH
L JNE
%%, SecureDoc Services SecureDoc Services HiE
9., SDConnex Service N o _ ~
€, ADSyncs Service Name Description Status Btartup Log On As Path SecureDoc Services hA
ync Service . . h — . . .
&, Analytics Engine Service A WinMagicSecureDocSDConnex WinMagic SecureDoc Communication .. Stopped  Automatic  ¥SESAdmin C¥Pr.. WinMagicSecureDocSDCo.. &
ﬁ,WinMangscureDacADSync.Servnce ADSync Service securely synchronizes .| Stopped [utomatic  ¥SESAdmin C¥Pr.. ~ 5
% WinMagicSecureDocAnalyticsEngine  WinMagic SecureDoc Analytics Engine..| Stopped fiutomatic — ¥SESAdmin CH¥Pr.. Lo Configure
B Monitor
[Z] ViewEventlog
) start
® stop
@ Register
@ Unregister
AT ¥

@  [SecureDoc Enterprise Server Version 9.2 7 A v 7 A VA M=/ HA K| 25 L T, 4 VA N—LEFST
LTCLEEN,

® AVAP=ATORBADRFT, FRORY TT v T RAvE—URNERENET,
V6.5 LIRS —2 g U ESEH L TV A RBEHKIL. SES 07 v 7~ L — KRl License validation tool % f#- T,
BIEFA LTV T4 B ARIELL BIEHP N2 D0 E MR T 2LENHY L, LirL, v6.51FBEIC EOL
Lo TBVYR—FBKTLTNDED, 5BON—Ta U TIEZOA v E—VRFERLZVIIICEFINE
K
<OK>%7 Vw7 LT, #EDTIIEE,

SecureDoc Enterprise Server 9.0 SR3 - InstallShield Wizard X

Please note that it is highly recommended to run the license validation
tool before upgrading from existing version of SES.

SecureDoc Enterprise Server Version 9.2 U 7 7 L 2>
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@ SESHKETLTELT, EITENTEFEOHE. A VAT B RAFUTFRORNY TT v 7 A v —UNER
ENET, SESOTu T TLEKTL, <OK>%227 U v 7 LTLEEN,

ﬁ SecureDoc Enterprise Server 9.0 SR3 Installer Information

. The setup must update files or services that cannot be
! Ly updated while the system is running. If you choose to

continue, a reboot will be required to complete the setup.

Cancel

X

® HWEHIIEST, A VAN VEETSEET,
ZEMX SecureDoc Enterprise Server Version 9.2 7 A v 7 A VA h—)LHA K| #ZBLTLZE W,
[A %4 — k] > [SecureDoc Enterprise Server] > [SecureDoc Enterprise Server] # %7 L 9,

@ wvrAVEEIRREINET,

BHERAX—7 7 A NVDNRAT— &2 AN L, <Login Key File>®h %> %27V v 7 LET,

E Login to the database

ey File

Key File Path: |C:\SESKey\SBSkey.dbk

| Browse

Password: | eesessss|

[ Autamatically connect to the database last connected-o

Login Key File

Cancel

T—=HN=ADT v T T = FPRETHLH I LR T Ay —VRERRENET, <OK>%227 VU v 7 LET,

SDDB

Database: SESDB at server: WMJ-SES¥SQLEXPRESS must be
upgraded!

Ensure no one else is using the database.

x

Q@ TFTER—ZAONRNYIT T EBIRI) ZLOMERERODONET, LT, <FWV>EZ Y v LET,

SDDB

o Backup SESDE database at WMJ-5ES¥5QLEXPRESS server now?

LWVE(N) Froel

X
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T=HN=ADNy 7Ty RN TH L, ROBHEPERSNET, <OK>%27 VU v 7 LET,

SDDB X

| Database SESDB was successfully backed up to SESDB_auto.bak.

O F—sR—ADT v T — FRBHSLET,

Database upgrade

Please waitwhile database is upgraded.

[ W)

@ FT—ER—RAOT v T T L— RIZEHT D&, ROWHDIERSINET,
<OK>%7 Vv r35%&, SESHEELFET,
[SDConnex Service] . [ADSync Service] . [Analytics Engine Service] #H#EL T E&EW,

SDDB >

Database SESDB successfully upgraded. Please upgrade all SecureDoc
server components.
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9. SES Z DY —N—IZBITT 2HE

WEAF D SES BREiA SES =12V —/L & SDConnex 8[| U — =24 VA =L & THEY | FHIZSES & A A b
—/T 58T SDConnex M IP 7 RLARZINETLERARD L, 7747 MIBEFD SDConnex & MilfE &t & o
ELET, IPT RLARERIZRLGE1E, BIFOSESREET, 7747 2 M AL AZHA LTV D7 07 7 A MITHT
LA VA M=ATIHREDOIPZBINL, ®RTCOIITAT L M7 a7 7 AN EFHEALTBLERSH Y £7,

[General options] -> [Communication]

SecureDoc options

3 Communication
Communication Setlings
General
Uge SDConnex to communicate with SecureDoc client machines

Server List 172.31.20163

- Add
Communication

& Faortnumber | 7300 Froxy Settings

[ carmmunicate with random SDConnex serer within priority group

<Add>%27 Vw27 L, IPT FLAZBINLET,
BIML7=%. <Move Up>, <Move Down>% 72V v 2732 & Priority #AE &£,
27 74 7 ¥ M Priority ®OJE#F T, SDConnex & DfE 2R A ET, FHLA A M—F% SDConnex @ IP %

Priority 1 & L. BEfF® SDConnex ® IP % 2 & L7=334 . #i#lic SDConnex 234 Y A h— /L INDHET, 774 Tk
IZ Priority 1 @ SDConnex & {5 TX 22 7=, Priority 2 ®REf7 SDConnex & il B Z 720 E 7,

SDConnex Address List >
Enter SDConnex Server Address(es) in any of IPv4, IPwE ar DNS-Name formats
MNOTE: The list can contain maximum 16 addresses
‘ Add
Custarn part nurnber (if not default): I:I
ServerAddresses Custarn Port Friotity Remove
172.31.20.163 1
172.31.20170 ] SEOERu
Move Up
Ok
Cancel

IIATNITu T ANV EFEALET,

[Devices]|T—&xFrL, &®TCHOI T4 T FT 34 AT, [Modified Profile]®»# x2% Up to Date] L7722 &%
e L, BEfED SDConnex —tE 2 & {51 L ¥,
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SES ZHDY—N—IZBATT 2 HEOFIRILUTO LY T,

O SESicul/Ar951200%—77 A0 (JEEFIX, dbk) 2874 VA =T 53— =B (at’—) L
ijﬂo

® SQL Server Management Studio #ffi~> T, BEFOT —F X—R2 %Ny 77 v 7 LET,

£ L <X, SQL Server Management Studio BEF DOV A N TIHER L IZE W,
T —ER—ZADERN Y 7T v T DOVERL

verlé

@ #HIT SES A v A b—/T 5P —s3—|Z, Microsoft SQL Server, SQL Server Management Studio % > %
r—L LET,

@ SQL Management Studio Zfi>T, "o /7 v FEDT—FX—RE LA NT LET,

® SecureDoc Enterprise Server Z A > A h—/1 L £,
ZEMT TSecureDoc Enterprise Server Version 9.2 7 A v 7 A4 VA b=/ HTA F] 2R LTLIEEND,

® [A#¥— 1] > [SecureDoc Enterprise Server] > [SecureDoc Enterprise Server] # %7 L %7,

@ vl VHEERFERINDL, <Browse>%7 Y v 7 LTH—T7 7 A VEBRINL, X2 TU— K% A%, <Login
Key File>Ah&# %27V v 7 LET,

"i_"’_.? Login to the database X
Key File
Key File Path: ‘C:\SESKey‘\seskey.dbk | [ Browes ]
Pagsword: | essssssss| Login Key File

Create Key File
Automatically connectto the datahase last connected-to A

Diatabase Information
Create new database
Server Name: Create new connection

Database Name: Delete database

Delete connection

Login Cancel

SecureDoc Enterprise Server Version 9.2 V 77 L > A~
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<Create new connection>%7 1 v 7 L¥7,

"E:'_,? Login to the database b
Key File
Key File Path: CASESKey\seskey.dbk Browse
Password: esessssses Login Key File

Automatically connect to the database last connected-to

Database Information

Create new database

Senvr Name: -

Database MName: ~ Delete database

Delete connection

Lagin Cancel

© TN RIET 2O OREZ LET,

Create New Connection x

Server and Database Information

* Ky List: AES Wb ~

* Server Narme: ~

Mate: If applicable, ensure that full S0OL Server name is entered in
the format <computer_nameiinstance_narmes,

*Database Name: | |

() Use Windows authertication (@ Use SOL Server authentication

*S0L Lagin ID: | |

Passward: | |

*-Fields marked with an asterisk ™ are required.

Firizh Cancel

Bl Eh 95 &, SES BEE L ET,
) ISDConnex Service] . TADSync Service] . [Analytics Engine Service] #FaE L T Z &,
[*#— ] > [SecureDoc Service Configuration] > [SecureDoc Service Configuration] Z3{TL £,

KV —ERADOFRENEIL,.  [SecureDoc Enterprise Server Version 9.2 7 A4 v 7 4 VA b=V T4 F] #5RL
TLEE,
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10.SecueDoc 75 AT ke T A VA —)LF)E

7747 M SecureDoc 27 A A = AT LA TPOESKBLOT—tusdy (FUT7— bEEET
TITL) OT oA VA N—=LANBMETT, HE{LT 570121, [Convert Hard disk] OHERSME T,
I 74TV NTNA ANEIEMERO 2 —F —ID NEEE SN TR WS, SEShH Y 747 v MIEEFEDO2——ID
ZBIML TS,

O lSecureDoc =» hr— ¥ Z—| ZiLd#H L. [Convert Hard disk] O#ERZ > TW\Wpa—F—ID Tr /A1 v
LET,

2-H-ph{:

& Tobo-ndzs-

J-tobAa2—4-1D:

SDAdmin

ATz

99000 kR H) |

Fol Y LAAUA oH42(L) |
—

@ SDzavbu—nErH—DESALT, [BEEEH] OTVE T A=a—hD [ EER] 227V v/ LE
To HA T, TAAZZBRL, THICHD [BAE] ML, TESL) . e 28R L, <Blis> R
Vv LET,

SDIYrO-)L Y- = ] X

£) SecureDoc

-— =

. 3 FS{LEmR

+ [2 msiea .
E2TH HD1 e DESK... F3{J3XF: C: e DESKTOP-EUBG...
UHIAT(PEERRTD BE{LES: @0 EE{LES: (0

T-hadA Ay

v YL=BT: OO

)

- X

. o”

@ D4 9ot 181 v xm%’ v E8{t¥-: AES DESKTOP-EUBGIB

A

1284 TaskDiskManagement & PH1/PH20A1BR RV S ATiES (YD
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@ HWHTDHT 4 A7 EZELSBIRTE TR0 A, THRICT A A7 EZRINL T EIW) ERRENETO
T, <OK> 27Uy 7 L, RVELET,

SecureDoc X

£ SecureDoc

e ST ADERIRUTCEED

OK(0)

@ BEAAERRmShZs, ETT0ETHLET,

SecureDocZE {2 - £{THRTT .. -

N=EF AR RS ESNTOZ T, I/ —MLBREEDERTI LD, FEAERETR
CebTESES, BRILT70EAL. BiEshiE(CAmLEE.

gam | | o
523 | | o

§8+125829119t55 -PDzH2-2050109% 4L
Bcp

fi‘.:;w

Fesle Bl 00:01:29 -
TirFEE: 14 MB/s IE
DB 01:11:42 y

® H\ELETH, 7= rTF &7 A A= LET,
[7—bharvba—L] OFALEY L A=a—inh [T—balF DL A=V [T oA A —=L] 27V v L
F9, RIZ, AL LD [TUvA A R—L] BT T, 7= T 4 A7 EERL, BHHEZAZ 72—V LT FHICHD
<KTUvAVAN=N> 7Y v 7 LET,

SDIVhO-hEY5- = a X

SecureDoc

. g

NNNNNS 22 ANNNNSS

T-bATAIDOPI1 VA=

-
* B3
> F_;; -
wwaren B ARSI
&~ T hOIASOPAVAR
s [37-tbon SecureDod. 77— M0/ VAIFTEDT - FOIAUEA VA M- ILE T FOADSIFEIESELEBS, Windowsk
© 20 BEFBOCELOF - 77 N EEST DS U BRNE S
o N J- DY A8, SecureDodd, MAEDSAVCERENTIBWindows D% —774 MEEBIINEY A(FADLIE1E
[ F=h0IAIPAYAC=WSPIASAR = ] BIEENTODTREENBNET ). SecureDodd. {REESNLIFPIM SecureDoc Spacel(c) - —J71 LERTFLES. :
=T IR MO A, 16~2000RAL—H -EEFTIBLABETERS, FI T, T- NI hO-MED—H-40A(ER
S Telieeds
FDEUA/ U IEIROA Ut — b /THAM— b N—KES{ JO%IR
SR HD1 (K547 C)
- X
> o”

@A Vs
Q@

2§ TaskBootConfig
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® EENFRENETOT, <OK>RZ %27V v LET,

PAISE ST X

£) SecureDoc

| g- FOSAADT A A=V ERTIDEERELTE
- \

(A

oo | oo

@D TrALAM—LBICHERTIEENFRENET, NEZMHRLT, <OK> 227U v 7 LET
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